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Scoring an Event with Apple 
Raceberry JaM: Overview 

Your basic objective in scoring a race is to report the order in which the runners 
finish, and in what time.  Once that is done, you must be able to score teams according 
to the rules of the race, and/or to rank the runners in any award groups the race may 
have, such as those based on age and sex but perhaps other criteria as well. 

Apple Raceberry JaM is a very powerful system for scoring road races and cross 
country meets, in that it can do just about everything that needs to be done for just 
about any race or meet.  The cost of this power and flexibility is that you have many 
choices to make in order to score any one race.  To help you get started, it may be 
useful to take a look at the complete process of scoring a race in outline before getting 
into any of the details.   

Here’s the basic idea:   
1. Before the event, you must first create files on your computer in which to store 

the data on the participants and their results.  These files are kept in a folder 
with the event’s name. 

2. Also before the event, enter the data on pre-registered participants, such as their 
name, age, sex, address, and team.  You will probably print out lists and labels 
for their bibs/ID numbers. 

3. At the event, you may have to enter data on walk-up participants.  In any case 
you must enter the times and the finishers’ ID numbers in order of finish. 

4. Finally you output the results, certainly in printed form and perhaps in files that 
can be uploaded to the Internet. 

These steps are covered in separate chapters of this manual.  

Apple Raceberry JaM is a complete race management system.  The software allows 
you to record all the information you need on the runners and their results, to score 
them in (probably) any way you can think of, to output the results in a variety of forms, 
and to communicate with the runners by email and snail mail.   

For recording their results manually, the runners must be issued bibs (race 
numbers) with detachable tags and you must have spindles on which to collect the tags 
at the end of a chute.  The recommended source is Rainbow Racing System (800-962-
1011).  The tags on other brands are much harder to handle on the spindles.  A bar code 
reader (again obtainable from Rainbow) would also be useful; ARJaM prints out bar 
coded labels. 

You also need to record their times.  The software has the ability to make the 
scoring computer act as a timer (see page 39). However, so doing does not supply the 
select times that are so important for insuring the accuracy of your results (pages 46-
49). 

An external timing device of some sort is therefore highly recommended.  A simple 
printing timer would allow you to input the times manually, which is not unreasonable 
for a small race (page 44), although it might not produce select times.  Serial devices, in 
particular the TimeMachine, do produce select times and allow you to download them 
as the race progresses (page 37). 

A more economical solution is to network the scoring computer with a laptop that is 
set up at the finish line.  With an access point/router, you can do the networking 
wirelessly. If you don’t have a laptop available and don’t want to borrow one, you can 
get a Windows netbook for $300 or less.  A useful accessory is the Logitech keypad, also 
economical, which makes it easy to collect select times.  The netbook can also be used to 
assist with race day entries.  See page 40. 

Alternatively, rather than enter IDs and times manually, you could purchase a chip 
system.  Apple Raceberry JaM is compatible with most chip systems currently on the 
market; see page 37.  All such systems use antennas to signal the chip, which reports to 
a decoder its ID number (which may have to be translated into the number assigned 
runners by ARJaM) and the time at which the chip reaches the antenna.  Some chips 
attach to the runner’s shoe.  With those systems bibs are unnecessary, although they are 
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useful if you have a video system to back up the chip results.  Chip systems, properly 
used, are very accurate for the finishers’ times, but cannot resolve really close finishes. 

For a really cool option, a flat screen TV can be obtained for under $300 and can be 
rigged to scroll through the results.  See page 67.  
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Step 0: “Install ing” the Software 
and Getting to Know Apple 

Raceberry JaM 
Welcome to Apple Raceberry JaM!  Your software is on the CD in the back of the 

manual.  Put the CD in your CD drive.  Depending on your operating system, you may 
get a dialog asking if you want to view the contents of the CD.  You do.  You’ll see a 
single folder called “ARJaM Windows Road.”  Drag the folder into your “Documents” 
(or perhaps “My Documets”) folder.  With older operating systems, you may need to 
go to “Windows Explorer:” right-click on the Start button at the lower left-hand corner 
of your desktop and select “Explore” with your mouse or by typing “x” and <enter>.  
Find the CD drive (probably “D:” drive), open it up, and drag the “ARJaM Windows 
Road” folder on to the (My) Documents folder. 

If you open up the ARJaM Windows Road folder, you will 
see several “jam-jar” icons and a couple of folders.  The folders 
hold files for demos of the software; instructions for running 
the demos are enclosed in the software package. 

 
 
 
 
 

The application ARJMenu is your gateway into the ARJaM system.  Double-click on 
it.  Its various buttons direct you to the basic steps of the process.   
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Clicking on the first button simply takes you to the NewEvent 
application, which will be discussed in detail in the next chapter.  
Clicking on the one below brings up the dialog at the left, which lists all 
the applications in the ARJaM system employed before or away from 
the event (SetData is also useful at the event for entering data on race 
day entrants).  The fourth and fifth items are not available in the basic 
Road Race/Cross Country package and are greyed-out; they belong to 
the Track Meet package.  The last two are optional pieces of the Road 
Race/Cross Country package.  ChipData is required if you have an 
IPICO or Championchip chips system. 

Using ARJMenu to call up the various pieces of the Apple Raceberry 
JaM suite of applications is so convenient that you will find it useful to 
put a shortcut to it on your desktop.  From Windows Explorer (see 
above), click on the ARJMenu icon, pull the File menu down to “Create 
shortcut,” and then drag the shortcut to the desktop.  Or, with more 
modern operating systems, once ARJMenu is started, right-click on its 
icon in the task bar and select “pin this program to task bar.” 

 
 
 

 

Except for NewEvent, which 
creates the files in the first place, 
after you call up an ARJaM 
program it starts looking for the 
data files on which it will 
operate, in particular one called 
ROSTERN.TEX (ROSTER.TEX in 
older versions of ARJaM), which 
stores the runners’ names and 
ID numbers. As you’ll see in the 
next chapter, the data files for 
each event are created and 
stored in a folder named (by 
you) after the event.  The 
programs remember where they 
were last used; initially they will 
look in the last directory in which they were located.  If there is a file called ROSTERN 
in the directory where it starts looking, the standard File Open dialog looks like the one 
shown on the right.  If that is the ROSTERN file you want, you just hit the <enter> key 
to get the program going. If you’re in some other directory, click on the folder icon with 
the up-arrow in it to get to the parent of your current directory – and double-click on it 
(in Windows 10, click on the arrow next to the name of the last directory used to get to 
the parent directory).  Double click on ROSTERN (or, if its name is showing in the “File 
name” box, hit <enter>). 

In any case note that only files of the type you want are shown.  In most cases there 
is only one permissible name for a file of a given type.  Theoretically ROSTERN files 
could actually be called anything that begins with “R,” but you should choose 
ROSTERN to take advantage of recent improvements in Apple Raceberry JaM. 

If, after starting up a program, you discover you’re in the wrong one, clicking the 
“Cancel” button of one of the standard file dialogs shown above will usually get you 
out and let you look for the right program.   

You cannot start an ARJaM program by double-clicking on one of the files they cre-
ate.  There are too many different programs that can operate in different ways on the 
same data, so declaring you want to use an ARJaM file does not identify the program 
(application) that you want to use. 

For the most part, the ARJ programs conform to the standard Windows user 
interface.  The principal exception is the lack of “Open,” “New,” “Close,” and “Save” 
items under the File menu, since these functions are all carried out for you 

 

Locating Race Data 
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automatically.    Program NewEvent creates space on the data disk for a number of 
blank lines of data (per your specifications).  The other applications write data into 
those blanks as they go along.   

The good side of this is, if the system crashes or you lose power, you do not lose 
(much) data.  The bad side is that you may have to work a bit to undo mistakes, since 
bad data can be written over good.  The “Undo” command under the Edit menu is not 
activated.   

Also, if you ask for some data beyond the end of the file as it was created in 
NewEvent, the system may crash with an error message or at least refuse to go any 
further.  If you need more room in your files than you thought, use program SetData 
and its “Expand” option to lengthen them; see page 14. 

One thing that has generated a lot of phone calls is that age groups and teams do 
not seem to be properly reported in program RaceDay if they were input or changed in 
program SetData after the finish order was recorded while RaceDay is open.  When you 
enter a runner’s ID in RaceDay, that information is stored in a file called ORDER along 
with the runner’s team and age/sex class, which are determined by looking up the data 
entered in file ROSTERN.  If you change the data in ROSTERN via a program other 
than RaceDay, that doesn’t automatically change the data in ORDER.  The solution is, if 
you find (or feel; as noted on page 42, you can enter or change the name, age, and team 
associated with a given ID in RaceDay) it necessary to change the runners’ data with 
program SetData while RaceDay is open and you have recorded some finishers, pull 
down RaceDay’s Finish Order menu to “Check finish order.”  This will reset the data in 
ORDER to conform with what is currently in ROSTERN. 

See also the section above on “Running ARJ Programs,” which is also peculiar to the 
extent that you cannot start up a program by clicking on an ARJ data file. 

Whenever you want some output 
from an ARJ program, you are asked 
where you wish to direct that output by 
a dialog box like the one at right.  You 
are allowed to “Select the output 
device” among Printer, Monitor, and 
File.  Rather than use a radio button, 
you can do so by typing “P,” “M,” “F” 
or their lower-case versions. 

If you don’t need or want a 
permanent record of the output, select the Monitor by typing “M” (or “m”), clicking on 
the second button, or using the down arrow once, and then clicking on “OK” or hitting 
<enter>.  You can usually interrupt a long output to the monitor by pressing <esc>. 

At the end of the output, there will be a message “Hit any key to continue” at the 
bottom of the screen.  You must hit a key to continue the program.  If there are several 
pages of output, the message will say “Hit <esc> to terminate and any other key to 
continue,” so that you can terminate the output when you’ve seen enough. 

When you wish to send your output to a printer, most programs use the drawing 
capabilities of the Windows operating system.  That is, characters are drawn at 

specified locations on the paper.  This enables such features as 
centering a meet title and printing it in a relatively large font size, 
printing results in two columns, and using bold face to highlight 
subheads, as is illustrated by the samples in the back.  

The “Printer setup” item under the File menu allows you to 
output data “sideways;” i.e., in “landscape” style rather than the 
default “portrait.”   
 
 
 
 
 
 

The “Output Device” 
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Select File for an output device (you will then be asked to name the file) if you want 
to massage the output with a word processor if you, or are “downloading” data to 
another program, or are preparing a file for the Internet, or need to send results to news 
media.  Usually columns of data are separated with tabs for easy formatting, but there 
is also a csv (comma-separated-values) option.  You can open the file with any word-
processing program, and then change the font to suit yourself, paste in graphs, etc. 

In naming a file, be careful.  You will be warned if you attempt to overwrite an 
existing file. 

A laptop computer is a very nice machine, especially when you have to carry your 
computer any distance.  Although you can buy a numeric keypad to facilitate its use for 
one-handed data entry, every attachment you put on it diminishes its basic attribute of 
compactness.  Therefore, when you are required to input a number, the ARJ programs 
will accept these substitutions without your pressing the NumLock key: 

M= 0, J = 1, K = 2, L = 3, U = 4, I = 5, O = 6 
Together with the ordinary 7-8-9-0 keys, this creates a software keypad that helps 

speed data entry. Your laptop may have these numbers printed on the keys. 

If you shut down your computer using its “Shut down” procedure without first 
quitting an ARJ program “normally” (by pulling the File menu down to “Quit” or 
hitting Ctrl+Q), you may seem to lose some data.  What has happened is that counter 
variables that ARJ uses to keep track of how much data is in each file may not be prop-
erly filed away.  When you restart ARJ, you may get a notice that the “next line of file 
XXX is not empty” and be prompted to search for the end of the file.  Accepting the 
suggestion will usually correct the problem, but you may not get the notice at all.  Your 
safest course is to Quit the ARJ programs using the command under the File menu 
before shutting down the computer. 

It should be noted that Windows is blessed with allowing keyboard shortcuts to 
every menu item and desktop button.  Just press the “Alt” key and then hit the key for 
the character that is underlined in the item you want.  Some of the most common 
functions can also be accessed with “Ctrl” key shortcuts.  For example, as indicated 
above, every program can be terminated by hitting the “Ctrl” key and then “Q.”  Such 
shortcuts will be pointed out as we go along. 

In cross country in particular, ID numbers may be assigned consecutively for boys 
and girls/men and women in different ranges.  In road races a similar separation may 
be used to distinguish runners in different races (5K and 10K, e.g.).  Inserting an 
unassigned number or sequence of numbers facilitates listing and scoring runners by 
gender or race distance.  In dialogs like that on page 23, you can select either the high 
or low range by inputting a “?” into the box for the starting or ending ID number, 
respectively. The division codes described on page 12 can also be used for this purpose 
(without wasting bib numbers). 

Some of the programs have help menus, and some of the dialogs and other 
windows have question marks that you can click on to access context-sensitive help. 

To the best of my ability, I have tried to write the Apple Raceberry JaM programs so 
that a person reasonably familiar with Windows would not have to keep this manual 
open while operating the programs.  However, I use these programs for some seventy 
events a year, and could not resist introducing a number of “short cuts” that cut down 
the labor of producing results.  These often necessitate some unusual behaviors of the 
programs.  I have tried to flag these with shading like this.   

 “Built-In Keypad” 

Quitting ARJ Programs  

Selection of Upper and 
Lower Number Ranges 

by Inserting Gaps 

Help 



  
7 

Step 1:  Setting Up Files for a 
New Event 

Double-click on the 
ARJMenu icon (if you do a 
lot of events, you might do 
as I do, and create a “short 
cut” to ARJMenu on your 
desktop and in your 
taskbar).  This brings up the 
four-button display shown 
on page 3. 

Then click on the button 
at the top on the left, “Set 
Up Files for New Race or 
Meet.”  This brings up the 
dialog at the right.  Not much choice here; just hit <enter>. 

NewEvent’s five buttons now appear. Whatever 
option you choose, you are asked whether you want to 
“Create files for a new event” or “Replace or revise 
existing files.” You’d use the latter option if you needed 
to restart the whole process, or if you realize you 
neglected to create certain types of files (most common 
for road races). 

Suppose first that it is a cross country 
meet you want to set up.  Clicking on the 
Cross Country button brings up the dialog 
at right. You are then asked for some basic 
data on the meet: its name and location 
(which you should now enter), the meet 
date (the default being today’s date), the 
range of possible ID (bib) numbers, and the 
types of data you will store. Change the 
date to the meet date and enter the lowest 
bib number available as the first ID.  What 
you enter for the “Number of entrants” sets 
the size of the files; it is best to make the files too large.  They’re small enough so that 
they won’t take much space on your computer.  The default for cross country is to store 
team data and the athletes’ school year. For collegiate meets, you should also store the 
runners' “TFRRS IDs;” see “Variations” below.  Although both genders are competing, 
they usually do so in separate races1, so there’s no point to keeping track of the 
entrants’ sex.  If you must use parallel ranges of numbers for males and females (both 
                                                
1 When they don’t  in middle school races, for example  the recommended procedure is to use male and 
female divisions.  See page 12. 
* Bug: RaceDay has problems connecting with built-in serial ports.  It works best with USB serial 
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starting at #1, e.g.), enter “2” or whatever is appropriate for the number of ROSTERs.  
For age-group meets (USATF or AAU, e.g.), you may also want to keep track of sex, 
home towns, and addresses; see below, under “Variations.”  Hit <enter> when done.  

All the data for the meet will be stored in a folder named after the event (“Section 8 
Championships” in this example) that will be created in the folder in which your 
software is stored (or in a subfolder of your choosing).  

Next you are asked for the number of teams expected, with a default of 50.  If that 
seems way too many, don’t worry about it; accept it.  Again make the files 
commodious. 

Next you enter the number of finish lines.  As noted above, cross 
country meets usually have at least two races. Their results will be 
stored in separate directories, which you will name on the fly.  For this 
meet, enter “2” and hit <enter>.  Then, for each race, the  dialog at left 
asks its name (“Boys” or “Girls,” e.g.), creates a folder within the meet 
folder with that name, and then creates the files required in the race 
folder.  The default number of finishers you “expect” is the range of ID 
numbers you specified earlier.  Obviously, if you divide the entrants 
into two races there will be many fewer in any one race, but the files are 
small enough that you can simply accept the defaults by hitting <enter>. 
Recording fractions of seconds is conventional with cross country meets.  

As you’ll see on page 10, the dialog also allows for the possibility 
that splits will be recorded in each race. If so, click on the “Event has 
splits” box in the dialog 
above. 

That’s it. Now quit the 
program by clicking on the 
“Quit” button (Ctrl+Q).  You 
have now set up the files for 
your meet. If you examine the 

meet directory from Windows Explorer, you 
will see that it contains three files and two 
subdirectories.  Double-clicking on either 
one of those directories will show that they 
each contain three files, called ORDER.TEX, 
TIMES.TEX, and IDENTIME.TEX. 

For non-collegiate non-scholastic cross 
country meets, like USATF meets for 
example, runners will enter their addresses 
and some may be unattached.  They 
probably pick up their packets as individuals. Thus you will have to enter their gender 
as well as their addresses, and follow procedures like that described below for a road 
race, albeit a road race with team competition.  

For NCAA meets, you must submit results to TFRRS (Track & Field Results 
Reporting System), which requires that you store TFRRS IDs for the collegiate runners.  
These data will be stored in the address field in ARJaM, which you can enable by 
clicking on the “TFRRS IDs” box in the Basic Data dialog above without having to open 
a CITIES file. 

Chip races that use the ChampionChip/MyLaps shoe chips or IPICO shoe or bib 
chips store the chip number in a file called OTHERDATA.  To access this file you must 
store CITIES and follow the procedures outlined below for road races. 

Similarly, if you want to use “division codes” (see page 12), you must create an 
ADDRESSESN file, which also requires that you store CITIES. 

 
 
 
 
 
 

 

 

Variations 
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The procedure for a road race is 
somewhat more involved.  It starts out 
asking for basic data as shown above, but 
the default “Types of data stored” include 
sex and home town and not team.  You can, 
of course, have team competition in a road 
race.  If so, just click it on.  There is also, in 
addition to the item about splits, a check 
box for “Start times.” 

Your first new option is 
(assuming you are storing home 
towns) is how many you cities will 
store (ARJaM’s data base consists of 
several linked files; for backward compatibility, it uses a data structure not 
much different than it used in 1980, when its storage media was 144K floppy 
disks and space was scarce).  The default 150 is probably enough for the default 
race size of 500.  Again, don’t be stingy.   

Note the option to import “standard cities.”  When you score a lot of races 
in the same geographical area, you soon find that most of the runners come from a 
relatively few cities.  Since, as you’ll see (page 20), the ARJ system looks up cities in the 
CITIES file after you start typing their names starting at the top of the file, it is 
convenient to use a CITIES file that begins with the most frequently encountered cities. 
In my case, I have a set of 50 cities with which the CITIES file always begins in every 
race I do.  After entering those cities manually for some race, I copied the CITIES file 
(along with an associated file called ZIPCODES) to the folder in which I file the races 
and locate the “standard cities” when prompted to do so, copying the first 50.  At the 
same time this imports corresponding zip codes into a ZIPCODES file, which suggests 
a zip code after you enter a city (see page 20). 

Storing cities enables storing street addresses (in a file called 
ADDRESSESN) and email addresses (in file SUPERDATA).  ARJaM 
allows you to email individuals with their time, place overall, and age 
group place, and makes entering email addresses reasonably easy.  If 
you want to do so, you will also store an “extra data” field for each 
runner (in file OTHERDATA) which may or may not be useful (it can be 
important in chip-timed races).  At this time you can also elect to enter 
runners’ ages on race day from their dates of birth. 

The ADDRESSESN file contains, besides the runner’s street address 
and zip code, an optional “division code.”  Division codes and names 
are stored in a file called KEYCODES.  The dialog at left allows you to 
copy an existing KEYCODES file from a similar event.  Division codes 
will be explained in detail on page 12.  For now simply note that if you 

wish to use such codes, you must create an ADDRESSESN file and hence a CITIES file. 
Next you input the age/sex 

group for awards.  First you are 
asked if you want to copy an 
existing CLASSES file (like the one 
you used for this race last year, for 
example).  If not, you are asked for 
the number of male age groups and 
whether the female age groups are 
the same.  

Road Race   
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If you have six or seven age 
groups, NewEvent assumes you 
will have 10-year age groups 
terminating at either “60 and up” 
or “70 and up,” and fills in the 
age-group breaks accordingly.  
Otherwise you enter the 
maximum age in each class (127 is 
the default maximum age in an 
ARJaM event).  Age-group 
abbreviations are created for you, 
but can be modified (three letters 
maximum; you could use OpM for 
the lowest male age group, e.g.).  
They can be printed out in lists by 
Sorters and SetData – see pages 23 
and 32 – and in the results, to 
indicate the age group in which they competed.   

Finally you are asked for the number 
of separate finish lines.  Usually it’s just 
one, but you may have consecutive races 
(not finishing simultaneously).   

If you do have separate 
consecutive races, you are asked 
to name each one, just as when 
doing a cross country meet with 
separate girls and boys races 
(see page 8 above).  A set of results files (ORDER, TIMES, and IDENTIME) will 
be created within a subfolder of the race folder whose name is that of the finish 
line; see page 8.  But if you have multiple races that go through the same finish 
line during the same time frame, treat them as a single race/finish line.  ARJaM 
can easily sort out the different distances if you assign division codes to runners 
in the different races, even if the races do not start at the same time (page 57). 

Some road races with multiple distances finishing concurrently use different 
age groups depending on distance.  In such cases, your best bet is to create 

separate folders for each race (even if they start together and go through the same 
finish line) and click on the “Age/sex groups depend on race distance” box that shows 
up in the dialog above when you are tracking age and sex.  You will then put the 
appropriate CLASSES files in each race folder (one of which you can copy from 
whichever CLASSES you created already).  The race-scoring program RaceDay will 
automatically substitute the correct file for the race of interest when you switch from 
one “race” to the other. 

If start times are recorded, click on the 
appropriate check box in the dialog on page 9.  
Separate folders for the start and finish (with 
default names “Finish” and “Start”) are created 
in the race folder.  If there are multiple races, 
start and finish folders are created in each race 
folder.  Results files ORDER, 
TIMES, and IDENTIME are created 
in each folder.  The start folder(s) 
also get files called ORDERX and 
TIMESX; these store the finish order and times in 
order of net time; see page 53.  The file structure 
is for an event with two races with start times 
recorded is shown at right. 

 
 
 

 

 

 

Multiple Races 

 

 

Start Times 
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If splits are recorded, you are asked to name them.  In naming the split folders, keep 
the names down to 12 characters.   Longer names will mess up the results printout (see 
page 64). Subfolders of the race folder with those names will be created with those 
names and a set of race files created within each folder.  A subfolder for the race finish 
will also be created in the race folder; as shown above, its default name is “Finish.”  If 
there are multiple races/finish lines, similar subfolders are created within the folder for 
each race.  

NewEvent creates in each folder containing a ROSTERN.tex file a text file called 
“Notes.txt.”  Initially it contains the name, location and date of the event.  By the time 
the meet is over the RaceDay application will have added the weather, useful if you 
later have to edit the results.  SetData also records counts of entrants by age group, the 
total of which may be needed for your bill.  Both programs allow you to edit the Notes 
file.  If you need to record your mileage, etc., create a file in the folder where your 
programs are kept (typically ARJW14) to remind you of what you need to record.  Mine 
looks like this: 
 
Travel (miles):  
ROAD 
Generator? 
Chutes? 
Clock? 
Numbers: 
Team scoring: 
Races/finish lines: 

Two things need to be emphasized: usually you run NewEvent only once per event.  
Once you have created runner-data files like ROSTERN to hold the proper types of data 
on the competitors, and results files like ORDER and TIMES to hold the race results, 
you use the other programs in the ARJaM package to fill those files and to report on the 
data they contain.  Each of those programs does “open up” the files that it needs, but 
NewEvent creates them in the first place.  If you do run NewEvent twice for the same 
meet, you will be told that the file you want to “open” already exists and asked to 
confirm (by answering the question, “are you sure?”) that you want to overwrite it. 

Secondly, be generous in sizing the files.  The ARJaM programs will complain if you 
ask them to read or write data beyond the end of the files as you create them.  The 
ARJaM files are very compact, so that you can usually afford to have quite a few empty 
lines in them. 

Splits 

The Notes File 

Points of 
Emphasis 
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Step 2:  Pre-Event Data Entry 
Now you need to enter the data on the runners, at least those who are pre-

registered, and assign them ID numbers.  If you have a text file containing the requisite 
data, the DownLoad application discussed below can do most of the heavy lifting for 
you.  But it won’t help you with race day entrants, so we will first look at program 
SetData, which has some limited options for uploading data from a file but also allows 
you to enter data from entry forms one at a time. 

First we will explain ARJaM “divisions.”  The scoring application RaceDay will 
score runners by age group or team, using data that you enter (mostly) before the 
event.  Some events have multiple divisions that must be scored concurrently.  For a 
simple example, a road race may have multiple distance options, such as 5K and 10K, 
and have them all finish in the same chute.  Using separate chutes would demand 
separate timing setups (and also some intelligence on the part of the runners).  A cross 
country meet may want to run girls and boys together (typical for middle school 
traces), or score small and large schools separately, or schools from a certain locale 
among themselves as well as against all participants. 

Both SetData and DownLoad allow you to create “division codes” that RaceDay can 
use to distinguish different award groups.  Codes are simply alphanumeric characters; 
each division is defined by a unique combination of codes, which are used to identify 
the race division of each entrant.  A runner’s codes are stored in the ADDRESSESN file, 
which must therefore be created in program NewEvent.  That, in turn, requires 
enabling storage of cities, or clicking on the TFRRS IDs option in the dialog on page 7.  
The names of the divisions and their codes are stored in a text file called KEYCODES. 

For a simple 5K-10K event, you could separate their results by inserting a blank 
record between their ID numbers, as described on page 6.  However, runners often 
change their minds as to which event they want to run.  Using division codes to 
distinguish the 5K and 10K runners makes it possible to account for such indecisiveness 
relatively easily in the race scoring program, as is discussed on page 46.  Thus you 
could give all the 5K runners a code of “5” and the 10K runners a code of “T”: 

Code Division 
5  5K 
T  10K 
Some races have more complex award systems.  The race may wish to list walkers 

separately from runners (and also with them), awards can be based on the runner’s 
weight (“Clydesdales” and “Heavyweights”), or given to veterans or residents of 
nearby towns.  Here are a couple of examples to illustrate the possibilities. 

Consider a 5K/10K race in which 5K runners and walkers are to be listed 
separately.  The KEYCODES file could be set up as follows: 

Code Division 
R  5K Runner 
W  5K Walker 
T  10K 

This would separate 5K runners, 5K walkers, and 10K runners.  However, suppose the 
race wanted to list all participants in the 5K together as well as separate the runners 
and walkers.  If so, set up divisions like this: 

Code Division 
5R  5K Runner 
5W 5K Walker 
T  10K 

and look for runners with a “5” among their codes.  On the other hand, if there was no 
need to list 5K runners separately from 5K walkers, you could eliminate the “5K 
Runner” division: 

5  5K 
5W 5K Walker 
T  10K 

Division Codes 
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The rule is this: Each division must have a unique code, which can be a single 
character or a combination of characters.  Codes are case sensitive.  If you enter a code 
of “t” instead of “T” for a 10K runner, the division name will show “No code assigned.” 

In fact codes that are lowercase characters (“a” to “z”) have a special, useful 
property.  In the “preliminary results” printout discussed on page 43, the divisions of 
runners whose division code contains a lower-class character will be printed out on the 
far right.  Making the codes in the preceding example 5, 5r, 5w, and -5 will show the 
divisions of all 5K participants in those results but not of the 10K runners.  This can be 
useful in checking that divisions were assigned correctly.  It may be more useful to 
make W and T lowercase, so that you can see when walkers and 10K runners have 
started to arrive. 

You are limited to seven distinct characters for codes.  From seven characters you 
can construct hundreds of distinct keys.  Keeping them mnemonic is not terribly 
important; except in SetData’s Proofreading display, you are always shown the division 
name that goes with the code.  However, you can extend the utility of a given number 
of keys by “negating” them.  The preceding example could have been coded as follows: 

5R  5K Runner 
5W 5K Walker 
-5  10K 
or 
5R  5K Runner 
5-R 5K Walker 
-5  10K 
Note that if a runner belongs to a division with a code of “-5,” that simply means 

that the code(s) in his division do not include a “5.”  Thus in entering or editing a 
runner’s data (in SetData or RaceDay), you would not enter a “-5” in the code box (like 
the one on page 18).  On the other hand, when selecting runners to list by division in 
RaceDay (see page 57), if you want to enter a code rather than pull down the pop-up 
menu to the division name, you could enter “-5,” meaning that you want to exclude 
runners with a code of “5” in their record.  Strictly speaking, you do not have to enter a 
division name for the 10K runners in the above examples, but if you don’t you will 
have to enter the division name in RaceDay.  So you may as well enter it before the 
race. 

Entering a negated code is rare, and indicated by a note about the use of minus 
signs as in the dialog on page 57.  Here’s a case in which it makes sense to use a 
negated code.  Some races give awards or otherwise recognize walkers.  Relying on 
entry form information for a runner’s intentions is always chancy; the run/walk 
division is particularly problematic.  First create divisions of walkers and runners, with 
codes W and -W respectively.  Have the walkers start a few minutes after the runners.  
After the runners start, line the walkers up and enter a division code of W for each.  
Since the runners’ code is -W, you don't have to do anything with them. 

To tag the walkers, if there aren’t that many, sort all the entrants alphabetically in 
program Sorters and use the “scroll thru list” option to edit their division codes; see 
page 30.  For chip races, if you are recording start times, use RaceDay’s “Tag finishers 
with division code” option (under its Other Options menu) to tag the starters with a W.  
If you are not recording start times, have them walk across a mat before they start 
anyway, recording their passages as if it were a start time.  In any case, you can easily 
correct for their late starts in RaceDay with the “Correct constant error” item under the 
Times menu, which can be confined to runners with specified division codes. 

For TFRRS cross country meets, coaches may submit a roster that contains the 
team’s TFRRS IDs and then indicate separately the runners who will compete.  It may 
be useful to tag the non-competitors with a division code.  A division code of “T” is set 
automatically for TFRRS meets for which an ADDRESSESN file is not created by first 
declaring you want to enter cities in the dialog on page 7 but instead by clicking on the 
“TFRRS IDs” box.  For TFRRS meets that are chip timed with IPICO or MyLaps shoe 
chips and so require an OTHERDATA file, you should add the “T” tag code (with a 
“distance” of -1.0) manually. 

Start up ARJMenu and click on “Pre-Event Data Entry.”  Call up SetData by clicking 
on the top-most button of the dialog on page 4 and hit <enter>.  This brings up the Program SetData 
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“open file” dialog discussed on page 4.  Locate the folder for your race/meet and open 
up the ROSTERN file. 

If cities are being tracked, you are 
asked if you want to work with addresses 
at this time.  If you are not tracking 
addresses, you should hit “Cancel,” but if 
you don’t you will simply be told that 
none are being filed.  On race day, you 
may choose not to work with addresses, 
to save time entering data on race day 
entrants in the files for results purposes.  
Entering PRs is rarely of interest in any 
case, and shirt sizes are usually irrelevant 
after packet pickup. 

If age and sex are being tracked, you then get an option to enter the 
runners’ birth dates, from which their age on race day would be 
calculated, and, if so, whether their age group is determined by their 
year of birth rather than their age on race day, as in the case in Junior 
Olympic competition.  If you do want to accept one of these options, 
click on the box before clicking on “OK” or hitting <enter>.  A file called 
DATES.TEX will be created (if it has already been created, the first box 
is checked on when you start up SetData; you may then click on the 
second one, too). 

The main options of SetData are shown in the buttons on its desktop.  
Obviously, we need first to discuss how it is 
used to “Add Data on Entrants.”  Before 
getting into this, however, we will look at 
some menu options in SetData that can be 
used to correct errors you may have made in 
setting up the files. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If the age/sex groups you entered are not what the race wants to use for awards, 
pull down the Edit menu to “Change age-sex groups.”  You’ll be led to dialogs like 
those on page 9 with which you set up the age/sex groups in the first place. 

The “Race date” item under the Edit menu allows you to edit the date that was 
entered while creating the files.   

 

 

 

Editing Decisions 
Made in NewEvent 
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Suppose you realize that you made the files too small.  Pull 
the Expand files menu down to the appropriate item (to 
explain “ROSTERN at al,” if the ROSTERN file is too small, so 
are ADDRESSESN, OTHERDATA, and SUPERDATA, if they 
were also created).  The dialog at left asks for the number of 
lines you wish to keep and how many you wish to add to the 
file.  Ordinarily you would accept what’s in the first box and 
just enter the number of lines you wish to add in the second, 
but sometimes, the file is filled to the limit, it may have been 
filled with junk thru a mistake in DownLoad, e.g.  In such 
cases you can limit the number of records that will be 
retained. 

If you find that the event has a different range of bib 
numbers than you expected, simply go to the “Numbers” item under the Edit menu 
(Ctrl+N) and change the first number on file.  Anyone you have already entered will 
have their ID number changed to match the change in first number. 

If you discover that the race has team competition but you did not set it up to track 
teams in NewEvent, you will have to go back to NewEvent to enable them.  Click on 
“Data Base” so you won’t have to deal with the results files, and say you want to 
“Replace or revise existing files.”  Locate the ROSTERN file.  You’ll be asked if you 
want to replace it.  Accept the default (“No”).  You’ll get the basic data dialog back.  
Click on “Teams.”  Continue through the rest of the dialogs, declaring how many teams 
you expect but otherwise without changing anything.  Then, when back in SetData, 
pull the Edit menu down to “Data types stored.”  Make sure Teams is checked. 

To use the division 
codes discussed above, 
create a KEYCODES 
file by pulling the 
Other Options menu 
down to “Make or add 
to file KEYCODES for 
division codes.”  For 
each division you wish 
to flag in the results, 
enter its name (“Half 
marathon,” e.g.) and an 
appropriate code (like 
“H”).  If the division 
defines the distance of the runners’ event, enter it.  If the division has nothing to do 
with the results (people who owe money, or to whom you must mail a T shirt, e.g.), 
enter a “distance” of -1.0.  The code you assign will show up in their records and will 
be searchable but will not affect the results.  ChipData tags runners whose chips are 
missing after the event with such a “tag code,” and RaceDay can tag finishers in similar 
fashion with an item under its Other Options menu. 

Data entry for a team-based cross 
country meet is very straightforward.  
On clicking on the “Add Data” 
button (Ctrl-A) you are invited to add 
entrants at the next available ID 
number and to add entrants by team 
(the first two options are blocked out 
unless addresses are available).  I like 
to assign males and females numbers 
in different ranges, and so override 
the default starting number when 
switching genders.  That makes it 
easy to print out separate lists and 
labels for boys and girls/men and 
women and to score them separately if they run together (as often happens in middle 
school races), and also to assign them division codes that indicate their gender. 

 

Division Codes 

 

Cross Country 

 



  
16 

The entry form for a simple cross country 
meet is pretty sparse.  Enter the runner’s 
name, first name first.  Then tab to the “Age” 
box and enter his/her year in school (I use 7-
12 for high school meets, some like 1-4; ages 
of 1 to 4 are output as “Fr,”, “So,” “Jr,” and 
“Sr”).  If you enter two characters in the 
“Age” box, the cursor jumps to the “Team” 
box.  If you are entering runners by team (you 
probably get their rosters team by team), the 
team name is already there once you enter it 
for the first runner on your list, so just hit 
<enter> to accept the entry and move on to 
the next ID. 

Here are some details of this process. 

Number.  The ID number is automatically indexed for you in SetData’s “Add 
entrants” mode; after each person’s data are entered, it is increased by 1.  If you need to 
skip around, click on or shift-tab to the “Number” box (hitting <tab> moves you to the 
right and down; holding the shift key down while you hit <tab> moves you back), 
enter the desired number and hit <tab> (or <enter>). 

To change the number of a runner already assigned one, you cannot simply edit 
his/her data and change the number in the “Number” box.  All that does is to recall the 
data already entered (if any) for the new number.  Instead use the “Move line” option 
under the Other Options menu; see page 25. 

If you need to skip a number while in the Add Entrants mode (if it’s not available, 
e.g.), type “>.”  If you see you made a mistake after you accept an entry (or if you hit 
<enter> too soon) and so want to go back to the preceding entry, type “<.”  Caution: do 
this after you have accepted the current entry.  Whatever is showing on the screen 
when you hit “<” or “>” is not saved. 

Name.  The alphabetizing and search routines expect the last name to begin after the 
first space.  Therefore, if the entrant has a middle initial, put a “.” before the middle 
initial, as in 

JACK.P MORAN 
You can enter names all in capitals to save time; they will be printed in initial-cap 

form in lists and final results.  The initial-cap routine will capitalize the letter after any 
space, period, parenthesis, hyphen, or lower-case letter.  All other letters are (if 
necessary) converted to lower case, except for      

(a) the I’s in “II” and “III” following a blank space;     
(b) the first letter following the combination “Mc” 
(c) the first letter following a letter initially input as lower case.   
Thus you can type in “McNutt” as “MCNUTT”, but “MACNUTT” becomes 

“Macnutt”.  To get “MacNutt”, type “MAcNUTT” or “MacNUTT.”  

If the last name of an entrant is the same as the one you last entered, type an up-
arrow (“^”, shift-6) in the first space of the “Name” box and that surname will be 
recalled. 

Team.  If there is nothing in the “Team” box, or if it is the wrong team name, tab to 
the “Team” box (if you have not been sent there already after entering an age) and 
input the initial letter of the runner’s team. SetData will search through its list of teams 
until it finds one that begins with that letter.  If it does, it will pull it up into the “Team” 
box.  If that’s the team you want, hit <enter> to go on to the next runner.  If not, type 
the second letter. SetData then looks for the next team in its list beginning with the two 
letters you typed, etc.  This is called “completion.”  If it’s a new team, you’ll just end up 
typing in its full name.  For example, suppose you want to type in “MINNESOTA.”  
After you type an “M” the program may show you “MICHIGAN.”  That’s not what 
you want, so you type an “I.”  Now the program shows you “MICHIGAN STATE.”  
That’s still not what you want, so you type an “N.”  “MINNESOTA” is not on file, so 
the program waits for you to type in “NESOTA.” 
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This system only works when you tab to the “Team” box.  If you instead click the 
mouse on the box, the program assumes you want to edit the name of an existing team.  
Thus, to correct a typo in the spelling of a team, click on the team box.  Tabbing to it 
tells the program you want to enter a new team.  To eliminate a team from the runner’s 
record, do not select its name and then hit <delete>; that may wipe out that team’s 
name in the record of every runner from that team.  Instead, enter “0” (zero) for its 
name.  The runner is then “Unattached.” 

Although not as flexible as 
the DownLoad program to be 
discussed below (not part of 
the Cross Country package), 
SetData does have the ability 
to upload entries from a 
properly formatted text file.  
Pull the Add menu down to 
“Entrants from file” (Ctrl-R).  
The second choice is useful for 
moving data between 
computers (see page 36), and 
the next enables uploading a 
Hy-Tek formatted file.  A 
“Standard email” file is simply 
a tab-delimited file with three 
fields ordered team, name, and 
age/year in school.  It’s pretty 
flexible, however.  One or both of the tabs can be replaced by a comma, and the first 
and last name can be separated with a delimiter, too.  Thus, all of the following could 
be lines in the file: 
Webster<tab> Joey Erickson<tab>12 
Webster<tab> Dan Formanek, 9 
Webster<tab> Nathan<tab> Gatten, 9 
The only hard requirement is that the names be first name first.   

The fourth item allows you to upload a tab- or comma-delimited file that has a 
header line, like 

First name, last name, year of eligibility, team 

so that SetDats can identify the fields in the file. 
One way to get a “standard 

email” file is to use Apple 
Raceberry JaM’s online entry 
service ($50 per meet).  But it’s 
not hard to set up such a file if 
you can get the coaches to send 
you an Excel file with their 
runners’ names and school year 
in separate fields.  I’m not much 
of an Excel user, but here’s what I 
would do with such a file, using 
my Word expertise. 

Save the Excel file as tab-
delimited text.  Open the text file 
from Word.  Select it all, and use 
the “Convert text to table” item 
under Word’s Insert/Table menu 
to make it into a table.  Select the 
first column, and then use the 
“Insert Columns to the left” item 
under Word’s Layout menu to 
put a third column in front of the 
other two.  Type the team’s name 

in front of just the first member of that team, select the table, and then 

Uploading Entries from 
a File for Cross Country 
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“Layout/Convert table to text,” accepting the tab-delimited option.  Save the file as 
text, and concatenate it with similar files from other teams.  The final result will 
resemble what’s shown below.  Although the team name does not appear on every line, 
it’s good enough; SetData will assume a runner belongs to the same team as the last one 
if the team field is blank. 

You will be asked for the range of ID numbers in which to 
file the data, the default starting after the last ID number on file.  
You can override that if you wish to overwrite the data currently 
on file, or if you want the numbers of the runners in the file 
you’re importing to be in a range different from that of the 
runners currently on file (as when you want to assign numbers 
in blocks by gender, see page 6). 

For NCAA meets, you can also upload TFRRS IDs from a 
properly constructed “standard email” file.  The format is 
Minnesota-Duluth<tab>Bethany Alber, 
1<tab>TFRRS<tab>224794BET*ALBE 
Minnesota-Duluth<tab>Kate Bendel, 
3<tab>TFRRS<tab>162384KAT*BEND 
Minnesota-Duluth<tab>Amanda Boman, 
2<tab>TFRRS<tab>962278AMA*BOMA 
Here “TFRRS” is case-sensitive.  The last field is the ID.  You can 
upload the IDs after you load the entries; SetData will attempt to 
match the names in the TFRRS file with those submitted for 

entries.  Runners in the TFRRS file but not entered will be tagged with the division code 
“T” (see page 13).  You can move all those athletes to the end of the ROSTERN by using 
the “Move coded runners to end of file” item under the Other Options menu.  You can 
also use the “header” format to upload a standard TFRRS roster file. 

You should list the entries afterwards to track down missing IDs in the entries (the 
IDs are in the address field), which may a result of different/mis-spellings of the 
runner’s names in the two lists. 

For road races, when you click on the “Add Data on Entrants” button, the dialog 
shown on page 15 pops up.  We’ll discuss the first two options on pages 22 and 80. 

As can be seen below, the entry form that shows up in road races is much richer 
than in the cross country meet discussed above.  After entering a name, hit <tab> or 
<enter> to advance to the age box and then to succeeding boxes.  When you’ve entered 
all the data on the entry form, hit <enter> to advance to the next entrant. 

Here are some details of this 
process.  Some are repeated from 
the discussion above of the cross 
country meet, but you may have 
skipped that section. 

Number.  The ID number is 
automatically indexed for you in 
SetData’s “Add entrants” mode; 
after each person’s data are 
entered, it is increased by 1.  
However, you may need to skip 
around, either to fix mistakes or 
because the numbers were 
preassigned by the race.  To 
change the ID number, click on or 
shift-tab to the “Number” box 
(hitting <tab> moves you to the 
right and down; holding the shift 
key down while you hit <tab> 
moves you back), enter the 
desired number and hit <tab> (or 
<enter>). 

To change the number of a 
runner already assigned one, you 
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cannot simply edit his/her data and change the number in the “Number” box.  All that 
does is to recall the data already entered (if any) for the new number.  Instead use the 
“Move line” option under the Other Options menu; see page 25. 

If you need to skip a number (if it’s not available, or was not used in in-person 
registration), type “>.”  If you see you made a mistake after you accept an entry (or if 
you hit <enter> too soon) and so want to go back to the preceding entry, type “<.”  
Caution: do this after you have accepted the current entry.  Whatever is showing on the 
screen when you hit “<” or “>” is not saved. 

Name.  Enter first names first; the alphabetizing and search routines expect the last 
name to begin after the first space.  Therefore, if the entrant has a middle initial, put a 
“.” before the middle initial, as in 

JACK.P MORAN 
You can enter names all in capitals to save time; they will be printed in initial-cap 

form in lists and final results.  The initial-cap routine will capitalize the letter after any 
space, period, parenthesis, hyphen, or lower-case letter.  All other letters are (if 
necessary) converted to lower case, except for      

(a) the Is in “II” and “III” following a blank space;     
(b) the first letter following the combination “Mc” 
(c) the first letter following a letter initially input as lower case.   
Thus you can type in “McNutt” as “MCNUTT”, but “MACNUTT” becomes 

“Macnutt”.  To get “MacNutt”, type “MAcNUTT” or “MacNUTT.”  If you have the 
caps-lock key down, you can input a lower-case letter by using the shift key. 

If the last name of an entrant is the same as the one you last entered, type an up-
arrow (“^”, shift-6) in the first space of the “Name” box and that surname will be 
recalled. 

Age.  Tab to the “Age” box and enter the age.  I like it when entry forms ask for both 
age and date of birth, since if I can’t read the age I can figure it out from the birth date.   
Sometimes the runner is too lazy to enter an age on race day as well as a date of birth.  
If so, type a “B” in the Age box.  A dialog pops up and asks for the date of birth (be 
sure to enter four digits for the year of birth), and the age is computed as of the day of 
the race. 

SetData assumes all your runners have ages under 100, so if you enter two digits the 
focus automatically shifts to the next box (probably sex).  If you get a runner over 100, 
type a “B” in the age box and enter his/her birth date, from which an age is computed. 

If you had declared in NewEvent that all ages would be computed from birth dates, 
three boxes for the entrant’s month, day, and year of birth would have preceded the 
“age” box, and the age would have been computed from your entries in those boxes 
(and the race date you entered in NewEvent) and displayed in the “age” box.  Entering 
a month greater than 9, a day greater than 3, or two digits of the year shifts the focus to 
the next box.  If the runner doesn’t supply his/her birth date, you can enter the age on 
race day instead directly.   

Sex.  Tab to the “sex” box (if necessary) and enter “M” for male or “F” for female.  
This moves you to the next box. 

Address.  You should then be in the “Street” box.  Enter 
the street address, including apartment number.  Only 
twenty-three (23) characters are available for the runner’s 
address, and you may have to abbreviate. 

If the street address of an entrant is the same as the last 
one you entered, type a caret (shift-6; “^”) in the first space 
of the “Street” box and that address will be recalled, 
including the city and zip code.   

If not, but you think someone else with the same last 
name has already been entered, type a “?” in the box.  
SetData searches thru the file of entrants and, if it finds 
someone with the same last name as the one you just 
entered, pops his/her address into the form and asks if 
that’s the one.  If it’s not, SetData will continue to search 
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for a match until you hit either accept the data or it gets to the end of the file. 

City.  If the runner has an address different from the one preceding, so that you 
cannot take advantage of the short cut above, tab to the “City and state” box.  Cities 
(and teams) are stored in a person’s file by number, with team and city names being 
stored in separate files.  Type the city’s initial.  The program searches through its list of 
cities until it finds one beginning with that letter.  If it finds one, it beeps and displays 
in the box the name of that city, and “selects” the part after the first letter; i.e., reverses 
that part so that it is deleted if you type anything over it, as shown above.  If this is the 
city you want, accept it by tabbing to the zip-code box.  If not, type the second letter.  
The program now looks for the next city (in its list) beginning with those two letters.  If 
it finds one, it beeps, displays the city’s name, and selects all but the first two letters.  
Eventually, it either finds the city you want or lets you type in the rest of the name.  
(This is called “completion.”)  For example, suppose you want to type in 
“MINNESOTA CITY, MN.”  After you type an “M” the program may show you 
“MINNEAPOLIS, MN.”  That’s not what you want, so you type an “I.”  Now the 
program shows you “MINNETONKA, MN.”  That’s still not what you want, so you 
type an “N.”  “MINNESOTA CITY, MN” is not on file, so the program waits for you to 
type in “NESOTA CITY, MN.” 

To eliminate a city from the runner’s record, do not select its name and then hit 
<delete>; that may wipe out that city’s name in the record of every runner from that 
city.  Instead, enter “0” (zero) for its name.  This is more important when dealing with 
teams than cities; see page 16. 

This system only works when you tab to the “City” box.  If you instead click the 
mouse on the box, the program assumes you want to edit the name of an existing city.  
Thus, to correct a typo in the spelling of a team, click on the team box.  Tabbing to it 
tells the program you want to enter a new team.  

With this system it pays to have frequently encountered cities already on file when 
you start entering names.  You can enter cities separately by pulling down the Add 
menu to “Cities.”  I have fifty favorite cities that I have on file for every race I do.  See 
page 9. 

If you want to print out results for all runners from particular states, be sure to end 
the entry for the runners’ city and state with the standard two-letter abbreviation for 
those states; see page 62. 

Zip Codes.  When the cursor arrives at the zip code box, the last zip code entered for 
the runner’s city will be recalled from a file called ZIPCODES and displayed in the zip-
code box.  The fourth through last characters of the zip code are “selected,” as shown 
above.  This allows for the fact that a sufficiently large city will have more than one zip-
code area within its limits, but the first three digits are usually the same.  If you do have 
to change the third digit, just backspace.   

Of course, if this is the first runner from that city, no zip code will be on file in 
ZIPCODES and the cursor will rest on the first character of the zip code line.      

PR (Previous Best Time). If the race’s entry form asks for previous best time, the 
race director may want you to fill in the PR box.  You will then be able to keep track of 
personal records in the results and/or assign numbers by previous best time.  The 
format required for a PR is (hours):(minutes):(seconds).  If the time is less than an hour, 
all you need is (minutes):(seconds).  You can, if you wish, input a time greater than an 
hour in this same format; e.g., 70:00 = 1:10:00.  You do not have to input “insignificant 
zeroes;” this same time could be input as “70:0,” and even as “70:” or “1:10:”.  But “70” 
would be interpreted as 70 seconds.      

A common typing error is to input a semi-colon instead of a colon; if you do this, 
the program will assume that you meant to type a colon.  Thus you can save a little 
time by just typing the lower-case semi-colon instead of the upper-case colon.   

Because PRs are so seldom required, you are asked when you start up and SetData 
and invited to enter addresses if you really want to “Enter and review PRs,” the default 
being off, as shown above.  You can change your mind after starting SetData by 
toggling the “Enter and edit PRs” item under the Other Options menu. 

Team.  If the race has team competition, usually not every entrant will have an 
affiliation, so you will have to watch out for those who do.  Tab to the “Team” box and 
start inputting the runner’s team. SetData will search through its list of teams and 
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attempt to complete your entry, just as it does for city names.  See also the discussion of 
entering cities for the difference between clicking the mouse on the box and tabbing to 
it. 

To eliminate a team from the runner’s record, do not select its name and then hit 
<delete>; that may wipe out that team’s name in the record of every runner from that 
team.  Instead, enter “0” (zero) for its name.   

In road races it often happens that awards are given for different types of teams: all 
male, all female, and mixed, for example.  (If it is just all men and all women, you do 
not have to do anything at this point.  The scoring program RaceDay can easily 
separate all-men from all-women teams.  It can also score masters and grand masters in 
a roster based on their age and sex, but assumes that masters and grand masters can 
also score in a younger division.)  In cross country this is not usually a problem, 
assuming males and females compete in separate races.   

If you are scoring teams in classes, assign each team class a two-character code and 
include that code in the last two characters of the team name.  Here are a few examples:      

OP Open     
MW Masters women     
MD Mother-daughter     
CL Corporate (large)   

Teams in these categories might be entered      
TWIN CITIES TC OP     
CALIF CONDORSMW     
JONES'S MD     
3 M COMPANY CL   

Note that the codes are case dependent. 
To simplify team scoring in classes (see page 59), use the “Make file TeamCodes” 

item under SetData’s “Other options” menu to store the abbreviations you use and the 
categories that they define.   

Shirt size. The race director may want you to keep track of shirt size.  You will be 
able to count the numbers of each shirt size ordered and print out packet labels with 
the runner’s shirt size on it.  The pull-down menu for shirt size has 16 different sizes, 
plus “Unkown” and “None.”  You can save data entry time by typing the initial let of 
the size you want (“X” for extra large and variations, “W” for women’s sizes, “Y” for 
youth). 

To record shirt sizes, you must open an ADDRESSESN file, which in turn requires 
that you track cities. 

Division code.  If you have created a KEYCODES file (which in turn requires that 
you open an ADDRESSESN file, which requires that you track cities), you can declare 
the runner’s division by selecting from the pull-down menu next to the shirt size menu.  
Or you can enter the code in the box to its right. 

Although you can enter the runners’ division codes as you enter their names, if they 
are grouped by ID number there’s an easier way.  Use the “Assign division codes in 
batches” item under the Other Options menu to tag the entrants. If you’re entering data 
from paper entry forms, this makes it a good idea to separate them by race entered first 
to facilitate batch processing of the division assignment.  See page 25 for details; you 
can also assign codes by gender, for members of selected teams and residents of 
selected cities, and for entrants with certain codes. 

Extra Data.  If you elected to open an OTHERDATA file in NewEvent (page 9), you 
can enter any 23 characters you want in the next box.  Those data can be used for a 
second address line, and printed out on labels below the street address line, or for such 
data as telephone numbers and birth dates, and printed out in lists or on the first line of 
“packet labels.”  They are also used for chip numbers in some systems. 

Super Data.  If you also elected to store “super data,” a file called SUPERDATA is 
opened for you.  This holds one 39-character string per runner, which should be 
enough for most email addresses.  If that’s what you’re using it for, hit a “-” (dash) 
when you get to the super data box.  The runner’s name will be inserted in the box, 
stripped of spaces and followed by the “@” symbol.  Like “JACKMORAN@.”  SetData 
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will complete many choices of the email service for you.  If you enter “A” after the @, 
you get AOL.COM; “H” gives HOTMAIL.COM; “M,” MSN.COM; “E,” 
EARTHLINK.NET; “C,”, COMCAST.NET; “S,” SBCGLOBAL.NET; “P,” 
PRESSENTER.COM.  To get MSCHI.COM, press “M,” backspace, “S.”  To get 
EMBARQMAIL.COM, it’s “E,”, backspace, “M.”  If a runner has the same email 
address as the one entered just before you started on this one, hitting “^” (shift-6) will 
repeat the address. 

If you have purchased the optional Data Base package, and have used it to build up 
a data base of runners from races you have scored (see page 81), you can save a lot of 
work in entering runners in a new race.  When you select SetData’s “Add entrants” 
option (Ctrl+A), the dialog on page 15 appears.  Click on the “Add addresses by 
name/age/sex” box; you are then asked to locate the ROSTERN and ADDRESSES file 
of your data base, and the usual “Entry form” appears. 

After you enter a runner’s name, age, and sex, SetData searches for that runner in 
the data base.  If it finds someone with the same last name (or close to it; DataBase 
“hashes” the last name by removing vowels while filing a runner’s info), age (+2 years), 
sex, and first-name-initial, it beeps and displays the runner’s address.  A dialog like 
that on page 19 asks if this is the address you want.  If the runner found has a different 
name or address from the one you want, click on the “No” box or hit <esc>.   

In fact I usually enter only the runner’s last name and let the program look up the 
first name (except when the last name is really common, as “Anderson” is in 
Minnesota).  If no acceptable “hit” is made, a space is inserted in front of the last name 
and the cursor jumps in front of that so you can fill it in.  You can then jump down to 
the (empty) address box, past the age and sex you’ve already filled in, by hitting the 
down-arrow.  If the name was found in the data base file, you can jump from the 
address box to the shirt size box (if you’re entering shirt size, division codes box if 
you’re not) by hitting the down arrow. 

If the runner does not supply an age or date of birth, tab past the age box and enter 
the sex.  SetData will search for runners with the same name and sex as the one you 
input.  I often find the runner’s age this way, especially when the race’s entry form is so 
poorly designed that the age box is ignored (for best results, put the age and sex blanks 
up at the top).  SetData computes the runner’s age on race day from an estimate of 
his/her birth date, which in turn is based on the runners’ age on the day of the last race 
he/she ran, so far as you know. 

Undoubtedly you have heard the computer programmer’s slogan, “Garbage in, 
garbage out”. The race results are liable to be garbage 
if you don’t proofread your ROSTERN. All it takes is a 
little mistake in typing in someone’s age or sex, and 
your list of class winners is messed up.  

Be sure to check the data you have in the computer 
against the entry blanks.  There are two ways to do 
this. 

If you plan to do the proofreading and corrections 
yourself, the quickest way is to use SetData’s 
proofreading option.  Click on the “Proofread” button 
or pull down the Edit menu to “Proofread” or type 
Ctrl+P.  The name, age, sex, team or (if teams are not 
stored) hometown, and, if addresses are on file, shirt 
size and division codes of the runners are now shown 
on a screen like that at the left, starting with the 
number you select.   

To scroll through the list, click on the “up” or 
“down” buttons (or click on your computer’s Page Up 
or Page Down buttons).  You can jump to an entirely 
different number by typing it in the “Go to” box and 
hitting <enter>.  When you find an item that is in 
error, click on it.  An entry form appears with the data 
for that entry in it and the cursor in the box with the 
erroneous data.  Fix the error.  After you accept the 
corrected data by hitting <enter> or clicking on “OK” 
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you are returned to the proofreading display, with the most recently examined entry at 
the top.   

You can also insert or delete lines in the ROSTERN from this display, as might be 
required to fit each team’s entries in a certain range of ID numbers.  Click on the 
“Insert” or “Delete” button or type Alt+I or Alt+D.  A dialog asks you how many lines 
to insert/delete and at what place to start; fill it in and hit <enter>.  You’ll be asked to 
confirm any deletions, which cannot be undone.  The data on runners after a deletion 
will be moved to lower ID numbers.  If you want to remove the data on a runner 
without changing anyone’s ID number, use instead the “Wipe out” option (Alt+W).     

The Insert, Delete, and Wipe out functions are also available outside the 
Proofreading option, under the Other Options menu and with the shortcuts Ctrl-I, Ctrl-
D, and Ctrl-W, respectively.  See page 25 for the Move and Copy options. 

When you’re done proofreading, click on the “Quit” button or type <esc>. 

If you can get help with proofreading, you can use the “List Data on Entrants”: 
button or the “List entrants” option under the File menu to create a printed list of 
recent entrants (see page 23) and ask your helpers to mark up the list with the needed 
corrections.  The “Edit Entrants” option (Ctrl+E) can then be used to correct errors in 
the data you entered on the runners and their cities and teams.  On entering an ID, the 
current data are displayed.  Use the mouse or <tab> to get to the item(s) that need to be 
corrected and fix them in the usual way.   

If you need to edit the spelling of a city 
or team name, select the “Cities” or 
“Teams” item under the Edit menu.  A 
scrollable list like that at right will appear; 
click on the one you want and a dialog 
will pop up with the city/team name 
ready for you to edit.  You can also edit 
city names from the proofreading display 
(if cities are shown; if teams are available, 
they are shown instead), as noted above.  
First click on the city name.  When the 
entry form appears, click on it again and 
you get the dialog that allows you to edit the city name.  Team names may be edited in 
the same way. 

To remove an item from the list, select its name in the editing dialog and delete it.  It 
will be replaced by “XX.” 

Especially for team names, it is important to resolve discrepancies in spelling of the 
name.  If the team or city name to which you edit an entry is already on file, you are 
asked if you want to assign entrants with the name you are editing to the one on file. If 
so, the rejected team or city name is changed to “XX.” 

Lists of entrants will be needed for 
packet pickup, among other purposes.  
Clicking on its “List” button (Ctrl-L) 
enables SetData to output data in 
numerical order.  First you choose the 
number range of interest from the 
dialog at right. As noted on page 6, it is 
often useful in cross country meets to 
assign boys and girls/men and women 
numbers in different ranges.  They 
generally compete separately and may 
or may not have different coaches.  If 
there is a range of unassigned IDs 
between the genders, you can select one gender or the other by entering a “?” in either 
of the Start/End boxes.  For example, if the males have the lower numbers, you can 
confine attention to them by entering a ? in the “End at what ID number?” box.  To 
concentrate on the females, enter ? in the “Start at what ID number?” box.  This option 
is ubiquitous in ARJaM; see page 57, e.g.. 

Editing by Number 

Editing City and Team 
Names 
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Next you choose the types of data you wish to list from a dialog 
like that at left.  Listing the keys to any “Division names” you may 
be using to sort out race divisions is available only if you created a 
KEYCODES file; see page 15.   

Program Sorters can also be used to produce lists of entrants, in 
alphabetical order and otherwise.  See page 32. 

 
 
 
 
 
 
 
 
 
 

If you need to find a 
runner’s ID number by name, 
click on the “Find” button, 
pull down SetData’s Search 
menu to “For ID by name” or 
type Ctrl+F.  Type the 
runner’s last name into the 
first box of the dialog at right 
and hit <enter>.  The ID 
number, full name, age, sex 
and team or home town of 
the first runner (the one with 
the lowest ID number) are 
put into the other two boxes.  
If this isn’t the one you want, 
click on the “Keep looking” button.  If it is, hit <enter> and you get the option of 
editing his/her data.  If not, the boxes clear, so you can look up someone else.   

To list runners by age group, city, team, or division, pull SetData’s Search menu 
down to the appropriate item.  You can either select a specific age group, city, or team 
from a dialog like those on pages 23 (for cities) or 31 (for age groups), or list all the age 
groups, cities, or teams from first to last by selecting the “All” item at the top of the list.  
In that case all the runners who belong to each subgroup are listed in numerical order 
beneath the group name.  Again you can select the range of ID numbers for which the 
search is made. 

When you search for teams, 
after you specify the types of data 
you want output and the output 
device, the additional options 
shown at right are available.   The 
“New column for each team” 
option (active when you output 
data to a printer) facilitates 
chopping roster printouts for 
coaches’ packets.  It works even 
better if you first pull the File 
menu down to “Page setup” and 
change the orientation to 
landscape. 

 
 

 

Searching for Specific 
Runners 

 

Searching for Runners 
by Age Group, City, 

Team, Division  
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SetData also has a Count menu that allows you to count entrants by age group, city, 
team, shirt size, and division codes for specified ranges of ID number.  Cities and teams 
are listed in alphabetical order in those searches. 

In races with team competition, every scoring system requires that participants be 
assigned to the correct team.  Before leaving SetData, pull down the Count menu to “By 
team.” Because of mistakes in data entry, you may have used two different versions of 
a team’s name.  In such cases, you need to put everyone on the same team.  Pull down 
the Edit menu to “Teams” and select the “wrong” team name.  Edit it to the “right” 
team name.  You will be asked if you want to reassign entrants from the wrong team to 
the right one.  You do.  The wrong team name will be set to “XX.” 

If you need to seed a runner whose data have already been entered, or otherwise 
want to change a runner’s ID number (which may be used to identify what race he/she 
is in; see page 57), you cannot simply use the “Edit Entrants” option, call up the 
runner’s present ID number, and then edit that number.  All that does is to call up the 
data entered (if any) for the second ID number.   

Pull down the Other Options menu to “Move lines” (Ctrl+M).  You can 
use this to (re)assign an individual a specific number or a whole block of 
numbers.  You are asked for the ID number range of the runners whose 
IDs you want to change, and then the ID number of the runner in front of 
whom you want them inserted.  With the options in the dialog at left, the 
runners whose IDs are currently 101-125 will be reassigned to 176-200; in 
front of the runner whose current ID is 201. 

There is also a “Copy line” item (Ctrl+T) under the Other Options 
menu.  On specifying the runner’s old and new ID numbers, all the data on 
file under the old number (including address and extra data, if any) are 
transferred to the new ID number.  The data remain on file under the old 
number, too, so you may wish to delete or wipe out those data (unless 
you’ve already printed out bar codes with the old set of numbers). 

Both the “Move” and “Copy” functions can be exercised from the 
“Proofreading” option by clicking on the appropriate button; see page 22. 

If you need to change everyone’s ID number – if the race director has a different 
range of ID numbers than you thought, for example – pull the Edit menu down to 
“Numbers” and change the first ID number. 

Championship cross country meets are generally scored with chips.  These produce 
results very quickly, and are very accurate so far as time is concerned.  However, their 
resolution is usually about a tenth of a second, which is not enough to resolve really 
close finishes.  Because placement is so important in these meets, they usually use 
FinishLynx or video to confirm the placement.   

Often the runners’ bibs are enough to establish the identities of the 
runners whose places are in question, but sometimes they are obscured by 
other runners’ bodies.  To provide additional clues as to the runners’ 
identities, they may be assigned hip numbers.  These are most effective 
(because they are bigger) when they are one or two digits or characters.  
Thus they may be assigned by team. 

If that is the case, pull the Other Options menu down to “Make file 
HipCodes.”  SetData will cycle thru the teams and ask for their “hip code.”  
Theses are filed in HIPCODES.txt, a simple text file that lists the team 
numbers followed by a space and the hipcode for that team as shown at 
right (for this meet, the hip numbers were assigned by the starting lane of 
the team).  In RaceDay, a list of the finish order will contain the hip code of 
each finisher. 

If you are using division codes to identify finishers in certain categories, 
you may be able to assign their codes in a batch.  Then pull the Other 
Options menu down to “Assign division codes in batches.”   

Counting Runners 
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The dialog at right 
gives you a multitude 
of options as to how 
to do this.  If you 
separate their entry 
forms and assign 
them ID numbers in 
non-contiguous 
ranges, simply 
specify the ID range 
for the code of 
interest.  

You can of course 
choose the code; if 
you precede it with a 
“-“ sign you can 
remove it from the 
records of the runners 
you select.  That is an 
editing tool.  E.g., if 
you have assigned “W” to the walkers, and want to assign “R” to the runners (non-
walkers), first assign “R” to every one, and then “-R” to people with “W.” 

You can use a “?” in the number boxes if you put a gap between categories when 
assigning IDs (see page 6).  You can also assign codes by gender, by the current 
division, and also for specific cities (for races that want to recognize local runners), or 
members of specific teams (for meets with multiple classes).   If you want to assign a 
code (“M,” say) to everyone who doesn’t have a certain code (“S,” say), first assign “M” 
to everyone and then assign “-M” to entrants with the code “S.” 

Apple Raceberry JaM adheres to the principle of WYSIWYG (what you see is what 
you get).  When the entrant’s data are completely input, click on “OK” or hit <enter> to 
proceed to the next one.  If you decide not to save the data that are showing on the 
screen, click on “Quit.”   

An item under the Other Options menu allows you to back up your entries.  If you 
add any entries, when you quit SetData they are written to a tab-delimited text file, 
which can be uploaded with the Download program to be discussed next.  The file 
name shows when it was created; e.g.,  “BACKUP 4-1-2014 1551” (the “1551” is the time 
at which it was created).   All such files are stored in a folder names “Backups.” Once 
you select the “Backup data” item, it will be on by default in subsequent races. 

Most road races get at least some – in many cases most – of their pre-registered 
entries from an online service.  You can download such entries into your ARJaM files 
with the aid of program DownLoad  (not available in the cross country package).  It can 
also be used when the race or meet supplies you with the pre-race entries in an Excel 
file, and when you wish to re-process race results produced by someone else. 

Select DownLoad from the dialog that pops up when you click on the “Pre-Event” 
button of ARJMenu (page 4).  After you locate the ROSTERN of interest (if you’ve just 
created the files you’ll be in the correct folder already), you are first asked to confirm 
the race date. 

DownLoad has a couple of items under its Add menu worth mentioning at this 
point.  One is “Import cities.”  If you did not do so while setting up the files in 
NewEvent, you can use this opportunity to put your most frequently encountered cities 
at the head of the CITIES file; see page 9.  You can also import teams from a text file 
created by listing the teams in a meet previously scored. 

If the file from which you want to import data on runners has information on race 
divisions, pull the Add menu down to “Make or add to file KEYCODES for Division 
code” before proceeding further.  The dialog on page 15 appears.  Assign every 
division listed in the file a code, making sure the division names match exactly what is 
in the file.  You can edit the division names later in program SetData (use the 
KEYCODES item under its Edit menu) if you prefer some other name. 
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When you click on “Read Data from File” (Ctrl+R), you first locate the file 
(it’s a good idea to save it in your race folder) and then specify the file 
format.  In most cases it will be “delimited,” with the various fields separated 
either by tabs (the default), commas, or (sometimes) semi-colons.  If your file 
is an Excel file, cancel if you’ve gotten this far without saving it as a tab-
delimited or CSV text file (to do so, double-click on the file, pull Excel’s File 
menu down to “Save as..,” and select a format of “Text (tab delimited)” or 
“CSV.)”  If it is an HTML file, open it from Word (i.e., open Word first and 
then open up the file, don’t just double-click on the file).  If the data are in 
columns, drag the cursor along the top row to select the data (the cursor 
should become a down arrow).  Then pull Word’s Insert tab down to Table, 
then down to “Convert table to text” and click on "Tab" under "Separate text 
as."  You may have to delete extraneous data, like the page title.  Then save 

the file as text; pull Word’s File menu down to “Save as..” and select “Plain text” as the 
format. 

A fixed-field length file has no delimiters between the fields.  I see it mostly when 
I’m reprocessing results.  As will be discussed below, to upload such a file you need 
know which characters on each line hold each field.  The “packet label” format is useful 
for exchanging data between multiple computers processing race day entries, but can 
be better handled within SetData; see page 36.   

If there is an ORDER file in the same folder as ROSTERN, you are asked if there are 
times in the file and, if so, whether they are results or PRs.  If you are uploading race 
results, the options are slightly different from when you are uploading entry data, the 
case that is discussed below.  Hit <tab> or the down arrow twice or click on the bottom 
button. 

You now must specify the delimiter used in the file (the default being <tab>), what 
fields it contains, and their order of appearance in the file.  By a “field number” of “3,” 
for example, is meant that two delimiters – tabs – appear before that field.  Thus in the 
example below there is nothing of interest in the first field (before the first tab), the 
runner’s first name is in the second field, last name in the third, etc. 

If the file has a “header” (a line indicating the order of the fields in the file), 
DownLoad will use it and try to guess which field in the file goes with which ARJaM 
field.  If it can’t interpret the file field, you get a message like “Field 12 BIRTHDATE is 
unknown,” and, after 
the header is searched to 
the end, a list of ARJaM 
fields that were not 
assigned. 

If you have an ID 
number field in the file, 
you have the option of 
offsetting the ID number 
at which a given 
runner’s data are filed 
from the number in the 
file.  There are occasions 
where that’s necessary.  
If you don’t enter a field 
number for the runner’s 
ID, you get the option of 
checking the file for 
duplicate entries, an 
occasional occurrence 
with online entries. In 
either case, you are 
asked for the range of ID 
numbers in which to file 
the data. 

The range of ID 
numbers that is 
suggested for your use 
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begins at the number after the last ID number already used (if any).  If you accept the 
default, the data will be tacked on to the end of the existing data.  If you want to add 
them starting at a certain ID number, simply change the first number in that dialog.  
You can even add them starting at a number lower than the last ID number already 
used, but you are warned that you then risk overwriting some data already on file.  
E.g., if you have entered some data for IDs 1 to 253 and some for IDs 501 to 622, and 
allowed for numbers 1-1000 when you set up the files, it is suggested the new data get 
IDs in the range 623-1000.  You could instead change “623” to “254” and put the new 
data in the ID range 254-500.  But if you had more than 247 (500-253) names in the file, 
you would overwrite some of the data starting at ID #501. 

You then get a “format check”: 
DownLoad shows you where the 
data will be stored according to 
your specifications.  In this case the 
user has switched the field numbers 
for the runner’s first and last names.  
After selecting “No” and trying to 
upload the file again, the field 
numbers used last are displayed.  
Switching the ones for first and last 
name gets it done right. 

You may notice a “=” in front of 
the zip code.  This is a peculiarity of 
files downloaded from the online 
site active.com.  DownLoad will take care of it without your intervention.  It also 
handles quotes in csv (comma-separated-values) files, invites you to insert commas 
when there aren’t any in a city-state field (and no state field is specified), abbreviates 
U.S. state names if they’re longer than two characters, and invites you to extract the zip 
code when a single field contains the city, state, and zip (like “Edina, MN 55424”). 

As the data are uploaded into your files, the names and ID numbers are displayed 
on the monitor.  Keep hitting <enter> until it’s done. 

As noted 
above, race 
results are often 
in fixed-field 
length format, 
like this: 

If you need 
to process such a 
file (redoing the 

results for whatever reason), you will have to manually determine the 
numbers of the first and last characters for each field.  In this case, a runner’s 
first name occupies characters 7 through 25; age is in characters 27 and 28; sex 
is character number 31; city in 35-55; and time in 58-64 (allowing for times 
over an hour).  Thus, after selecting a file, declaring it to be fixed-field length 
and to contain times, you would fill in the dialog shown at left (which doesn’t 
quite match the file above). 

As with uploading a delimited file, you get a “format check” display so 
you can check whether you have set the fields correctly. 
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Under its Other options menu, DownLoad has an option to “Delimit file around 
numerals.”  This can be used to help prepare a file for uploading (as a delimited file).  
Typically these are files saved as text from a pdf, as in the example at left.  Applying the 

option to this file would insert tabs around all the 
numbers separated from other data by spaces.  Thus nine 
spaces would be replaced by tabs in these lines of the 
file. 

There is also an option to “Translate Mac file to 
DOS.” An effort has been made to do this translation 
automatically for files uploaded into ARJaM files, so it’s 
probably not something that you will have to use. 

 
 
 

To make it easy for 
runners to pick up their 
packets on race day, their 
packets should be 
alphabetized.  This is hard 
work unless their ID 
numbers are assigned in 
alphabetical order.  Program 
Sorters can do that, as 
follows.   

Select Sorters from the 
dialog that appears when 
you click on the “Pre-Event 
Off-Site” button of ARJMenu 
(page 4).  Its primary options 
are shown as buttons in the 
form that appears after you 
locate the ROSTERN of 
interest.   

On selecting the 
“Alphabetical” sort option by 
clicking on the appropriate 
button (Ctrl-A), you get the 
options to restrict your sort 
shown on the right.  If 
reassigning the ID numbers is 
your purpose, you generally 
don’t want any restrictions.  The 
IDs can be reassigned only if 
there are no unassigned ID 
numbers in the range selected.  
Thus you certainly will accept 
the A-Z defaults.   

You can, however, limit the 
sort to a specific range of ID 
numbers.  Note the ability to use 
a “?” in the Start/End boxes to 
limit the sort by exploiting a gap 
in ID numbers; see page 6. 

You can also restrict the sort 
by division.  When working with 
a data base, you can also restrict 
the sort by the runners’ 
“expiration dates.”  Again, such 
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options are useful only when you want to list the runners in alphabetical order; if you 
want to reassign numbers in alphabetical order you must select everyone in the ID 
number range of interest. 

After going through the sorting process, Sorters puts a new 
set of buttons on the desktop.  Unless there are IDs with no 
names in the selected range, one of them is “Reassign ID  
numbers.”  Click on that button or pull the Other options 
menu down to “Reassign ID’s in order.”  You are then asked if 
you first want to print out the names (with their old numbers) 
and, if you have addresses on file, whether you want to store 
the old numbers in an OTHERDATA file, separated from the 
rest of extra data by a backslash; e.g., “0034\952-920-0558”.  
This option allows you to recover the original ordering of 
names, by sorting them by “extra data” (Ctrl+X) and then 
reassigning the ID numbers after doing corrections/additions.   

The portion of ROSTERN that you selected, along with the 
ADDRESSES file (if any), is now sorted in alphabetical order.  
If OTHERDATA, SUPERDATA and/or TRIPLEDATA (a file 
used in chip-timed races, multi-race series and triathlons) are 
on line, they will be sorted, too.   

The routine used to reassign ID’s in order fails if there are 
any blank names in the sequence of ID numbers you wanted 
alphabetized.   If this is the case you won’t be able to reassign 
ID numbers; the appropriate option under the Other options 
menu and the corresponding button will be disabled.  If there 
is no reason for the empty lines in the ROSTERN, use 

SetData’s “Delete” option to get rid of them (best done from the Proofreading display; 
see page 22) and try again. 

After any alphabetical sort, a button “Scroll thru List” appears on the desktop.  This 
highly useful option allows you to edit certain data on entrants 
you choose from an alphabetized list and/or to communicate with 
them by mail or email, as indicated by the options below.  If you 
want either to send out emails or to delete someone’s (incorrect) 
address, you should of course click on the option in the 
alphabetical sort dialog to sort only runners whose email address 
is known (i.e., with an entry in the “superdata” field). 

The “Declare teams” option is useful in road races with team 
scoring, when you discover that some runners neglected to 
include their team name in their entry, or declared a team on 
which they are ineligible to compete (lacking USATF 
memberships, e.g.).  Deleting email addresses is something I 
routinely do after road races when I find the emails in which I 
reported the runners’ individual results (see page 72) were 
incorrectly entered.  You can also change a runner’s division, send 
him an individual email, print a mailing label, or simply list him. 
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On selecting any 
option, the runners’ 
name, ID number, age, 
sex, other data 
appropriate to your 
selection from the 
dialog above appear, 
in alphabetical order.  
You can scroll thru the 
list with the arrow 
keys, the scroll bar, or 
by pressing the key for 
the runner’s initial.  

Selecting a 
runner’s name 
leads to the 
appropriate 
action you 
may have 
selected from 
the check 
boxes above: 
declaring a 
team, printing a label, adding the runner to a list, etc.  The team and division 
options bring up a specialized entry form like that at left. 

You may also be asked to assign 
numbers by age group; e.g., to give runners 
under 30 the numbers 100-199, runners 30-
39 the numbers 200-299, etc., or to give men 
and women different ranges of numbers.  
This is especially common when the 
runners start in waves by age group, as in 
triathlons.   

Pull the Sort menu down to “By age 
group.”  You get options as to ID number 
range and division codes as in an alfa sort, 
and then select the age group(s) of interest 
from the list above. 

As with alphabetizing, you can use 
Sorters to do this if and only if there are 
absolutely no gaps in the runners’ ID 
numbers when you start.; if necessary, use 
SetData to eliminate any gaps with its 
“Delete” option, and of course select “All 
classes in order” from the dialog  

In cross country, you will almost 
certainly want to reassign ID numbers alphabetically by team.  The usual restrictions 
apply.  If men and women/boys and girls are assigned numbers in different ranges, 
using the “?” in the boxes for the ID number range of the sort makes it easy to separate 
runners by gender.  In addition to the usual options, you can also decide whether to 
sort the runners on each team in alphabetical order or to leave them in the same order 
they were entered.  Also, you get an option to sort the team names in the TEAMS file 
alphabetically.  This is useful in printing out team labels. 

Road races used to mail entry forms to previous years’ entrants.  Bulk mailing 
required that the labels be printed in zip-code order.  On clicking on the “Sort by Zip 
Code” button or pulling down the sort menu to the corresponding item, a dialog 
similar to the alphabetical sort appears.  

Mailing entry forms is expensive, and has given way to email blasts, to entrants in 
the upcoming race (for informational purposes) and to previous years’ entrants.  To do 
so, do a zip-code sort for those runners whose email address is known (and stored in 

 

 

Sorting by Age Group 

 
Sorting Alphabetically 

by Team 

Sorting by Zip Code 
and Bulk Mailing and 

Emailing  



  
32 

the “superdata” field).  You can restrict the sort to a particular range of zips and to a 
division of the race if you wish.  Click on the “List” button.  You get an option to send 
emails to the sorted runners.   

Your first option is to send out some “preview” emails to 
yourself.  This is a good idea; you can see if what you’re 
sending makes any sense.   

Then you fill in 
some blanks specific to 
your email account (this 
may not work with 
gmail, yahoo, and the 
like) and the subject line 
of your email.  Finally 
you create your 
message.  On accepting 
what you’ve written, 
you get an option to 
record the disposition 
of your emails.  I 
usually make a file of 
the runners’ names and email addresses. 

To prepare for packet pickup, you need to print out various lists.  Sorters is the 
program best equipped to do this, although SetData has some capabilities as well, as 
was discussed on page 23. 

Sorters will print lists of the runners in any order you select from its Sort menu (or 
from the desktop).  For road races you should at least print lists in numerical and 
alphabetical order; the alfa list can be printed “last name, first name.”  As indicated on 
the dialog on page 24, all lists include the runner’s ID number, name, age, sex, and 
home town (or team).  You can add other fields of you like (shirt size and division, e.g.) 
and put a title at the top of the list so you can tell what it contains; the default title is the 
race name. 

For cross-country meets, and in other cases where team competition is important, 
you can use SetData’s search-by-team function (pull down the Search menu to “By 
team”) or Sorters’s sort-by-team option  to list all members of every team together, 
again in eye-pleasing initial-cap form.  The team name will be listed first, and then all 
members.   

SetData and Sorters have a Font menu that allows you to select the font and its size 
and style for printed output, in two columns if you wish.  They list entrants in initial-
cap form regardless of how they were entered.  Selecting a file as the “output device” 
may be useful if you want to list the entrants for a pre-race program.  You can then 

paste the file into your favorite word processor or page layout program and 
add titles, coaches’ names and other information.   

When you list data to a file you get the several formatting options 
shown at left.  You can also choose to separate first and last names 
(advisable in listing to a file that you want to upload to another computer 
since the initial-cap process removes the periods that otherwise separate 
first names from middle initials) and cities from states (which works only if 
you used the standard “city, XX” format when entering the city and state 
name). 
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ARJaM produces labels in a variety of formats.  Before a race of any type, the most 
important is an identification tag that can be stuck on the tag portion of the runners’ 
bibs to facilitate distributing them to the runners. These labels necessarily have the 
runner’s name and ID number on them.  When those tags are detached and collected at 
the end of the chutes, they can be used to establish the order of finish.  If you have a bar 
code reader, the labels can be printed with bar codes on them; using bar codes can 
reduce the number of typos in the finish order.  If you have packets of information 
and/or T shirts to give them, you may also want to print out labels to stick on the 
packets.  

Both SetData and Sorters can print labels.  SetData will do so only in numerical 
order, which is certainly what you want if you’re sticking them on bibs.  You can also 
print labels with “QR codes,” which are sometimes useful in assigning bibs at the race 
(“dynamic bib assignment;” see page 35).  If you’re using Sorters, first sort the runners 
by ID number, selecting the number range in the process.  If you’re printing bar-coded 
labels, include enough unassigned numbers to cover race-day entrants. Then pull down 
the File menu to “Print labels” (Ctrl+B) or click on the “Print labels” button.  In SetData, 
you pull down the File menu to “Print labels” (Ctrl+B) first and then select the number 

range of the labels.  You are next asked to direct the output.  
Now select the type of label you want from the dialog box at left.  The 

default “pitch” of 6 lines is appropriate for the standard 15/16-inch high 
labels, but in fact can be left as is even for bigger labels.   

For identification tags, you are asked 
whether you want to print out shirt size and/or 
“extra data” and/or “keys to division codes” (if 
they’re available).  A sample is shown at right.  
You’re also asked whether you want to print 
labels for ID numbers that are not yet assigned.  If so SetData and Sorters will 
print out a tag with blank lines for the runner’s Name, Age, and Sex.  Ask the 
registration crew to fill in the blanks if they give that number to a late 
entrant.  

If you are using a bar code reader, print out bar codes for a range of 
negative ID numbers; these can be used as “turkey tags” (in fact the “name” 
above the code will be “TURKEY”), since RaceDay recognizes an 
unregistered finisher by a negative ID number (see page 42). 

Finally (assuming you are 
sending your output to a printer or 
previewing it) you define the label 
configuration.  The default 3 
columns, 10 rows is the usual 1 X 2-

5/8 inch label, but you can also do two 
columns of 1-1/3 X 4 inch labels, for example.  
The “Narrow 3-column labels” (an option not 
shown at right) are ¾-inches high. 

Note that you can 
choose the column and 
row in which to start 
printing.  Don’t throw away your last label sheet; you may be able to 
use it for your next event. 

SetData and other ARJaM programs will print to any printer you 
can select from the Printers dialog.  For some printers, the code used 
to space the labels vertically does not do so accurately; the printing 
at the bottom of the page slops over on to the label above the one 
where it should be.  The dialog used to select the number of 
columns contains items “Label spacing adjustment” and “Label start 
adjustment.”  Try something in the range 7 to 10.  SetData and 
Sorters will remember your last choice and use it as the default the 
next time you run it.  I haven’t seen this happen in years. 

For cross country meets you may also want to print labels for 
team packets.  If so, pull SetData’s File menu down to the team 
labels item.  You get the options shown at left.  I typically print out 
labels separately for each gender, and show the number of entrants 
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(a subsequent dialog asks for the number range, which I use to separate entries by sex).  
After doing one gender, the dialog returns. I do the other one and hit “Cancel” when 
the dialog returns. 

The “Maximum entrants per label” option allows me to print out multiple labels for 
meets in which I must prepare labels for packets with limited capacity (actually for 
packets of chips). 

Some races give prizes or merchandise randomly.  Sorters can be used to select any 
number of runners randomly; just pull down the Sort menu to “Randomly.”  You will 
get the usual options for selecting the range of ID numbers you wish to deal with, and 
for restricting the search to runners with specified “division codes.”  If you want to list 
finishers only, first run RaceDay and use the “Tag finishers with division code” option 
under the Other Options menu, and select the “Finishers” division code.   

You can also reassign ID numbers in random order, provided (as usual) that there 
are no gaps in the ID numbers.  This could be useful in cross-country skiing or other 
races in which the competitors start one at a time at fixed time intervals, and you want 
to assign their starting times randomly but keep their numbers in the order they start, 
to simplify the starting process.  Just Sort them “Randomly” and pull down Sorters’s 
Other Options menu to “Reassign ID numbers.” 

Much of the work detailed in the preceding pages can be avoided, at least for road 
races, if you don’t assign a runner’s bib until he/she shows up.   This is called 
“dynamic bib assignment.”  Advantages include: 

(1) Less work before the race: no sticking labels on all the chips and/or bibs, no 
assigning numbers in alfa order, no dealing with lists.  

(2) You don’t waste bibs and chips on no-shows.  It is by no means unusual if 20% 
of preregistered entrants stay home. I charge by the entry, so this saves the race money, 
too.  

(3) Using a computer to look up an entrant’s data is quicker than searching for a 
name or number in a pile of bibs. 

 (4) Online entries can be kept open until the last minute; with the right online 
service, even until the close of race day registration. 

The online service I’ve used is Tempo Events (http://www.tempoevents.com).  
They supply tablets that can be used for runners to enter their data at the race and for 
race personnel to assign bibs.  When a runner comes up to get a bib, they scan a QR 
code on his phone or printed receipt to access his data and then another QR code on the 
next bib in the stack of available bibs. 

For races that use their own online systems, 
an application BibSetter in the Apple Raceberry 
JaM package can handle bib assignment for 
preregistered runners.  After creating a race 
folder, make a copy of it; we’ll call that folder the 
“source” folder and the original folder the 
“destination” folder.  Download the entries into 
the source folder and put a copy of BibSetter in 
that folder.  Then copy both folders on to as 
many memory sticks as there are computers 
available for bib assignment at the race (they 
could be computers supplied by race 
management or your own; so long as they run 
Windows). 

At the race, each of the people assigning bibs 
will have a computer and a stack of bibs.  Put a 
memory stick in each computer.  The two folders 
you created will show up in the Windows 
Explorer file list.  Open up the source folder and 
start BibSetter.  You’ll be asked to locate the 
ROSTERN in the destination folder. 

The display at left appears.  The names in the 
source files are show in alfa order, along with the 
shirt size each runner ordered and their race 
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division, if any.  When Henry Johnson  comes up, press “J” to 
get to that section of the alphabet and click on his name and hit 
“Enter.”  The dialog at left asks you to confirm the number he 
will be issued.  It should be the next one in the stack of bibs; the 
suggested number is increased by one after each entry.  
Sometimes the operator hits the Enter key twice and the 
number is not correct.  If the number selected has already been 
assigned, the operator is warned.  But if it’s the next bib in the 

stack, she should go with it. 
When the operator is done -- when registration closes or the last few registrants are 

lined up at another station -- he/she hits “Enter.” Clicking on a “Backup data” button 
creates a file like “201-278” in the destination folder, the file name indicating the range 
of bib numbers that were assoigned.  This file is a csv file with a header.  Grab the 
memory sticks and use Download to upload the data files in each stick’s destination 
folder. 

If the operator pulls the stick out of the computer without saving the file, all is not 
lost.  Put it into your computer, find BibSetter, hit “Enter,” and click on “Backup data.” 
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Step 3: Entering Results and 
Other Data at the Event 

If there are walk-up entries, their names must be added to the files before you can 
list them in the results.  SetData is best equipped to do this, although RaceDay has 
capabilities in this respect; see below.  For cross country, this is quite straightforward; 
all you have to enter are name, year, and team.  If you have separated the runners by 
gender with some unassigned numbers so as to score them by gender in a mixed race, 
an easy way to switch from one gender to the other while doing the adds is to use the 
Proofreading display. 

Road races are more complex and often attract a hundred or more race day entrants.  
Ask the race-day registrars to try to keep the entry forms in numerical order, so you can 
use the “Add” option, and above all to be sure to write the numbers they issue on the 
forms.  If you have a substantial number of race-day entrants, you may elect not to 
locate the ADDRESSES file when you open up SetData on race day, and so restrict your 
work at the race site to inputting their name, age, sex, and home town, the only 
information you really need to produce results.  But if you are scoring by division, you 
will need to leave the “Enter addresses” box checked. 

If you have the data base package, you can save some time by accepting the option 
to enter addresses.  As discussed on page 22, enter the runner’s last name, age, and sex.  
If an entrant is in your data base, great.  If not, enter the first name, then hit the down-
arrow to advance to the address box, tab to the city box, enter the city, tab to the zip 
code box (may as well enter/correct it while you’re there), and hit <enter> to advance 
to the next runner. 

Later you can go back and fill in the missing addresses; see page 71.   
If you are unable to enter all the race day entrants before the runners 

are close to finishing, you can enter the most essential information (name, 
age, sex, team, city, division code, PR) using the “Add Entrants” item 
under RaceDay’s Data Entry menu or the "Name by number" item under 
the Edit menu.  You can fill in street addresses, extra data, and superdata 
later as mentioned above.  “Division codes” may be necessary to score the 
runner in the right category (see page 57), and PR could be important in 
races with a handicapped start (page 81).  Enter the missing data as usual.  
The entry form, shown at left, behaves much like that in SetData: entering 
two digits in the age box jumps you to the sex box, entering the sex jumps 
to the next available box, and team and city names are completed.  

In “simple” events, you can, if you wish, leave Setdata open and use it 
for data entry after you switch to RaceDay.  Before you switch, use 
SetData’s Edit/Numbers (ctrl-N) option to change “Names on file” to a 
number high enough to accommodate runners still to be entered.  If you 
need to change age groups, however (see below), or have different age 
groups for different distances (see page 9), you should close SetData before 

you open RaceDay or execute the change in age groups.  It’s safest to close it once 
runners start finishing. 

Multiple computers can be used to spread out the job of inputting data on the 
runners.  SetData can both export and import data from one computer to another, 
through the “ARJ packet label” files mentioned on page 27, unless there is team 
competition. 

After entering some data on an auxiliary computer, pull down the File menu of 
SetData to “Make ARJ file.”  Name the file and specify the range of ID numbers to be 
sent to the main computer.  Skip the option to write out “extra data” on a second 
address line, if any.  Move the file from the auxiliary computer to the main computer (a 
stick will do, or you can network them; see Appendix A).  Then use program SetData 
the main computer to read the file into ROSTERN by pulling down the Add menu to 
“Entrants from ARJ file,” selecting ARJ file and locating the file from the auxiliary 
computer.    

If the race has team competition, make a “backup file” with SetData (page 26) on the 
auxiliary computer and use DownLoad on the scoring computer to import it. 

Race Day Entries 
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If you realize, after setting up files 
for an event that you need to set up 
files for another finish line/race that 
you didn’t know about or forgot, pull 
RaceDay’s Edit menu down to “Add 
new results folder.”  By default the 
new folder will be located in the 
current race folder.  As indicated at 
the right, you can put the folder 
inside some other existing folder.  
You will be automatically switched to 
the new folder, and given the usual 
info on the numbers of finishers and 
times on file (zero, of course) as on 
page 41. 

Rarely, the size of your results 
files is insufficient.  If so, there is an “Expand results files” under the Edit menu similar 
to the one in SetData (page 14). 

If the age/sex groups you entered are not what the race wants to use for awards, 
pull down the Edit menu to “Change age-sex groups.”  You’ll be led to dialogs like 
those on page 9 with which you set up the age/sex groups in the first place. 

Three types of data have to be input in order to score a race: ID numbers in order of 
finish, times in order of finish, and “select times;” i.e., records of the ID number and 
time of selected finishers. Select times are important for the accuracy of the final results, 
as will be discussed on pages 46-49: manually recording a time for every finisher (and 
not otherwise) is subject to errors, finishers get out of order on their way to the end of 
the chute, etc.  To each of these functions corresponds an item under the Data Input 
menu of RaceDay and a button on its main window. 

Chip systems, in which the runner wears a transponder on his/her shoes or bib, 
allow the semi-automatic capture of all three types of data.  Apple Raceberry JaM has 
been used with Championchip/MyLaps, DAG, Jaguar, Bibs Bolt, IPICO, and 
race|result systems.  Such systems are discussed below starting on page 51.  The IPICO 
system, which I used for 10 years, is discussed in detail Appendix B, and race|result, 
my current choice, in Appendix D.   

For now we’ll consider manual data collection. 

Runners must be issued identification tags on which the ID number is preprinted.  
Race management should be prepared to collect the tags in order of finish on spindles 
or stringers at the end of a finish line chute.  The tags should have punched holes so as 
to allow them to rotate freely on the spindle.  Most races big enough to computerize use 
two-part race numbers, one part bearing the runner’s number in large numerals (useful 
for recording select times) and the other being the tear-off tag; these do very well.  The 
“Print labels” option of programs SetData and Sorters can be used to print adhesive-
backed labels that can be stuck on the tags to identify the runners; see page 33.  Ask the 
volunteers collecting tags to put them on the spindles printed side face down; they’ll be 
easier to process that way.       

Spindles should be brought in from the finish line to the computer operator 
periodically; e.g., after the first 20 finishers and at intervals of 25 to 50 after that.  For 
small races, I just go over to the end of the chute and pick up another spindle whenever 
I’m ready.  The spindles should be tagged with numbers or letters in order of their use, 
so that you can identify which one is to be read next.   “Turkeys” (finishers who enter 
the chute without an ID and so have a time recorded) should be identified by putting a 
special card or tag on the spindle (see page 33 for how to print out bar coded labels for 
such “turkey tags”).  And then perhaps taken out and shot. 

Most professional timers, when they’re not using chips, use a serial device called 
TimeMachine to record times.  Apple Raceberry JaM also works with the Chronomix 
737X and Sprint 8, although with difficulty in the latter case.  These timers have 
optional settings as to baud rate, stop bits, etc.  RaceDay assumes the timer is set up as 
follows: 

9600 baud, no parity, 8 bits, no handshaking 
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For the Chronomix 737X, you may have to ask the manufacturer to cut a wire on the 
timer end of the cable to disable handshaking.  With the TimeMachine you should 
select the “Line Setup” display to insure the machine is properly configured. 

To have the timer dump times directly from the finish line into the computer, start 
the timer as usual (preferably with the gun) and connect it to the serial port.*  Start up 
RaceDay, and pull down the Serial Port menu to “Open” before the arrival of the first 
finisher.   

A dialog box like that at left now appears, asking for the 
number of finish lines, the COMM port available and the 
type of timer you are using. If your timer is a TimeTech, you 
will have to press a key on the computer at this point, as 
you will be told by RaceDay.   

The TimeMachine and Chronomix will record both 
individual times and “select times,” IDs and times for some 
of the finishers.  One person clicks the switch for every 
finisher, while another enters the ID number of runners 
before they hit the finish line and hits an <enter> button 
when they arrive.  It’s not usually possible to get select 
times for every finisher, but it’s not hard to record one every 
few seconds. 

If you are using a 
Chronomix or TimeMachine, 
you get the additional options 
shown at right.  Some people 
like to record either an 
individual or select time for 
each finisher, but not both.  
They can then more easily 
read the times off the tape for 
the award ceremony.  
Needless to say, this option is 
exercised only for small races, 
and the timer is dumped into 
the computer only after the race is over.  If this is the way it is done, turn on the first 
check box.  Most people will prefer to use the select times as an independent check on 
the timing, and so engage two people to operate the machine as described above. 

The second check box is useful for dumping the times from a TimeMachine after the 
race. 

The timer is now ready to dump data into the computer.  The data stay in a buffer 
until you are ready to read them into the ARJ files.  In the meantime, you can go about 
other tasks in RaceDay, in particular entering ID numbers. 

When you close a spindle of ID data, you are invited to read the times from the 
timer.  Accept the invitation; the times and select times will then be listed on the 
preliminary results printout (see page 43).  The times and select times are shown on the 
screen as they are filed away.   

If you are not able to get your computer close enough to the finish line to read times 
directly into it, you can read the timer after the race.  If you had recorded some 
individual times by hand, you should zero out the TIMES file before reading the timer 
or its files; after selecting the “Times” option from RaceDay’s Options menu (Ctrl+T), 
pull down the Edit menu to “Number” (Ctrl+N) and enter “0” for the number of times 
on file.   

When you are ready to dump the timer, pull down RaceDay’s Serial Port menu to 
“Open” and connect the timer to the serial port.  Indicate the number of chutes and 
timer type on the dialog above and declare whether or not select times are to be 
included in the TIMES file.  With a TimeMachine, click on the “Dump Data” button and 

                                                
* Bug: RaceDay has problems connecting with built-in serial ports.  It works best with USB serial 
adapters. 

Dumping times during 
the race 

 

 

Dumping times after 
the race 



  
39 

enter the TimeMachine’s event number of interest if, as 
in a cross country meet, several events have been 
recorded in the machine. 

For a TimeTech, the computer screen now says “Set 
up the timer to transmit now.”  Do not press the 
<enter> key yet.  Reset the timer (for a Sprint 8, turn it 
off and on) and tell it you want to score a road race.  
Press any key on the computer to open the connection.  Go back to the TimeTech and 
enter the number that indicates that  you want to transmit times.  When the TimeTech 
indicates the data have been transmitted, go to the “Read” option under the Serial Port 
menu and the data are yours. 

For a Chronomix or TimeMachine, after you connect the timer and open up the 
Serial Port, go directly to the “Read” option under the Serial Port menu.  Unless you 
elect to dump the times in the TimeMachine from the computer as described above, 
you then have to do something with the timer to get it to transmit its data: 

For the TimeMachine, press the SET UP key until the display shows “Setup 
Parameter/[RS232 PORT].”  Then press the ENTER key.  Next press the SET UP key 
so that the display shows “RS232 OPERATIONS/[RE-XMIT DATA].”  Press the 
ENTER key on the TimeMachine.  Depending on the model of your machine, the 
display may now say “Specify [PLACE#] To Begin Re-Xmit;” hit ENTER, then enter 
“1” for the place at which you want to begin transmitting (unless you have already 
transmitted some of the times).  On newer models it suggests a starting time, and on 
older models it just dumps everything.  The display on the TimeMachine will show 
the “transmit status.” 
With the Chronomix 737X, you must first end the race by pressing the “E” key and 
holding it down until an “EOR” message appears on the timer’s display.  After 
hooking the timer up to the computer, press “B”.  You should get a message 
“BAUD-1 MEMORY-3” on the display (if you don’t, press the reset button and then 
press “B” again).  Press 3; the message changes to “C-1 P-2 C/P-3”.  Press 1 on the 
Chronomix.  The timer indicates it is transmitting data by changing the message to 
something like “STOP DUMP-0”.  When it is done, the message changes back to 
“BAUD-1 MEMORY-3”.   

Serial devices like the TimeMachine work very well, but they are expensive, and 
may not be within your budget if all you need to do is score one or two races a year. 

If you are scoring with a laptop you can operate close to the finish line, Apple 
Raceberry JaM allows the entry of times into its files by using the F1 or F12 key on the 
computer.*  These are far enough removed from the rest of the keyboard that you can 
have someone pressing one of these keys as the finishers arrive while you enter the 
finish order.  Or you can have one person timing everyone with the F1 or F12 key and 

the other entering select times; see below. 
To start the timer, pull the Times menu down to “Keyboard timer.”  A 

dialog will ask you the race time at which you will start the timer.  If you 
are able to start it with the gun, accept the default of “0:00:00.00” and hit 
the <enter> key at the gun.  If not, bring a watch that was started with 
the gun over to the computer, pull the Times menu down to “Keyboard 
timer,” enter a time a little beyond the current race time, and hit <enter> 
when that time is reached.  Once the timer is started, hitting the F1 or F12 
key will cause a time to be added to the end of the TIMES file and 
displayed at the lower-right corner of the monitor. 

For races so small that you can enter a select time for every finisher, 
you can use F-Key timing to completely create your results.  After 
starting the keyboard timer as described above in the Times section of 

RaceDay, shift to the Select Times section.  Click on the “Add” button.  You'll be asked 
if you want to “Add IDs to ORDER file and times to TIMES file.”  Click on “Yes.”  As 
finishers arrive, enter their bib numbers in the left column of the form shown on page 
47 and hit <enter> when they cross the finish line.  That’s it. 

                                                
*  With Windows 10, you may have to work with the “Fn key” to enable this operation; e.g., <Fn >+ 
<esc>. 

“F-Key Timing” 
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Putting a lot of equipment at the finish line – computer and printer – may not be 
possible.  And having two sets of fingers on the keyboard is not the way you may want 
to work.  You can separate the tasks of timing and entering IDs/reporting results with 
the purchase (under $50) of a Logitech N305 Wireless Keypad.  This is a Bluetooth 
device, which connects to the computer through a USB receiver (supplied with the 
Keypad) over short distances (several feet at least).  Start the “Keyboard timer” as 
described above, and record times by hitting the “+” key on the keypad. 

If you can’t use “F-key timing” and don’t have a computer that can be set up as a 
timing computer, times must be recorded manually.  If you use any printing timer, the 
data you need to set up the file of TIMES are printed on the tape.  If, as we shall assume 
in most of the discussion that follows, you are entering times manually, the race 
director should have someone bring pieces of the tape over from the finish line to the 
computer operator along with the spindles of ID numbers. 

If you are entering data manually, a simple sheet of lined paper suffices to record ID 
numbers and times by hand; “tic sheets” are unnecessary and usually harder to read.  
Again, these data should be brought over from the finish line periodically.      

It’s much more efficient to have a computer do the timing for you.  If you have or 
can borrow a second computer, you can use that computer at the finish line and 
download the times to your scoring computer over a LAN (“local area network”). This 
allows the timing computer to record select times, too, so that it has all the capabilities 
of a special-purpose automatic timer like the TimeMachine.  With Netbooks retailing 
under $300 and a keypad under $50, less than a third of the cost of a TimeMachine, this 
becomes economically attractive even if you have to buy a timing computer.  See also 
the discussion above for using such a computer to assist with race day entries. 
Appendix A discusses the details of networking the computers. 

The Windows application TheTimerAP is part of your package.  Put a copy on the 
timing computer, in a folder that can be shared with your scoring computer.  On 
starting up TheTimerAP you are asked to locate the TIMES file (it doesn’t use either 
ROSTERN or ORDER).  To create TIMES and IDENTIME files for a new race, click 
“Cancel.”  You are then asked to name the race (or finish line) for which you will be 
recording data.  This creates a folder of the same name in which to hold the data in the 
folder containing TheTimerAP.  You then specify the number of times you want to 
handle (default 512).   

Once you have found/created the timing files, you get the “Start Timer” dialog 
shown and discussed above.  After starting the timer, you are asked if you want to 
enter select times.  Hopefully you have two persons assigned to timing, one to time 
every finisher and the other to enter IDs and times for specific finishers.  If so, accept 
the suggestion and click on the entry form that appears to give it focus.  Your 
(individual) timer is now ready to record times by hitting the F1 or F12 key (or, in fact, 
the “-“ or “=” key) every time a finisher hits the line.   

To record select times in TheTimerAP, accept the option to record select times that 
appears after you start the timer.  An entry form like that on page 47 appears.  When 
possible, your select timer then enters IDs of runners before they finish, and hits the 
<enter> key when they do.  By using the keypad built into Apple Raceberry JaM (J=1, 
K=2, etc., see page 6), which works even if the computer’s “num lock” option is off, the 
two timers can comfortably work together.   

Even better is to use a Logitech keypad (very cheap, under $50), which sends the 
data to the timing computer wirelessly (via BlueTooth).  Simply enter the ID on the 
keypad and hit <enter> when the runner arrives.  You can also use a second keypad to 
enter individual times by hitting the “+” sign when they cross the finish line. 

One important caveat: to enter the select times, be sure the focus is on the select 
times dialog.  You should see them being recorded as they are entered.  If not, click on 
the dialog. 

If, as at a cross country meet, you have more than one race to time, click on the 
“Change results files” button when you want to switch.  Then enter the name of the 
new event. 

To score a road race or cross country meet, only one program is required: RaceDay.  
Click on ARJMenu’s “Results Entry & Output” button and select the first item.  Then 
locate ROSTERN in the race directory as usual (see page 4) and open it up.  You can 
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elect to show age-group abbreviations with the class place (why not?). If you have 
multiple races, you will then be asked to locate the ORDER file for the race of interest.  
It is in one of the results folders you opened up (see page 8, 9 or 37).   

You will then be asked to name the race or finish line. The default 
is based on what you named the race folder, concatenated with the 
name of the results folder in which you found the ORDER file in races 
with multiple finish lines.  This name will be printed at the top of 
preliminary results from the Finish Order part of RaceDay and of the 
“Check times” output by the Select Times part, so you can tell what 
race or, in a multi-finish line race, what finish line the printed results 
came from, and is the default title for printing out final results.  The 
dialog also shows how much data have been recorded.  Initially, of 

course, those numbers are zeroes. 

You are then shown the major options of program 
RaceDay. 

If you have a web site to which you can upload 
results, and have Internet access during the race 
(perhaps through your smart phone), it is a good idea 
to run RaceDay before the event and set up some files 
that can automate the process of sending them up; see 
page 66. 
 
 
 
 
 
 
 
 
 
 
 
 

If you are networked with a computer that is running TheTimerAP, first pull the 
Network menu down to “Get times from remote computer after entering data.”  
Similarly, if you are connected to a TimeMachine, establish a connection as described 
above, and if you are using keyboard timing, click on the Times button and pull the 
menu down to “Keyboard timer.”  That’s all you have to do for now. 

When you click on the “Finish Order” 
button (ctrl-O), a new Finishers’ ID 
Numbers menu appears on the menu bar 
and a new set of buttons on the main 
window. 

To record finishers, pull down the 
Finish Order menu to “Add” or type 
Ctrl+A or click on the “Add ID numbers” 
button.  You are then told what the 
number of the last spindle input was and 
asked what is the number of this one.  This 
is to help you input them in order.  The 
locations of the spindle breaks are stored 
and printed out on various lists (a spindle 
printout, see the sample in the Appendix;  
you can get a similar list when you click 
the “Check” button), to assist in resolving 
problems like a mislabeled spindle or one 
read in reverse order.  You are also asked 
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at what place to add the data.  Naturally, the default is the place after the last runner 
you input.  

A data entry window (shown at left) now 
pops up.  Input the ID (bib) numbers of the 
finishers in the boxes that appear.  Type a 
negative number in case of a turkey.  To advance 
from one place to the next, hit <tab>, <enter>, or 
a down-arrow.  To go backwards, use <shift-tab> 
(hold the shift key down while pressing <tab>), 
the up-arrow or the mouse. 

If an error is detected, the program gives you 
a message.  On seeing such a message, your first 
step should be to reexamine the tag from which 
you got that number.   If you simply misread it, 
use the mouse (or up arrow) to select the 
mistaken entry and correct it.   

Number out of range indicates that the ID 
number is outside the range you established 
when you opened up the ROSTERN file (page 7 
or 8) and possibly modified with the help of 
programs SetData and/or Expand.  Such errors 
indicate a lack of communication with the meet 
director; you should know what numbers were 
available!  If the name, age, and sex of the runner 
are written on the tag, you can correct the out-of-
range error, but only by closing RaceDay and 
going to program SetData to expand the 
ROSTERN and related files; see page 14.  Then, 
when you come back to RaceDay, you will have 
to reenter the Finish Order part of the program, 
choose its “Edit” option (Ctrl+E) and retype the 

troublesome ID number, and then enter the runner’s data via the dialog shown on page 
36 (if you didn’t already fix it in SetData).  

The other types of errors shown can (and should) be fixed in RaceDay.  No name 
entered for this ID usually indicates a registration error; entry forms often get lost on 
the way to the computer on race day.  Double-click on the ID number for which no 
name is known.  That brings up the form shown on page 36 in which you can enter the 
most essential information (name, age, sex, team, city, division code, PR), some of 
which may be on the finisher’ tag.  Or you may find an entry form with the runner’s 
name on it but no indication as to the number the runner was assigned; now you know. 

Similarly, you will get a No age for this runner message if a name was recorded for 
the ID number but no age was entered (unless in opening the files you did not declare 
that ages would be recorded).  Race day entrants sometimes neglect to fill in their forms 
completely, but the age may be recorded on the finisher’s tag. 

If the number was used before this place, and the current entry is correct, the 
previous one must have been wrong.  The first place at which it was used is indicated 
in the message.  If that place was on a previous spindle, you will have to wait until after 
entering the rest of the ID’s on the present spindle before retrieving the previous 
spindle and correcting it with the “Edit” option (Ctrl+E), which looks just like the 
“Add” option. 

After entering all the ID numbers on a given spindle, you should go back to the 
beginning and check your input against the tags on the spindle (although, if you can 
get volunteers to do the checking for you, you can accelerate your output considerably; 
see below for using a spindle printout for this purpose).  Especially when it’s wet, they 
may stick together, causing you to miss one.  If there were more tags on the spindle 
than can be shown on the screen, scroll back to the beginning of the spindle by clicking 
on the “Up” box.  Click on “Down” when you have reviewed all the ID numbers 
shown to get to the next page of ID numbers.   

If you find you missed an ID number, you can insert it on the spot, as follows.  Click 
on the place where you need to insert it, and then on the “Insert” button.  The dialog 
assumes that you want to insert some data in the ORDER file at the place where you 
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clicked (but check to see that it’s right), and asks how many lines you want.  After you 
tell it, the program will insert a “-1” (as for a turkey) at each line.  Type in the missing 
ID number.  If you insert a single ID, you may be asked if you want also to insert a time 
at that place, by interpolation.  That might be appropriate after the race, or in a chip 
race where the runner’s chip was not recorded (see page 53 for an easy way to enter IDs 
and times after finishers have been recorded).  Similarly, you can delete an erroneous 
ID number by clicking on it and then clicking on the “Delete” button.  In such cases you 
may be asked whether you also want to delete the time entered for that place.  Probably 
not if you’re entering IDs manually. 

Sometimes a husband/wife/parent/sibling will inadvertently switch their assigned 
numbers with their partner.  An item under the Finish Order menu allows you to 
“Switch places of pair of finishers;” you simply enter their ID numbers. 

In cross country you can probably wait until the conclusion of each race before you 
leave the ID entry process (unless you’re sending results to a web site or scoreboard 
during the race; see page 66).  In road races you will want to interrupt the process (after 
each spindle is a convenient time) to post preliminary results. 

When you are satisfied that you have correctly entered the data on the present 
spindle (or have volunteers ready to check your work for you), quit entering data by 
clicking on the “OK” box or typing <esc>.  If you are networked with a computer that 
is running TheTimerAP, or are connected to a TimeMachine or the like, you are invited 
to “read” in the times before printing anything out.  The results of the runners on this 
spindle are then printed out; see the sample at the end of the manual.  If you didn’t 
already check your entries against the spindle on screen, pass this printout on to a 
volunteer who will do so.   

To the extent that the times of those runners are on file, they will be listed on the 
printout, too, which can be posted to provide very rapid results.  Similarly, if select 
times are on file, they will also be listed beside the individual time for the runner 
whose ID number was entered by the select timer.  Comparing the two times will help 
you detect timing and tag collection errors; see pages 46-49 on “Using Select Times.”   

If you are using KEYCODES to flag runners in different divisions, you can list their 
divisions in the preliminary results by using lower-case codes for divisions of interest; 
see page 12. 

The spindle printout will flag runners for whom no age is on file (assuming you are 
tracking age or year in school).  If the age is shown on the runner’s tag (as is often the 
case for a race day entrant who did not enter his/her age on the entry form), use the 
“Edit” option to enter it as described above. 

The number of the spindle is shown on the printout and the location of the end of 
the spindle is stored (in a file called “SPINDLES”).  Printing out the data entered 
spindle by spindle will help you locate errors of which become aware later.  If you find 
there is a problem with runner number 1038, for example, you can find his place in the 
finish order by using Finish Order’s “Find place by ID” option (Ctrl+F), and then find 
out what spindle his/her tag is on by looking through your printouts.   

In road races, the numbers of finishers recorded thus far in each age group are now 
shown on the screen. This gives you a clue as to when you have 
enough data on file to print out results for the awards 
ceremony.  If you are still short, simply go on to the next 
spindle, typing Ctrl+A or pulling down the Finish Order menu 
to “Add” or clicking on the “Add ID numbers” button.  In some 
of the age groups, there may not be enough entrants to take all 
the awards.  Thus the display also lists the number of entrants 
in each age-sex group. 

Preliminary Results 
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In cross country, after entering each batch of finihsers you get an 
option to print out “preliminary XC team scores;” i.e., scoring by place 
with displacement, as opposed to scoring by time which is used in road 
races.  The scoring is based on finishers recorded.  As indicated in the 
dialog at left, you can, if you choose, list the numbers of finishers in 
teams that are currently incomplete.  Although the scores are based on 
the assumption that eventually all teams will be complete (runners on 
incomplete teams do not affect the placing), it is usually quite accurate. 

 
If you wish, you can print or reprint the preliminary results later.  To create a list of 

finishers (with spindle breaks indicated), pull down the Finish Order menu to “Check 
finish order” (Ctrl+C) or click on the “Check” button, declare that you do want to print 
out the “details” of the results, and specify the starting and ending places of your 
printout.   

Before finalizing your results, pull down the Finish Order menu to “Check finish 
order” or click on the corresponding button.  This will display any errors you may have 
missed (duplicate ID’s, blank names, etc.).  You do not need to click on the “Print 
results in detail” box for this purpose. 

As indicated above, entering the finish order is usually first in priority, since you 
can identify the age-group winners (and score teams by place) without knowing their 
times.  However, runners are interested in their times (and sometimes in their rivals’ 
times), so the more you can print out by the time of the awards ceremony the better.  
This is no problem if you are downloading times from a serial device like the 
TimeMachine or a networked computer.  After each spindle, you simply accept the 
option to update your times files and there they are, along with select times that help to 
confirm the accuracy of the results; see pages 46-49.  You might also use the “Print 
Results” option (discussed in detail in the next chapter of this manual) during the race 
to the extent you can, especially in longer races, for which the lower rate of finishing 
permits it and the long time between the arrival of the first finisher and the award 
ceremony demands it. 

If you must input times manually, you should go back and forth between the Finish 
Order and Times parts of RaceDay, at least until the spindles start to pile up.  

Pull the Data entry menu down to “Times” or type Ctrl+T or click on the “Times” 
button on the desktop.  A “Times” menu 
then appears on the menu bar and the 
desktop buttons change appropriately.  
Click on the “Add Times” button (ctrl-A) 
or pull the Data entry menu down to “Add 
results data.”  You are asked at what place 
you want to add times, the default being 
the next available place.  The entry form 
shown at left now appears. 

For the first finisher, enter the time with 
the usual colons (or semi-colons; quicker) 
separating the minutes and seconds (and 
hours and minutes, if it’s more than an 
hour) as you would expect: 15:22.3, e.g.  
After the first finisher, the program will 
remember the hours and minutes of the 
previous finisher, which speeds up the rate 
of data input.  If the next finisher’s time is 
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less than a minute more than the last time recorded, you need only type in the seconds.  
If the seconds are less than the seconds part of the last time recorded, the program 
assumes that the minutes have increased by one.  Thus, to enter the data shown above, 
one enters 45, 49, 5, 10, 20, 33, 33, 35, and 10.   

When there is more than a minute between successive finishers, you type the 
minutes and seconds (and hours if it’s more than an hour).  But you can then use a 
semi-colon rather than a colon. 

After typing in each time, press <enter>, <tab> or the down arrow to get to the next 
one.  Hit the <escape> key or click on “OK” to terminate data entry.   

This procedure applies only when the time is being added to the end of the TIMES 
file.  To edit a time already input, click on it, and then correct the seconds, minutes 
and/or hours part of the time by the usual drag-delete-type procedure, (re)entering it 
with colons (or semi-colons; again, the ARJaM programs assume a semi-colon is 
supposed to be a colon but that the shift key was not pressed “by mistake”). 

One disadvantage of this system is that an undetected error can mess up subsequent 
entries as well.  That is, if the last time was 58:40 and the next time is 59:45, you might 
type “45” and so get 58:45.  Once you catch the error, simply scroll backwards though 
the data entry window by clicking on the up-arrow until you locate the erroneous entry 
and fix it as described above.  Now move to the next time and pull down the Times 
menu to “Fix propagated error.”  The times after the erroneous entry will now be 
redone as if the seconds part of each of those times were entered. 

To terminate adding times, click on the “Quit” box or type <enter>. 

There are situations in 
which all the times are off 
by a fixed amount.  For 
some races, the “official 
time” of the first finisher 
is collected by a timer 
different from the one 
used to generate the 
finishers’ times.  Also, in 
chip timing, the chip 
reading device may be 
supplying times as time of day, and so need to be corrected by manually entering the 
time of the first finisher, e.g. (see page 52), a source of error.   RaceDay has an option 
under the Times menu, “Correct constant error”, that may be used in such cases.  You 
can either enter the correct time (with colons and decimals) or add (or subtract) any 
given number of seconds (put a plus or minus in front) to all the times, starting at any 
place you specify.  Note the option to handle races in which different divisions started 
at different times. 

An item under the Other Options menu allows you to “Sort IDs and times by time.”  
Since the IDs and times are generally entered in order of finish, this item is seldom 
useful.  However, occasionally one has to adjust a runner’s time; e.g., in triathlons and 
bike races penalties are sometimes assessed.  You can simply use the “Edit” item under 
the Times menu to change the time, and then use the “Sort” item to move both the 
corrected time and the corresponding ID number into their proper places.   

But see also “Editing Results After the Race” on page 53.  It’s quicker to enter the 
correct data as a select time. The new data will wipe out the old and be inserted at the 
proper time. 

Also, after the race you may be convinced that a runner’s tag blew away or was 
otherwise uncollected, and accept some estimate of his/her time (you may have a select 
time for that ID).  In chip races, the runner may have lost the chip enroute, or not 
fastened it to his shoe, or it may have failed.  If you know the place of the missed 
runner, you can go to the Finish Order/Edit menu and insert the runner’s ID at the 
proper place.  If the numbers of finishers and times are the same, you will be asked if 
you also want to insert a time at that place, which would be done by interpolation. 

See page 53, “Editing Results After the Race,” for making corrections when you 
know the missed runner(s) time(s).  The select time trick mentioned above is fast and 
accurate. 

Adjusting Times 
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In some cross country meets it is important to note runners who did not finish, and 
you may wish to report those who were disqualified.  To do so, simply enter “DQ” or 
“DNF” for their time. 

DNFs should be listed in the results at the end of the finish order.  Simply enter 
their IDs after the runners who finished the race and the time of “DNF” at the same 
place.  You may learn of a disqualification after the runner’s ID number is already 
entered, at place “N,” say.  If you simply edit time number N to “DQ,” the runner will 
still be listed as coming in in place N.  That may not be a bad thing, but, if you prefer to 
list the DQs at the end of the finish order, use the  “Sort IDs and times by time” item 
discussed above. 

If you scored the race before entering the DQs, those runners may be given team 
points.  To correct this, you will have to re-score the teams. 

Coaches have been known to whine when their runners are disqualified, sometimes 
successfully.  Make a note of the times of DQed runners before you change those times 
to “DQ.”  If you’ve already sorted them to the bottom of the finish order, restoring their 
times and then using the “Sort IDs and times by time” option will put them back in 
their proper position.  You may then have to redo the scoring, too, as noted in the 
preceding paragraph. 

You may be 
asked to find out 
whether a 
specific runner 
has finished, or 
to edit his time or 
basic info.  If you 
know the 
runner’s name 
but not his/her 
ID number, pull 
the Other 
Options menu 
down to “Find 
runner’s ID by 
name” item, 
which is similar 
to that available 
in SetData, see page 24.  You are then asked if you want to find the runner’s place and 
time.  Initially the dialog at the right has only the runner’s number filled in.  Follow the 
directions: hit a <tab>, and the name, place and time are filled in.  As noted in the 
dialog, you can correct the runner’s time at this point, and his place will be changed if 
necessary.  The race illustrated was chip timed; hence splits and net times are shown. 

You are then asked if you want to edit any data on the runner.  If so, you get the 
dialog on page 36, and can edit the runner’s name, age, sex, team, division, and PR, 
which may be important for scoring (see page 81). 

When you know the ID number, pull the Other Options menu down to “Find 
runner’s place by ID.”  That will bring up the dialog above and you go through the 
same subsequent options. 

If the ID number is not found in the finish order, RaceDay also searches the list of 
select times.  If a select time was recorded for that number, the place is shown as 
“unknown” but the time is reported.  This can be helpful if the runner’s tag was lost or 
not recorded.  See the discussion above under “Adding Missed Runners.” 

Select times are entered with a procedure very much like whatever is used for times.  
If you are networked with a computer that is running TheTimerAP, or are connected to 
a TimeMachine, they can be downloaded after you close each spindle of ID tags, 
provided they are being recorded by those devices.   

DQs and DNFs 

Finding a Runner’s 
Place and Time  

Editing a Runner’s 
Time and/or Data 
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To enter them 
manually, first pull 
down RaceDay’s Data 
entry menu to “Select 
times,” click on the 
“Select times” button 
or type Ctrl+S.  A 
Select Times menu 
appears on the menu 
bar and new buttons 
on the desktop.  Click 
on the “Add Select 
Times” button (ctrl-A) 
or pull the Data entry 
menu down to “Add 
results data.”  Enter an ID, then hit <tab> or <enter> to get to the time box.  As with 
individual times, RaceDay remembers the hours and minutes of the previous finisher, 
which speeds up the data input.  If the next finisher’s time is less than a minute more 
than the last time recorded, you need only type in the seconds.  If the seconds are less 
than the seconds part of the last time recorded, the program assumes that the minutes 
have increased by one.  To get the times shown above, one enters 24, 35, 37, 50, 12, and 
16.3 (select times are stored only to whole seconds, but when the data are being stored 
in the finish order and times files, too – see page 53, “Editing Results After the Race” – 
the times are stored as input). 

As noted on page 6, ARJaM has a keypad built into the software.  Thus an entry of 
“L7” for the time of runner #233 would be translated as “37” and produce the time of 
16:37 once the <tab> or <enter> key is pressed. 

Move around from one item to another with the mouse or arrow keys when you 
need to edit something.  As with times, when editing a time you need either to enter the 
colons or to edit around the existing colons.   

To delete a select time, pull the Select Times menu down to “Delete” (Ctrl-D) and 
enter the time.  All this does is to set the time part to zero.  It is never necessary to insert 
a select time, since the program sorts all select times on file before using them; you just 
tack new data on to the end of the list. 

To terminate adding select times, click on the “OK” button or hit <esc>. 

Select times can be used in several ways:    
1.  To provide approximate times, by interpolation between select times.  This can 
be useful for large races, in which the individual times may be unreliable (until 
corrected with the help of select times), temporarily unavailable (because they will 
be input by hand), or missing entirely (because of a timer failure). 
2.  As a check on the order of finish.  Select times are recorded at the finish line, 
whereas the “finish order” is based on data taken at the end of the chute.  Runners 
do get out of order in the chute, spindles are sometimes labeled out of order, and 
spindles may also be read into the computer in reverse order. 
3.  As a check on the order of times.  This is the primary function of select times.  
The person recording individual times may have pressed the switch too often or too 
seldom, and results for non-winning finishers are not acceptable for age/sex group 
records without the support of select times. 
4.  As the source of both the finish places of individuals and their times.  See 
“Editing Results After the Race” on page 53. 

The “preliminary results” discussed on page 43 list IDs, times, and select times: all 
the info you need to check the finish order.  To get complete results in that format, 
“Check Finish Order” item in the Finish Order part of the program (ctrl-F to get to that 
part and then either the first item under the Finish Order menu or the middle button on 
the right).  You do want to print out results; doing them to the monitor is good enough 
for an initial check. 

Entering Select Times 
Manually 
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The important things to check are whether 
the select times (the times in the far right 
column) keep on increasing with the runners’ 
places, without taking a sudden jump up.  Some 
judgment is required here: these select times 
were entered manually on an external device, 
and not always accurately.  For example, the 
select time of 15:23 recorded for runner #42, 
who finished at 15:10, probably belongs to 
runner #482.   

You may spot a couple of instances of 
successive select times being out of order; e.g., if 
the select time for place 75 is faster than that 
shown for a previous place.  This may indicate 
that the runners got out of order before they 
turned in their tags; select times are recorded at 
the finish line and tags are collected at the end 
of the chute.  However, it may also have been an 
error in entering the select times.  If you decide 
you want to switch them, wait until you edit the 
times (see below).  It will be much easier (and 
safer) then. 

If you see a long sequence of select times 
decreasing with place, check the spindle which 
was the source of those IDs.  It may be because 

the tags on the spindle were entered in reverse order (I had a meet once where the 
volunteer realized he had been putting the tags on the spindle upside down, printed 
side up, and so took all the tags off the spindle and put them back on printed side 
down but in reverse order).  This is easy to fix.  Pull the Finish Order menu down to 
“Reverse order of IDs” and enter the places of the first and last runners on the reversed 
spindle. 

If the select times jump up by a few minutes for a sequence of runners 
and then jump back down, a spindle may have been read out of order (or was 
used in the wrong sequence).  This is a problem that sometimes occurs in 
multiple-chute races.  Note the places of the first and last runners on the 
misplaced spindle, and the ID number of the first runner on the spindle that 
should have been entered after the misplaced one.  Pull the Finish Order 
menu down to “Move finish order data” and enter those data into the dialog 
like the one at left. 

The worst case is where just part of a spindle is out of order.  This 
happens in multiple-chute finish lines when a spindle is reused after the 
chute for which it was first used is closed and then reopened.  It’s very hard 
to determine exactly at what point the chute was closed and where the reuse 
began.  Although it may be too late to do anything about it, it may give you 
some satisfaction to yell at the person supervising the tag collection.   

Such problems can be minimized if the spindles 
are handed out at the head of the chute (near the 
finish line) and, when a chute is closed, a 
“plugger” is sent down with the next spindle to be 
used behind the last runner in that chute. 

Rather than eyeball the output of a “Check 
Finish Order” operation and search for problems 
in the order of finish, you can pull the Select Times 
menu down to “Check times and order.”  Basically 
this mechanizes the operations discussed above.  
An output like that shown at right suggests a 
reversed spindle for places 204-219, and a spindle 
out of order for places 260-308 (which is pretty 
close to how the errors were introduced).  If you 
are downloading times from an external computer 
after each spindle, the eyeballing approach is appropriate. 
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When you are satisfied that the finishers have been entered in the correct order, you 
are in a position to check the timing.  It is hard to hit a button once and only once for 
every finisher. 

Click on the Times button (ctrl-T) and then on “Edit Times” 
(ctrl-E).  Start viewing the times at place 1.  The select time for a 
runner who finished in a certain place is shown on the same line 
as the individual time recorded for that runner.  In the picture 
shown at left, you can see that the times and select times match up 
pretty well until between places 32 and 35.   After that the 
individual times are evidently off by one place.  You can bring 
them back into sync by deleting a time in that range.  (Disclosure: 
the display was created by inserting a time at place 35.)  Similarly, 
you can detect cases where the timer failed to push the button and 
so insert a time at a place that will make subsequent times match 
up with select times. 

To insert a time, click on the place where you want to do the 
insertion and then on the “Insert” button  (not shown at left).  
You’ll be asked how many times you want to insert and to confirm 
the place where you want to insert them.  Times will be 
interpolated between the existing times before and after the 
insertion.  Caution: make sure the place is correct.  Sometimes it is 
not recorded correctly if you don’t click hard enough on the place 
you wanted the insertion. 

If you need to delete a time, click on the place where you want 
to do the deletion, then on the “Delete” button, and enter how 
many times you want to delete and confirm the place where you 
want to delete them.  

The apparent necessity to delete a time could be due, not to the 
timer clicking the button too often, but to a missed finisher.  
Therefore, after indicating you wish to delete a time, you are 
asked if you instead want to insert blank lines (turkeys) in the 
finish order.  If you later find the missing finisher(s), you simply 
change the negative number(s) to runners’ ID’s.  The default is to 
insert blanks in the finish order rather than delete times if only 
one time is being deleted. 

If you have select times on the runners who finished one behind the other, with the 
select time of the second one less than that of the one in the lower place, and you trust 
the select timer, you can use this display to reverse their finishes.  Click on “Reverse” 
and then enter their places.  You could also use the “Move” button to take care of a 
misplaced spindle, but you would have to know the ID number of the runner in front 
of whom the IDs on that spindle should be.  

Hopefully you’ll never have to use this option.  It could be handy if your timing 
failed, but you were able to record select times (manually), or if the person doing the 

timing completely screwed it up (I remember one who 
clicked the button as soon as she saw the runner rather than 
wait for them to finish).  At least it’s easy. 

Go to the Select Times section (click on the button or 
type Ctrl-S) and pull the Select Times menu down to 
“Interpolate times.”  The dialog at left asks for a “maximum 
frequency.” This refers to the rate at which runners finish, 
which is estimated by the difference between the times at 
which the select timer recorded them divided by the 
difference in the places of the runners whose ID is part of 
two sequential select times.*  A typo in the ID can give a 
runner who finished long before the time at which it was 
recorded a select time long after he actually finished, 
leading to ridiculously high frequencies.  The “Straight 
interpolation” option is usual, although increasing the time 

                                                
* Actually this is the inverse of a frequency, but I’ve been using this nomenclature 

for 30 years and still can’t think of a compact way to say it. 
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to the next available select time is required by USATF rules.  You can probably accept 
the defaults. 

RaceDay now goes through the select times, looking for the place of 
the finisher whose ID the timer recorded.  If there are no individual 
times entered, RaceDay sets the first finisher’s time equal to the first 
select time.  After that, when a finisher’s ID matches what the timer 
recorded, times are interpolated between that runner’s place and the 
place of the last runner found.  Note that the display at left shows you 
when an ID is not found in the finish order and also when it is found, 
but at a place before that of the corresponding time. 

Regardless of which version of interpolation you employ, its use 
furnishes a check on the finish order, because the search for the place in 
ORDER of the ID begins at the place of the last time on file.  If an ID is 
not found after that place, it may simply be due to a transcription error, 
either on your part or at the finish line, but it may also be that the 
runner to whom it belongs was recorded as finishing earlier than the 
runner to whom the previous select time belonged. Since select times 
are recorded at the finish line, whereas the finish order is based on tags 
collected at the end of a chute, this indicates an error in ORDER.  
However, you may or may not be able to do anything about it.  If the 
runner whose ID was found before the last select time shows up in 
ORDER immediately before the runner whose ID was in the previous 
select time, fine, just switch those two finishers around in ORDER by 
using RaceDay’s “Fix reversed IDs” option (see below).  But if there 
were several finishers between the two selected runners, it’s hard to say 
whether the first one got lost on the way to the end of the chute or the 
second one jumped ahead.   

If the apparent frequency of the finishers is too high, you are asked 
if you want to delete the select time just read and to continue interpolating at the last 
place where the interpolation was not problematic.  I can’t think of why not. 

That’s it. 

Especially in cross country, you may have to process several separate races in 
succession.  When one is done, pull the Other options menu down to “Get another set 
of results” (ctrl-G).  You’ll be asked if you want a new ROSTERN; probably not.  Then 
find the folder in which the next race’s results are stored.  The dialog is asking for an 
ORDER file, but it’s usually nough just to click on the folder and hit <enter>. 

If you are networked to a remote computer running TheTimerAP, you’ll be asked at 
this time to locate the folder on that computer in which the new race’s times will be 
stored. 

Manual timing becomes problematic when finishers come in too frequently to 
capture accurately; i.e., when the race gets large.  Before chip timing, the solution was 
to operate multiple chutes, each timed independently and each with its own set of 
spindles and tag collectors, and then to merge their results on the basis of time.  
Although that is now ancient history, there are still occasions when merging the results 
of separate races/finish lines is necessary.  I have one chip race that requires two chip 
systems to handle the start; the start line is too wide for one system.  I time each start in 
two separate folders and then merge the results.  For billing cross country meets, I 
merge the results of the different races rather than add up the finishers in each. 

The “Merge data” option of RaceDay can merge any two sets of results on the basis 
of finishing time.  First be sure that both sets of results are correct.   

After pulling down the Data Entry menu to “Merge data” (Ctrl+M), you are asked 
to locate the ORDER file of the finish line whose data you want merged with the data 
from the finish line on which you are currently working.  Suppose that the results files 
for men are in directory “Men” and those for women are in directory “Women,” and 
that you are in RaceDay working on the men’s results.  Call up the “Merge data” option 
and locate the Women’s ORDER file (it’s important in this case to actually click on 
ORDER).  The ORDER and TIMES files from the “Men” directory will be kept in the 
“Men” directory but renamed as ORDERA and TIMESA, respectively, and the merged 
data will be put in the “Men” directory as ORDER and TIMES.  If you merge the data 
from more than two finish lines, simply recall the “Merge data” option and click on the 
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ORDER file from another finish line.  The data from each successive merge will be 
saved each time in file pairs ORDERB and TIMESB, ORDERC and TIMESC, etc.  Thus 
you will not lose the unmerged data; they will still be available if further corrections are 
found necessary.  Since RaceDay can open up files ORDERA (or any other file that 
contains the string “ORDER”) and TIMESA, you can leave them in the Women’s 
directory. 

RaceDay keeps you informed of its progress by printing out the place, runner 
number, and time of every tenth runner in the merged file on the screen.   

The merged files are always sized large enough to contain the two sets of files you 
are merging. 

ARJaM is compatible with several chip systems: Championchip/MyLaps shoe and 
bib chips, DAG, Jaguar, IPICO, Chronotrack, Bibs Bolt, RFID Race Timing, Race 
Results: the list keeps growing.  To use it with Championchip/MyLaps shoe chips and 
IPICO/Trident requires a special interpretative application ChipData, but the others 
can be handled with RaceDay 
as is.  Appendix B deals with 
certain special aspects of the 
IPICO system (which I used 
for 10 years) and Appendix D 
with race|result (my current 
system).    

Most of these systems 
create a file containing results 
in a format special to the 
system.  To read these files, 
pull the Data Entry menu 
down to “Read results data 
from file” (or type Ctrl-R or 
click on the “Read” button on 
the desktop).  The first three 
options in the dialog at right 
appear only if you first declare 
(by typing ctrl-F, pulling the 
Data Input menu down to 

“Order of finish,” or clicking on the “Enter and Edit Finish 
order” button, e.g.) whether you are working with finishers’ IDs, 
times, or select times.  The “Lynx .LIF file” option allows you 
upload a file from the FinishLynx electronic timing system.  That 
system produces very accurate times and places, but requires the 
user to click on the torso of each finisher in the image captured 
by the system and then manually enter the corresponding bib 
number.  The Chronotrack routines assume that the file is in the 
default CSV format: variable width lines and <CR><LF> line 
termination. 

When you exercise one of the chip options, the dialog at left 
gives you several options.  The default is to reject times that are 
faster than the last time on file.  This prevents reentering a time 
for a runner who was turkeyed out for one reason or another.  
Chip systems typically employ a 24-hour time-of-day clock; the 
third check box allows for the possibility that the clock goes from 
24:00:00 to 0:00:01.   Clicking on the next to last check box allows 
you to bypass this dialog and the file options dialog above. The 
other options will be discussed below.   

Except when you are reading a text or ARJaM .TEX file into 
the TIMES or IDENTIME file, the data read from the file are 
displayed in the “preliminary results” format described on page 
43. 
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To convert the 
times 
communicated by 
the reader into 
runner times, you 
need to know the 
reader time at 
which the race 
started.  That time 
will be subtracted 
from all times in 
the file to get each 
runner's time.  
ChampionChip/M
yLaps and 
race|result 
systems allow you 
to put a marker in the file at the start, or at a known time after the start.  If the marker is 
on the first line of the file (i.e., it was entered before any finishers), you’re asked for the 
race time at which the marker was recorded (you may be at the start and have to run to 
the finish to start the chip reader). 

Otherwise you establish the start time from the 
dialog at the left.   The “Search for start signal” option 
appears only when you are using MyLaps shoe chips 
or race|result and the first line of the file is not a start 
marker.  When recording splits  (or start times) with 
the same reader or a synchronized reader, you can 
import the start time from another split (it will be in a 
text file called “CHIPTIMESTARTED” in the folder in 
which that split was recorded).  The start time shown 
below that option is the last start time recorded, 
presumably for a split or the start. 

The default is to enter the winner's time (which 
you should always determine by using a watch or 
other timer) in the second box.  The default entry in 
the last box is the reader time at which the first chip 
was recorded.  If the reader was cleared of data before 
the arrival of the first finisher, that is the reader time 

of the winner.  If not, change that time to something just before the winner's reader 
time.  RaceDay will then compute the reader start time by subtracting the winner’s 
actual time from the reader time at which the winner finished.  

In any case the reader's start time is subtracted from the other times it collects to get 
the runners’ times.  If you input the reader data in batches, the dialog above will not 
appear once you establish the start time. 

For road races, you may want to start outputting results for awards before the last 
finisher arrives.  Once you enter the results part of RaceDay, you can continue to read 
data from chip files by pressing !R or clicking on the Read button. 

The “Extract times last seen” option is, as indicated, useful for capturing start times. 
One of the attractions of chip races to runners is the possibility of getting their time 
from when they crossed the start line to when they reached the finish.  To satisfy them, 
you must open a folder (“Start,” say) in which to store the times at which they leave the 
start line, either by declaring you will have start times when you first create files for the 
race in program NewEvent (page 10) or afterwards in RaceDay (page 37).   

Recording start times is somewhat messy, since the reader typically records 
runner’s times when they go back and forth across the starting mats before the start 
and when they are standing on the mats (which are supposed to be behind the start 
line) waiting for the gun.  The solution is to operate on the reader's data file with the 
“Extract times last seen” option.  With some chip systems you are invited to input an 
approximate start time, which should exclude the extraneous records.  If you take your 
computer to the start, and have synchronized the reader(s) with the computer, you will 
be able to observe the start time; input something a few seconds before the start time 
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you observe.  The last time each chip is seen is first written to a file whose name 
appends “LS” to that of the source file in the same folder as the source file.  You then 
upload that file into the ARJaM files.  When presented with the "Start Time" dialog, 
simply hit "Okay;" the "winner's time" is 0.0 and the first time in the file is the time at 
which a runner first crossed the starting line. 

Ideally, when you list the 
“preliminary results” for the start 
on the monitor, you should see the 
first several runners with times 
under a few seconds.  However, if 
you did not choose an approximate 
start time close enough to the actual 
start time, it can happen that a 
runner crosses the mat(s) before the 
start, but then runs around them or 
is otherwise not recorded crossing 
them after the start.  In that case 
you get results like those shown at 
the left.  Clearly #222 was the first 
runner to cross the start line.  In 
such a case you must delete the 

data for the runners who were not recorded crossing the start mats after the race start.  
In the case shown, delete the first six runners and accept the option to delete their 
times, too.  Then go to the Times part of RaceDay and “Correct constant error,” 
subtracting 6:02 from everyone's time. 

If your start line is so wide that you need more than one reader, read them all into 
separate files and then merge them.   

As noted above, many runners want to know their “chip time,” their time elapsed 
between the start line and the finish line.  To get chip/net times, (1) while in the Start 
folder, pull down the File menu to “Store  start times” (they are stored in a file called 
TRIPLEDATA) and (2) when you start to record finishers’ times, click on the “Start time 
available” box in the Chip Options dialog shown on page 51 (it should be on by default 
because of the ORDERX file created in NewEvent; see page 10).  If you forget to do that 
for the first batch of finishers, pull down the Other Options menu to “Subtract start 
times to get net times.”  The chip times will then be displayed on your preliminary 
results (in the column otherwise occupied by select times), and are easily inserted in 
printed results (see “Splits and Net Times” on page 64).  

IPICO, Trident and race|result allow you 
to stream data directly from the reader.  Pull 
RaceDay’s Network menu down to “Open 
LAN connection” and select the timer type 
(RaceDay remembers the last timer type you 
used).   You are then asked for the IP address 
and port of the reader, as shown at right.  
When you want to import some data, pull the 
Network menu down to “Read data over 
LAN.”  The data in the reader are processed 
automatically: once you establish the chip start 
time, results are shown in the preliminary 
results format.  See Appendix B for details of working with IPICO/Trident and 
Appendix D if you’re using race|result.   

Q: Why did the arrogant runner not get recorded in the results? 
A: Because he had a chip on his shoulder. 
Chip times are always very accurate, and you always get one and only one time per 

finisher.  However, especially with shoe chips, not every runner wears the chip 
properly, and they sometimes fail, in which case the runner receives neither a time nor 
a place.  I use FinishLynx to back up the chips. 

Chip race or not, if you are able to determine a missing runner’s time, the quickest 
way to correct the results is to use the “Add” routine in the Select Times section of 
RaceDay.  When you start adding select times, if the numbers of finishers and 
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individual times on file are equal (if you have none on file at all, e.g.), you are asked if 
you want to store the IDs in the finish order file and the times in the times file.  The 
data will be inserted in the files at the proper place. 

You can also edit a runner’s time by the same means.  The existing data will be 
removed (the runner is turned into a turkey, actually) and the runner’s correct result 
put into the files at the correct place.  

You could in fact enter a complete set of results simply by entering select times, but 
I think I’d soon go nuts. 

If your event has a race announcer with a computer, put a copy of the Announcer 
application inside your event folder and put a copy of the event folder on a stick or 
otherwise make it available.  It’s very easy to operate. 

Double-click on the Announcer icon.  It will 
look for the ROSTERN file.  When you find it, 
click on “Start Timer.”  A dialog like that on page 
39 allows you to start a timer so that the 
announcer can see what the running time is. 

Every time a number is entered, Announcer 
will look it up and display the runner’s name, 
age, sex (if it’s tracked), home town (if it’s 
tracked), and team (if any).  As new runners are 
spotted, the ones already entered will remain on 
the screen, in inverse order of when their IDs 
were entered, with the most recent runner 
entered in bold at the top of the list. 

If the announcer doesn’t have a computer, see 
if you can supply one.  If you’ve got a spare 
Logitech keypad, an announcer’s assistant can 
enter IDs at will and leave it to the announcer just 
to look at the screen and talk. 

If you are using an IPICO, race|result or 
MyLaps system, you can stream data from the 
chip reader in program RaceDay.  Pull the 
Network menu down to “Open LAN connection” 
and click on “Data will be used to announce 

finishers.”.  When the announcer runs out of names to announce, he/she clicks on 
“Read data over LAN.”  The recent arrivers will then be displayed as described above. 

You may need to produce results for a race without having prepared the data base 
beforehand.  I often did so in order to reformat them for a magazine I published, and 
now often post results of other people’s races on my web site.  Program DownLoad can 
upload the data from most files you are likely to encounter; see pages 26-29.  If sent to 
you as an Excel file, first save it as tab-delimited text or csv.   

In the dialog that appears after you identify the file type, accept the default that the 
“Times in the file are finishers’ times.”  After uploading the data with DownLoad, start 
up RaceDay.  Go first to the “Finish Order” option (Ctrl-F) and its “Read” option (Ctrl-
R).  Accept the default file type of “IDENTIME.”  This will take the data from the 
TIMES file and fill in an IDENTIME file, the “ID” of the Nth select time being “N” and 
the time being the Nth time, and put the IDs in the ORDER file.  Your results files are 
now complete and you are ready for the “Print Results” functions we shall next discuss.   

Announcing 
Finishers 

 

Results After the 
Fact 



  
55 

Step 4: Outputting Results 
The general objective of Apple Raceberry JaM is to report the times and places of 

the individuals in a race and the scores of participating teams.  For a cross country 
meet, you will probably want to wait for each race to finish before posting results.  The 
last finisher usually is not that far behind, and may complete a team and so affect the 
scoring all the way down the line.  For road races, you can post the preliminary results 
discussed on page 43, although some users prefer to use the more elegant formatting 
available with the Print Results option that is the subject of this “Step” and use its 
“Order of finish” function for posting.   Once enough finishers are recorded that you 
know (from the display that appears after entering every spindle, see page 43) that at 
least some award groups are complete, you can start reporting them to the race 
director.  

In any case, click on the “Results” button (Ctrl-P). 

You are now presented with a wide choice of formatting options, as shown below.  
RaceDay will remember the options you choose, and use them as the defaults if you 
return repeatedly to print out more results, perhaps for a different race. 

These are the default options for a road race with no team 
competition but for which division codes will be used to separate 
finishers doing different distances, so that a KEYCODES file was 
created to simplify that task (page 15).  If there was team 
competition, you might want to click on the option to print a team 
name for affiliated runners. Also click on minutes per mile if you 
want to show the finishers’ pace.  The options to “Eliminate open 
runners” and restrict the output by ID number and/or division 
code will be discussed below.  For cross country meets the defaults 
include team name and team place rather than class place and 
home town.  The four radio buttons appear only when a chip 
system has been used to create net times; see page 64.  The option to 
print the runner’s division is active only when KEYCODES exist 
and at least one code is lower case. 

The “Age 1=Fr, etc.” box will be turned on by default if the first 
100 entrants have “ages” 1 to 4, as would be the case for a collegiate 
cross country meet. 

A header names the items listed: Place, Team Place, Finisher, etc.  
If you choose it can be printed on every page of the results, along 
with a title if you elected to print one. 

Whatever options you choose, the order in which items are 
printed is fixed, as is shown in the sample results at the end of this 
manual:        

Place overall*     
Place in class or team place*     
Name     
Age     
Female indicator*     
Time     
PR indicator*     
Time per mile or miles per hour*     
Extra data* or Division* 
Team name*   

The items marked * are optional; whether they appear depends on your selections from 
the dialog shown above.  

Formatting 
Options 
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Unless you deselect the option to print a title above the header, 
you will be asked what you want for a three-line title, as shown at 
right.  The default Race/Meet Name is whatever you entered when 
you started up RaceDay, and the location and date what you 
entered when you opened up the files with NewEvent.  The race 
location can be left blank when it is clear from the race name, in 
which case you’ll get just a two-line headline.  The title will be 
centered and in the larger font size that you select in the dialog 
above.  You are also invited to print out comments on the weather, 
records that were set, or whatever (if you can say it in 40 characters 
or less) and to identify the company producing the results.  These 
comments are printed in the basic font size (typically 12 point) just 
below the race date, and on the right.  The company name is stored 
in the ARJaM.ini file in your ARJW10 folder, so that it will be the 
default for your next event, with the other data being stored in the 
Notes file in 
the race or 
meet folder. 

The dialog at right will appear 
if you have elected to print out 
fractions of seconds (an option 
under the Times menu).  That is 
the default for cross country 
meets; you can also select or 
deselect the option with an item 
under the Times menu. 

If you have elected to print minutes per mile (or miles per hour, as 
is preferred in bike racing), you are next asked for the race distance. 

After selecting the format of the results, a Print Results menu 
appears along with a few buttons on the desktop.   

Every time you select one of 
these options, you pick the 
output device, the default being 
the same device you last chose.  
If you select “Printer,” you can 
print results in two columns 
under a centered three-line title.  
The dialog at right allows you to 
select the font size, indicating 
what sizes will allow multiple 
columns.  Use the smaller sizes 
in cross country meets when it’s time to print out results for the 
coaches to take home, and the default 12 points for results easy to 
read when posted or used for the awards presentation.   

See page 66 for how you can pre-select the format for road race 
results by creating an HTMLFILESTUFF file in the results folder. 

 
 

Road races sometimes wants to 
exclude the first few men and women 
from age-group awards, and perhaps 
masters (age 40+) and grand masters (age 
50+) men and women as well.  This is 
particularly so when those runners earn 
prize money.  If so, clicking on the 
“Eliminate open runners” box will bring 
up the dialog at the right. 
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If the race will be scored in divisions, select the division of current interest from the 
formatting dialog above.  If the divisions are defined by assigning them numbers in a 
certain range, pick the ID number range (use a “?” in the Start or End box if the ranges 
are separated by some blank names, see page 6).  If they are specified with division 
codes, enter the division code(s) of interest in the box or pull the “Select division” menu 
down to the appropriate division.  

A dialog (it is slightly different from 
the one at right when you select a 
division by division code) allows you 
to designate a subtitle for the category 
(it is filled in from your KEYCODES 
file when you score by division) and 
also the start time for the category 
(which will be stored if you change it) 
and race distance, if you had indicated 
you want the pace.  Thus you can 

handle, for example, a 
5K/10K in which the 10K 
starts first and everyone goes 
through the finish line at the same time. 

When you are done scoring one division, you can move on to another 
(with the same formatting selections) by pulling the Print Results menu down 
to “Change number/division code restrictions.”  The dialog at left invites you 
to enter the new restrictions, plus the associated subtitle, start time, and, if 
you’re showing pace or mph, the race distance. 

It often happens that runners enter one division and then change their 
minds at the last minute.  You can easily edit the runner's choice if you are 
using division codes.  Simply double-click on the runner's ID in the ID entry 
dialog on page 42 or pull the Edit menu down to “Name by number.”  This 
brings up the dialog on page 36 in which you can edit the runner’s division 
from either the pull-down menu or the division codes box. 

 
 
 

If you are printing results 
periodically as the race proceeds, 
you may have to switch in and out 
of the “Print Results” option.  When 
you reenter it, you are asked if you 
wish to re-use the previous options.  
This can save you several dialogs. 

For the typical cross country 
meet, the “Standard Road Race” 
button above will not be showing.  
In any case your preferred option is 
“Standard Cross Country,” which 
will show the team scores, the 
scoring runners, and the individual 
results. 

The details for this powerful 
option are shown at right.  In most 
cases the defaults will be fine.  
Here’s a description of the other 
options: 

• “JV scoring.”  In most meets 
with more entrants than the usual 
seven who affect the scoring, any 
additional runners are simply listed 
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with no team place.  Some meets want to have a “JV competition” and run the JV along 
with the “varsity.”  Unless they insist on pre-declaring who’s varsity and who’s JV (bad 
idea! Although you could handle it with the “division code” device.), use the JV scoring 
option.  This eliminates the first seven runners from each team (if that’s the number 
who affect the scoring) from the scoring, scores the rest, and defines them as the JV. 

• Varsity only.  If you’re doing “JV only,” the meet may want you to show the top 
seven separately, or simply list all the finishers together. In the latter case the “varsity” 
will be those indicated with a point score. 

• Mark qualifiers.  If the meet is a qualifier for another meet, 
you can flag the teams and individuals who qualify in the output.  
For printed output, they are marked with a “Q” and printed in bold 
face.  In Internet files, they are shown in red.  See below for an 
example of how they look in “newspaper” format.  There is also an 
item under the Print results menu that allows you to list just the 
qualifiers and alternates (members of the qualifying team who did 
not run). 

• Scoring by class.  USATF rules now require that teams be 
scored by age group in masters’ championships.  See page 21 as to 
how you can identify the age group of a team. 

• Excess finishers.  Some meets (such as qualifiers) limit the 
number of entrants.  When they are chip timed, alternates 
sometimes wear chips and are inadvertently recorded. 

• “Dual meet scoring” scores the teams in pairs and totals the 
number of wins and losses for each team.   

Ski races will be discussed in Appendix C.  The first skier earns a 
specified number of points for his/her team, and those that follow get 
one less point than the one before.  Teams are ranked in order of 
decreasing number of points. 

Accepting the defaults produces the results shown in the back of 
the manual.  The team scores and scorers are shown on the first page, 
and the finish order on the second. 

Note that there was a tie for second place. Under high-school rules 
ties are broken by looking at the places of the first non-scorer.  For 
USATF it used to be the place of the last scorer (now they use the 
“NCAA regional rule”), whereas NCAA rules let the tie stand (except 
for Regionals, or when the host decides to use regional rules).  In any 
case, when two teams have the same number of points an asterisk is 
inserted after the team place.  Once you make your selection, RaceDay 
remembers it as the default for ties in subsequent races of the meet. 
 

Road races generally 
give awards to the first 
few finishers in specified 
age/sex categories.  The 
quickest way to get an 
awards printout is with 
the “Standard Road 
Race” option.  Hitting the 
button so labeled or 
pulling down the Print 
Results menu to this item 
(Ctrl-R) brings up the 
dialog shown at left.  The 
program will then list the 
first “O” men, the first 
“O” women, the top “M” 
masters men and women, 
the top “G” grand 
masters men and women, 
and the first “A” in each 
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male and female age group, where “O,” “M,” “G” and “A” are the numbers you enter 
in the first four boxes, presumably after consultation with the race director.  If open 
and/or masters runners are ineligible for age-group awards, the numbers you entered 
in the dialog on page 56 will be filled in for “O,” “M”, and “G.”   

The “Make file” check box at the bottom (active only 
when you output the results to a file) puts the names and 
division places into a file that can be uploaded by Sorters 
and used to print labels for the award winners, via an item 
under its Other Options menu.  Select File for the output device.  Upload the file in 
Sorters.  The labels show the place and age group (and time, if you choose). 

The bottom check box allows you to tag award winners with a division code.  This 
enables sending emails just to award winners (page 72). 

Teams can be scored as part of the Standard Road Race printout, but only by time.  
If you have team classes, and the number of scorers is the same in each class, and set up 
a file “TEAMCODE” in SetData, the default is to list all teams by class at this time (see 
page 21).  If those restrictions are not useful, leave the “Number of team scorers” at the 
default “2000;” presumably no team will have that number of finishers and so the team 
scoring will be bypassed.  You’ll need the discussion below to get your team results.   

As indicated in the dialog, if the number of awards 
varies with the age group (in recognition of the fact that 
the number of entrants certainly so varies), typing a “V” 
in the fourth box allows you to tailor the awards printout 
accordingly by filling in the boxes in dialogs like that at 
left.  The check box at the bottom adds two extra names 
to each category, separated from the others by a dashed 
line, to allow for errors in data entry. 
 

 
 
 
 
 
 

When cross country 
scoring and scoring by time 
with team classes don’t do 
the trick, click on the “By 
Team” button or pull the 
Results menu down to 
“Teams” (Ctrl-T).  The 
options at the right appear.   
As already noted, you can 
score on the basis of total 
times or total places.  One 
system or another is sure to 
be mandated by the rules of 
the race.   

The “multiple dual 
meets” option is similar to 
what you can get under 
standard cross country 
scoring, adding the option 
to print out team vs. team 
scores for all pairs of teams.  
Picking out all-men and all-
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women teams can be useful in mixed races.   
Clicking on “Relay” forces the number of scorers to 1, the scoring method to total 

time, and removes the option to print all finishers.  It scores the teams by their only 
finisher, but lists the other members of the team as well. 

When you score by place, you usually elect not to allow unattached runners to 
displace team members.  For example, if the only team-affiliated finishers in the top 10 
are places 2, 3, 5, 7, 8, and 9, they would get 1, 2, 3, 4, 5, and 6 points, respectively.  To 
elect this option, leave the “Allow displacement by non-team members” box turned off. 

There is no limit on the number of entrants per team in the ARJ software (although 
there may be in the rules governing the competition).  However, if you elect to score by 
total places, and do not allow unattached runners to count in the place totals, you 
usually also need to limit the number of team members who can displace other 
finishers (“bumpers”).  Usually five finishers count in the scoring and seven can 
displace other finishers (in USA Track & Field championships, the number of team 
finishers who count as such is usually 8).  If a team had 10 finishers, their last three 
would be treated as if unaffiliated.   

Also when scoring by place, you usually must “Eliminate non-scoring teams”.  
Members of incomplete teams (teams with fewer finishers than the number who count 
in the scoring) are then treated as if unattached.  As with the limit on the number of 
team members who can displace others, this option zeroes out the members’ team 
record in the ORDER file, but the runners’ affiliations will still be listed in the final 
results (provided the format you selected includes the team name, whether as a “home 
town” or not).   

If you choose to score by place, and not to allow unattached runners and/or 
members of incomplete teams to displace team members in the scoring, it is useful to 
print out the “Team place” of the finishers when printing out the complete order of 
finish.  For this to be meaningful you must score the teams before printing out the order 
of finish.   Which is what happens in the default version of “Standard Cross Country.”  
You get the scores, then the scorers, and then the order of finish. 

Some road races have a “coed” teams division; scored, e.g., 
by the times of the first two men on the team and its first two 
women.  Click on the box “Certain numbers of runners must 
belong to age/sex groups to be specified.”  The dialog at left 
then appears.  For the code teams case, you’d enter “4” in the 
box.  You would then get a dialog asking to which age group 
each of the scorers must belong.  You’d click on “Males of any 
age” twice and “Females of any age twice.” 

You can elect to print the names and performances of all 
finishers (when scoring by place, all those who either score or 
displace other scorers) from each team.  If you do not turn on the 
“Print all finishers” box, only those whose performances count 
directly in the scoring will be listed. 

 
Once RaceDay has determined the scores of the teams, 

the program begins a loop with the dialog at left.  If there 
are a large number of teams, you may not want to list “All” 
teams.  Those that do not have enough finishers to be 
counted in the scoring are eliminated anyway in cross 
country scoring.   

 If you have prepared a TEAMCODES file, you will get 
the option to score all the classes in succession. 

If you select the “Scores only” option, you get a concise 
summary of team scoring that shows (in order of scores) the 
team name, team score, and team place of all its finishers), 
as shown below. This is essentially the format that leads off 
the “Standard cross country” output. “Scorers, places, and 
times” gives the second part of that output. 

The “List names only” option lists the teams in order of 
finish in “paragraph form,” as shown below: 
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1 Lakeville (Phil Smith, Chuck Smith, Chris Newby, Vince 
Reed, Matt Beauchane) 94 

2 Duluth East (Jay Schoenfelder, Nic Matack, Eric Hartmark, 
Nils Arvold, Justin Kavie) 103 

3 White Bear Lake Area (Josh Kath, Troy Brinkman, Andy 
Kummer, Chad Laber, Justin Skjegstad) 105 

4 Wayzata (David Herman, Jacob Hallen, Todd Obermiller, Ben 
Morris, David Frank) 124 

5 Minneapolis South (Ben Wahlstrand, Paul Richter, Ben Peck, 
Eric Giesen-Fields, Alex Rand) 180 

Again, ties are flagged by an asterisk after the place.  If you are scoring by time, the 
total time is listed instead of the total points.  You can elect to “Print all finishers” and 
list teams in this format by class. 

The “Packing” 
option is shown 
at right.  The 
teams are listed in 
order of 
increasing score, 
and the times of 
their finishers are 
graphed to the 
right.  Thus you 
can see how 
Stanford’s pack 
won the 1996 
NCAAs over a 
Villanova team 
that had two 
finishers ahead of 
its first. 

The optional program MultiRace is designed to score relays (and triathlons) and to 
record the splits turned in by each member of the team.  However, you can figure out 
the winning team without recording splits, since the first team to finish is of course the 
winner, by using RaceDay’s Relay option (see above).   

To exclude the relays from the individual competition, assign the relays numbers 
higher than those given individuals or give them a division code.  RaceDay will then be 
able to score the individuals separately from the relays by specifying the correct ID 
number range or division in the formatting dialog.   

I generally print out the complete 
order of finish at the conclusion of the 
race, at least for the race director for 
his/her records and for posting if 
anyone is still around. Click on “In 
Order of Finish” to get complete 
results in that order.  You’ll get the 
choices shown at right.  The last two 
items are of interest only when the 
results are to be posted on the 
Internet, as will be discussed shortly.   

You may also choose to print out 
the order of finish for posting during 
the race.  This is especially easy in 
chip races.  Once you set the results 
format, you add finishers in batches 
either by clicking on the “Read data 
from file” button or pulling the 
Network menu down to “Read data 
over LAN.”  After viewing the results 
on the monitor, click on the “Order of 
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Finish” button.  RaceDay will remember where you left off the last time you did so, and 
so, if you just added finishers starting at place 63, the dialog above will suggest you 
start at that place. 

Although the “Standard 
Road race” option probably 
meets your needs for 
awards presentation, you 
may need to list results for 
specific classes.  Pull down 
the Results menu to “By 
Class” option (Ctrl+C) or hit 
the corresponding button.  
The choices associated with 
this option are shown at 
right.  Clicking on the first 
button gives the first N 
male finishers, regardless of 
age and as to whether or not 
open runners are eligible for 
age-group awards, where N 
is the number you type into the “Number of finishers” box.  With N = 3, clicking on the 
third button gives the first 3 men in each male age group whereas the next button gives 
the first 3 females by age group, open runners not listed with either group if they were 
declared ineligible for age group awards.  If the race wants you to list everyone by age 
group, you may want to skip a page between age groups; if so, click on the last box.  
The fifth button brings up a list of age-sex classes, so you can select a particular group. 

You may also be asked to print out results in alphabetical order. Once you have 
finalized the finish order and times, go to program Sorters (you don’t have to quit 
RaceDay before doing so).  Click on the “Alphabetical” button (Ctrl+A), sort everyone 
on file, and click on the “Prepare alphabetized results” button. If you have multiple 
race/finish line folders, you’ll have to navigate to the ORDER file of interest.  A file 
called ALFARSLT, which contains the ID number, place overall, and place in class of 

the runners in alphabetical order, is stored in that folder.  
In RaceDay, pull the Print Results menu down to “Alphabetical results” 

option.  You can list last names first, if you choose.  Also, rather than list 
age-group abbreviations along with the runners’ places in those groups, 
you can list the number of finishers in those groups along with their place 
(“22/53.” e.g.).. 

A similar procedure produces results in zip-code or numerical order; 
just sort the runners by zip code (Ctrl+Z) or numerically (Ctrl+N) rather 
than alphabetically.  You can select a limited range of zip codes when doing 
the sort in Sorters, and so get results of interest to a particular newspaper, 
for example.  They will be listed in order of zip code, however. 

If you want results for all the runners from a particular state, it’s even easier.  
Include their “Home towns” in the results format, and pull down the Print Results 
menu to “By state.”  You will be asked for the two-letter abbreviation for the state of 
interest.  If, when you input the runners’ city and state, you used that abbreviation for 
the last two letters of its name, those runners will be listed in order of finish.  Similarly, 
you can get results for all entrants for a particular city or team by choosing those items 
from the Print Results menu.  You will have to supply the name of the city or team of 
interest; as usual, you start typing it and RaceDay looks it up for you.  Again the results 
will be in order of finish. 

If you wish, you can keep track of age-group (or single-age) records for your race, 
and flag performances that set new records.  All you need is a tab-delimited text file 
like this in your results folder: 
MN EASY DOES IT CLASS 
M 25:03 Brian McCollor 18 Minneapolis, MN 14 Jun 86 
M 23:58 Rolf Schmidt 23 North St. Paul, MN 10 Jun 89 
M 23:48 John Mirth 27 Minneapolis, MN 10 Jun 89 
M 24:23 Tom Stambaugh 30 Burnsville, MN 16 Jun 90 
M 25:12 Mike Seaman 35 Minneapolis, MN 14 Jun 86 
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M 25:37.9 Doug Suker 40 MINNEAPOLIS, MN 15 Jun 91 
M 26:30.1 John Emmons 45 WHITE BEAR LAKE, MN 15 Jun 91 
M 27:31 Paul Noreen 50 Plymouth, MN 29 Jun 85 
M 29:50 Greg Prom 55 St. Anthony, MN 14 Jun 86 
M 28:28 Alex Ratelle 61 Edina, MN 14 Jun 86 
M 31:02 Alex Ratelle 65 Edina, MN 16 Jun 90 
M 32:07.8 Alan R Anderson 71 EXCELSIOR, MN 15 Jun 91 
F 30:50 Debra Board 18 Maple Grove, MN 29 Jun 85 
F 28:33 Eileen Donaghy 22 Minneapolis, MN 10 Jun 89 
F 28:25 Lisa Czech 26 Hastings, MN 16 Jun 90 
F 27:14.2 Janis Klecker 30 MINNETONKA, MN 15 Jun 91 
F 29:49 Francine M Pahl 39 Minneapolis, MN 18 Jun 88 
F 30:13 Susan Josselson 40 Minnetonka, MN 14 Jun 86 
F 33:25 Judith Cronen 47 Lakeville, MN 18 Jun 88 
F 34:03 Patricia Larson 52 Prior Lake, MN 16 Jun 90 
F 36:15 Mae Horns 56 Edina, MN 16 Jun 90 
F 38:52.9 Mickey Armstrong 60 EDINA, MN 15 Jun 91 
F 39:37 Barbara Andersen 65 St. Louis Park, MN 16 Jun 90 
F 52:10 Helen Reiter 72 Edina, MN 10 Jun 89 

“Like this” means   
1. Its name is AGERECORDS.  
2. It must be saved as a “text” file.  
3. The first line of the file has the home state, the name of the record (race name, 

e.g.), and the kind of record, all separated by tabs: 
Home state: you can, if you wish, keep separate records for in-state runners and 
visitors. If you don't wish, just enter one record for each age or age group. But 
enter your home state anyway.   
Record name: for state records, use “STATE.” For race records, use the name of 
the race. The records will be labeled (in the example case) EASY DOES IT 
RECORD FOR ...   
Kinds of record: enter CLASS on the header line if the records are for the age 
groups used in the race. In the example case, a record would be labeled EASY 
DOES IT RECORD FOR MEN 19 & UNDER. If the records are for single ages, use 
AGE RECORDS instead of CLASS.  Such a record would be labeled EASY DOES 
IT RECORD FOR MEN 19.   

4. The rest of the file has one line for each record, with tabs between each field, in 
this order:   

sex   time   name   age   home town (or at least state)   date (or year) of record  
You'll hear a beep for each record detected if you accept the suggestion to “Mark all 

age records” (as noted, don't do it until you've entered and corrected all the times) that 
appears when you go to enter results. Those records are written out in tab-delimited 
form to a file called  NEWAGERECORDS. By cutting and pasting from 
NEWAGERECORDS to AGERECORDS, you can update the latter.     

If you have results files going back to the race's first year, you can use 
NEWAGERECORDS to create a file of race records. Simply start with an 
AGERECORDS file that has no entries below the first (“home state”) line.  

Listing runners by their age-sex group provides a measure of how they performed 
relative to their peers in this race.  However, given that a runner’s performances sooner 
or later decline with age, and that the best men will always run faster than women, 
such lists do not rate the runners across age/sex boundaries.  Hence the advent of “age 
grading” (actually age/sex grading), which assigns each performance a percent, ideally 
a percent of a world-class performance.  For details of the generally accepted WMA 
(World Masters Athletes; formerly WAVA) system, see 
http://www.usatfmasters.org/fa_agegrading.htm. 

Age-graded results 
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To age-grade runners’ 
performances in a race (or meet for 
which the runners’ age and sex are 
tracked), pull the Other Options 
menu down to “File WMA age 
graded results as split.”  You first 
identify the race distance from the 
scroll list at right (the mile, 3 mile 
and 7.5K factors are “unofficial”).  
Then you open up the file of age-
grading factors, currently called 
ROAD2015.txt but named 
ROADXXX.txt in the file-open 
dialog, which is in the ARJW15 
folder.  The age-graded results 
(percentages) are then stored as a 
split.  You are asked to identify the 
split.  Printing out results is 
discussed below.  You can, if you 
wish, sort the results by the age-
graded percentages.  To do so make 
the percentages the last split and see 
the discussion that follows. 

 
 

If you have results at splits along 
the course, or at the start line, you probably have a chip system.  Lucky you. 

See below under “Lap races” if you have more than one split at the same point. 
As noted on page 53, if you have start times it is easy to compute chip times and to 

store them as split #1.  If you will collect results at intermediate points, you must open 
separate folders for each split.  You can do so in NewEvent (see page 10) or use 
RaceDay’s “Add new results folder” item under the Edit menu.  The folder name will 
be used for the name of the split in results; keep its length to 12 characters or less so 
that the split name will fit on printouts.  You can store the split results as the split of 
your choice (except that split #1 is reserved for net times, if you have them) by pulling 
down the File menu to “Store results as split” when you’re in the split folder. 

If you have net times and splits, and want to report the 
splits, select the default “More options” radio button in the 
formatting dialog on page 55 (it doesn’t appear if you don’t 
have net times).  The dialog at left will appear. Note the 
option for reporting results in order of “net times.”  If you 
choose that, you can either report the clock time, too (by 

clicking on the last check 
box), or not.  The “Replace 
final time with sum of 
splits” option is often 
useful in Nordic pursuit 
races; see Appendix C.   

In any case, after 
leaving the splits dialog 
you name the splits from 
the dialog at right; the 
names you assign will be 
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printed in the results header.  The default names of the available splits are stored when 
you save them, based on the names of the results folders from which they come.  If you 
have stored age-graded results, that split is named “AGE GRADE.”  Note the option to 
sort the results by one of the splits.  This is not available when you ask for the results in 
order of net time.  If one of the splits is the WMA age/sex percent, and you can accept 
the name “AGE GRADE” for the split, the box asking for the number of that type of 
split will be filled in.  Also note the option to report the net time as the last split (just 
before the clock time).  If you decided in the preceding dialog to report the results in 
order of net time, that option does not appear.  The net time will then be the last 
column, and the clock times will be listed just to its left, unless you decided not to print 
them at all.  Finally, note the option to subtract each runner’s start time from each of the 
non-WMA splits, making them all net times. 

Rather than report the net or clock time runners get to the splits, you may wish to 
report the time they take between splits.  For example, if you have a split at 5K in a 10K, 
you may want to report the times taken for the first and second 5K’s.  If so, there is an 
option in program MultiRace that can do the trick.  See page 83. 

As indicated by the Standard Cross Country dialog, if you have timed splits in a 
country meet you can show the team scores at those splits and show the finishers 
places and times at the splits.  For an extreme example, see 

http://raceberryjam.com/2018/nc2mencc.html 

If you have net times but no splits, you can use the radio buttons in the formatting 
dialog on page 55 to report net times only or net and clock times sorted by one or the 
other.  The splits dialogs described above will not appear at all unless you accept the 
default choice “More options.”  If you decide you want to report clock times only, 
simply leave the number of splits as the default “0.” 

The maximum number of splits RaceDay can display is 15 (you’ll have to print 
results sideways -- i.e., landscape rather than portrait -- if you have more than five).  If 
you are scoring a lap race, you may have many more splits than that.   

First you have the problem of recording 
the splits.  The easiest way (short of a chip 
system; the dialog on page 51 allows you to 
record runners repeatedly after a specified 
interval) would be to record select times for 
everyone, accepting the option to add the 
IDs to the finish order and the select times to 
the individual times file.  If you record IDs 
manually, you will soon have to brave a lot 
of “NUMBER XXX FOUND AT PLACE 
YYY” messages. 

To display the splits, pull the Print 
Results menu down to “Count multiple 
finishes (splits).”  The splits are then shown 
as at left.  When you’re done, you’re asked if 
you want to file the “last IDs and times.”  If 
so, it actually shows the final elapsed time 
for each ID in ARJaM results files ORDER 
and TIMES. 

 

 

 

 

 

Some events enable runners to participate in more than one race.  For example, a 
10K and 5K may be run in succession.  The obvious thing to do is to score runners who 
do both races by summing their times. 
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To do so in RaceDay (see page 83 for using Multirace, which provides more options 
in reporting the results), simply save the results of each race as a split (an option under 
the File menu).  Then pull down the Edit menu to “Add new results folder.”  Click on 
“Print results,” say you want two splits and click on  “Replace final time with sum of 
splits” in the splits dialog on page 64.  You’ll be asked for the “Required number of 
splits.”  Say “2” and click on “Order of finish.” 

If you have splits or a start time in the two events, it’s slightly more complicated.  
Splits are stored in a file called TRIPLEDATA.  If you have split folders within the 5K 
and 10K folders, there is a TRIPLEDATA created inside both the 5K and 10K folders.  
Copy the finish results for each race (an item under the File menu) to new folders 
outside the 5K and 10K folders (in the ROSTERN folder).  Then go to those folders 
before you start saving the results as splits. 

Runners (and their friends) can now obtain smartphone apps from which they can 
find their place and time “shortly” after they finish.  RaceJoy, currently available for 
iPhones, is the more sophisticated of those available at this time, also provides place by 
age group and live tracking.  It costs the runners $1.99 and there is also a fee to the 
event. Bibs runs on iPhones and Androids and is free to both runners and events.  Apps 
of this type are probably released every month; I’m sure this it out of date info. 

To enable any of these apps you must have 
Internet access during the race and send results 
files periodically to a Dropbox folder to which 
the purveyors of the service have been given 
access (Dropbox, a cloud-like service, is also free; 
at least up to a point)).  In RaceDay, name the file 
“racename.csv” and put it in the Dropbox folder.  
Once you do so, the output device selection 
device will have a special Dropbox item and 
ARJaM will remember the location of the 
Dropbox folder, even after you close RaceDay.  
Also, if you have been using files from a chip system for your results, RaceDay will 
remember where they are, too, and take you back to the folder in which they are filed 
when you are ready to read another file. 

For this to work, runners must have the appropriate app.  Send preregistered 
runners an email before the race to advise them of its availability; see page 31 for how 
to do this with program Sorters. 

If you have a web site on which you can post data yourself, you can set up links that 
will enable runners and their friends to access both their individual results and 
periodically updated full results from their smart phones without having an app.  
Preparing and posting an HTML file that will include links to your results files is 
discussed in detail on pages 71 and 72.   

Before the race, open RaceDay and navigate to the folder that 
contains the ORDER file for the finish.  Pull down RaceDay’s File 
menu to “Make HTMLFILESTUFF.” That is the name of a file 
which will stored in the finish folder.   In the race for which the file 
at left appeared, 8K runners were finishing with 5K runners.  The 
“xxx” in the first line was replaced by “freedomfun8k” and 
“freedomfun5k.html” was entered on the third line.  There are also 
boxes for two more divisions, not needed for this event. 

Note the check box at the top for storing “format files.”  Unless 
you reject this useful option, you are then asked if you want to 
include award winners in the results files.  If so, there will be a link 
in the results file(s) to the finishers who will take home awards.  
Here’s a sample of such a file: 

http://raceberryjam.com/2018/nv10k.html 
In any case, you are now taken to the “Results options” dialog 

of page 55 and all the related dialogs (race distance, eliminated 
open runners, net-time related options, etc.).  Your choices are put 
into a file called xxxORDER.txt; you can edit the part of the name 

before “ORDER,” but leave “ORDER” alone.  If you accepted the option to include 
award winners in the file, you then enter the numbers of open and age group award 
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winners.  Your selections are written to a file called xxxAWARDS.txt.  This is done for 
each division you wish to post separately. 

You are then asked if you want to “Make LIVEFILE, now, too.”  LIVEFILE is 
discussed below. 

During the race, after entering a batch of finishers (with or without the help of a 
chip system), you are asked if you want to update the file(s).  If so, you’ll see messages 
to that effect.  If you have to edit the results (enter a name for an unidentified runner, 
correct someone’s age or division, correct a constant error in the times, reverse the 
order of some runners, whatever) the files will be updated automatically and refreshed 
every 60 seconds.   

You should put a link to these files in a prominent place on your web site before the 
race.   

As above, send preregistered runners an email before the race to advise them how 
to access the   results when you’re updating them periodically; see page 30 for how to 
do this with program Sorters.   

If you have two to four race divisions finishing thru the same finish line, and the 
divisions have different age groups, their results must be kept in separate folders.  
Create an HTMFILESTUFF file in each folder.  When you add to the finishers in a 
division, only its html file will be updated.  When you switch from one division/folder 
to the other and enter some more finishers, the correct html file will be updated.   

When, as in the 5K/8K case, one division has quite a few finishers before the other 
has any, it is useful to give the division that finishes later a lower-case code.  Then you 
will see on the preliminary results display when members of that division start to 
arrive, and so will know when it’s time to switch divisions to print out results of the 
second division; see page 13. 

As a bonus for creating an HTMLFILESTUFF file, an item under the file menu 
“Output results using stored formats” is enabled.  After clicking on this item, you’re 
asked to locate the xxxORDER.txt or xxxAWARDS.txt file of interest.  This enables 
printing results without having to format them.     

For road races, the order of finish -- overall, by sex, and by age group -- are of 
primary interest.  In cross country, team scoring is as important as individual 
placement.  This is supplied by a function similar to that of HTMLFILESTUFF in road 
races. 

Because the formatting is usually minimal (name, year in school, team, time, and 
place overall), and because scholastic and collegiate cross country meets always have at 
least two separate races, it is convenient and useful to create the files in NewEvent as 
you make results folders.  Click on the “Create HTMLFILESTUFF” option in the dialog 
on page 8 for the first race you set up. All you’ll have to do is to name the results file for 
that race.  The option will be on for the other races; simply name the results file for each 
race.   

At the meet, after each batch of finishers is entered, you are first asked if you want 
to “Show preliminary XC team scores.”  You do; see page 44.  If you made 
HTMLFILESTUFF, you are then asked if you want to update the html file.  If you do, 
the html file will include “PRELIMINARY RESULTS” in its header and show the 
preliminary team scores based on the finishers recorded thus far under the assumption 
that all teams will eventually be complete (again, see page 44), followed by the order of 
finish.   
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To permit 

runners to 
access their 
individual 
results 
without 
searching 
thru the full 
results, also 
post a link to 
a file called 
“findmytime
XX.php” on 
your server.  
To enable it, 
before the 
race pull down RaceDay’s Other options menu to “Make LIVEFILE”  (as you’re invited 
to do when you create HTMLFILESTUFF in RaceDay).  The dialog above appears.  
Because you may have several active versions of this file on your site (for different 
races in a cross country meet, or for races scored by different members of your scoring 
team), you can enter a suffix for the LIVEFILEs that contain the data for each race and 
for the “findmytimeXX.php” files that operate on those files.  If you are using 
KEYCODES to distinguish different divisions of the finishers, you can select the 
divisions in which to report the runner’s order of finish.  For the Freedom Fun Run, “e” 
was used to indicate 8K runners and “F” 5K runners.  Note: as you’ll see below, results 
are always reported by sex as well as by division, so, if you have assigned division 
codes by sex, don’t bother to include the sex-based division codes you select here.  Also 

note the question as to the basis for awards. 
When you create a LIVEFILE, a blank version of 

it and the files that will operate on it once you have 
some results are posted to your web site.  During 
the race, after each batch of finishers are recorded, 
their data are put into the LIVEFILE in your results 
folder and its version on your web site are updated.  
On clicking on the link to findmytimeXX.php, a 
display like that at left appears.  (For cross country 
meets, there is a note that entering a team name will 
yield individual results of all team members who 
have finished thus far.) 
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When you enter a race 
number or last name, the 
findmytime app searches its 
version of LIVEFILE on your web 
site (which is usually different 
from the version on your results 
folder) for the associated runner.  
If successful, the results are 
reported in the display at left.  
For this race, awards were based 
on net time.  LIVEFILE records 
them in order of finish; hence the 
note.  This runner was entered in 
the walk division.  His placement 
overall, by gender, and by age 
group are reported relative to 
that division.  Also note the 
negative start time; walkers 
started 1:09:00 before the runners.  
Finally, note the options to email 
or text the results. 

 
 

 

In principle, Apple Raceberry JaM can send results to any properly configured 
scoreboard that can accept data from FinishLynx.  The only one with which this has 
been done so far as I know is the 
Micrograph, marketed in the 
United States by Lynx System 
Developers.  It also connects to a 
computer running ResultsTV, 
another Lynx product, which can in 
turn drive a Jumbotron. 

RaceDay connects to a 
Micrograph either via a serial 
connection or over a LAN.  Pull 
down the Scoreboard menu to 
“Open scoreboard.”  The dialog at 
right allows you select the COMM 
port if you’re using a serial 
connection.  If not, set the COMM 
port to “Connect.”  Then select the 
particular function of interest under 
that menu.  Initially you should 
select “Show running time,” just to 
get something showing on the 
board and so attract the attention of spectators.  You are then taken to a dialog like that 
on page 39, where you input a time and hit enter when the running time reaches it. 

As indicated above, RaceDay is programmed to show a variety of results on the 
board.  But since the board shows only one result at a time (every 3 seconds is the 
recommended refresh time), I have not found it useful for most of these functions. 

What has been useful is to show team scores and the first few finishers in cross 
country races.  After each batch of finishers is recorded, accept the option to “Show XC 
team scores.”  If any teams are complete, they will be scored assuming all teams will 
eventually be complete, and you are asked if you want to send the results to the 
scoreboard.  If you say yes, you’re asked how many teams and individual results you 
wish to show; the limit is a total of 29 (which will take about a minute and a half).  The 
results are labeled “Preliminary,” since, if any teams never complete, the scores are 
incorrect.  But the placement is usually accurate.  For championship meets, some 
runners compete as individuals.  If they are separated from those who compete as team 
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members by a range of ID numbers, you can exclude them from the scoring, which will 
then be perfect. 

Here’s what it looks like: 
https://youtu.be/aajgky2fPfI 

The Micrograph costs $7500.  Thanks to a suggestion from one of my customers, I’ve 
come up with a much cheaper and, in a way, more powerful solution. 

You need a flat screen TV (you can get a 40-inch screen for about $250) with an 
HDMI connection. Mount the TV on a tripod (I use a Monoprice ceiling mount and an 
old tripod that has a one-inch diameter shaft).  Connect the TV to your computer with 
an HDMI cable (50 feet is probably the longest you’ll find).   

When you open the scoreboard in RaceDay, choose “HTML” as the scoreboard 
type.  The COMM port is not used; it can be ignored, as is the case with the baud rate. 
As for the number of lines, for cross country anything from five to twelve looks good.  
For road races, choosing 15 to 20 lines gives you two columns.  Five or six seconds is 
probably okay for a refresh time; suit yourself.  You can always pull the Scoreboard 
menu down to “Change board settings.”  

Once you select the scoreboard parameters, you’re asked if you want to “Refresh 
board after adding results.”  You do.  An html file BOARDFILE.html is then created in 
your race folder.  Double-click on it; initially it will say “Results will be posted here 
when available.”  Turn on the TV.  Right-click on the desktop and click on “Display 
settings.”  Scroll down to “Multiple displays” and select “Extend.”  Then, with 
BOARDFILE visible on your monitor, press and hold down the Windows Key and then 
press the SHIFT key. While keeping those two pressed hit the right arrow key to move 
the current active window left or right.  The html file will disappear from your 
computer and magically reappear on the TV, many times larger. 

If you have created race divisions and asked for more than 14 lines, you’re asked if 
you want to show results separately for any two divisions.  For a 5K and 10K finishing 
at the same time, e.g., first the 5K finishers will be listed and then the 10K finishers.  
Check it out here (this one was a 5K/8K): 

http://raceberryjam.com/scoreboard.MOV 
After each batch of finishers is processed, you’re asked if you want to update the 

scoreboard.  As with the html results files sent to the Internet, any correction of errors 
or omissions automatically refreshes the scoreboard. 

Some Jumbotron operators will refresh their boards by accessing an html file you 
post on the Internet.  Although you could send BOARDFILE to the Internet, you’d be 
sending a new file every 5 seconds or so. That’s a lot of (expensive) bandwidth. 

An option in the html language allows the data in an html file to scroll on the 
viewer’s screen.  See, for example, 

http://raceberryjam.com/2018/scrollfilex.html 
You can control the size of the results and the speed at which they 
scroll by pulling the Edit menu down to “Scrolling parameters.”  

To create such a file, after clicking on Print Results and selecting 
your formatting options, and then on the type of results wish to 
display and “File” for the output device, name the file something like 
“scrollfilesomething.html.”  Having “scroll” in the file name will 
make the default file format “Scrolling HTML file,” which is what 
you want.  As you add finishers, the file is updated and refreshed 
every 60 seconds. 

After you enter each batch of finishers, you’ll be asked if you want 
to update the scrolling results.  After the results currently showing 
get to the bottom, they will automatically be replaced by the newer 

set. 
In cross country meets, accept the option to  “Show XC team scores.”  The scrolling 

file will list the complete teams (once at least one team is complete) and their scores, 
followed by all the individual finishers and their times.  
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Scrolling Files for 
Scoreboards 
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Step 5: After the Race 
If you have a substantial number of entrants on race day, you probably have to skip 

inputting their addresses until later.  After the race, return to SetData.  Leave the “Enter 
and edit shirt size” box off.  When you pull down the Add menu to “Entrants” or type 
Ctrl+A, you get the dialog shown on page 15.  Click on the “Add mainly addresses” 
box, and “start adding at” the first number of the race-day entrants.  When the entry 
form for those runners appears, the cursor will be on the “Street” line.  Enter the 
address if it’s not there already.  If you have already entered the runner’s home town 
and zip code, hit the down-arrow to get past those boxes and tab to the email box if you 
need to enter an email address.  Otherwise hit <enter> to move on to the next entrant. 

Apple Raceberry JaM makes it possible for you to post your race results on the 
Internet with very little effort.  You will, of course, need access to the Internet and an 
Internet service provider who allows you to store your files.  Software that allows you 
to send files to the provider is optional; RaceDay can do it for you. 

For examples of what your readers will see, check out my Web site 
http://www.raceberryjam.com.  Note that the software you use to view the page (the 
“browser;” Netscape, e.g.) has a “Find” option that allows you to search for the 
performance of a particular runner or team.  Note also the time it took for the software 
to read the file.  These files are actually text files (save one as text if you like; first click 
on “Lose the frame” so you get the file you actually want to see) in the HTML format, 
not PDFs, which are much slower to load. 

It is easy to prepare an “HTML file” of your results in whatever 
format you prefer: order of finish, standard cross country, standard 
road race, teams, alphabetical, etc., and to produce a single file 
containing more than one format. Your first step is to select an option 
under the Results menu or from the buttons shown on page 55.  When 
asked to select an output device (page 5), select File (type “F”) and give 
the file name a suffix of “.htm” or “.html.”  The file format options 
dialog (see page 65) that then appears confirms that you want to 
prepare a file for the World Wide Web. 

The dialog at 
right asks you for 
some information 
that will be put at the 
head of the web page 
on which your 
results will be stored.  

The first three lines are filled in with 
what you entered if you declared you 
would put a title above the header of 
your results, page 55. 

The last six lines of the dialog help 
you to “link” the page you are 
working on to other pages.  One of 
the neat things about the Web is the 
ease with which you can jump from 
one page to another by clicking on a 
highlighted (usually underlined) 
piece of text or part of a graphic.  The 
fourth line puts in a link back to the 
index page (named “mainrr.html”) 
that the reader probably went to first 
in order to access the results.  That it 
is labeled “/mainrr.html” indicates 
that the results files are being kept in 
a subfolder of that in which 
mainrr.html is stored.  More about 
that and the “Logo file” below.  

Complete 
Addresses for Race 
Day Entrants 

Posting Results on 
the Internet 
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To keep the size of the files down – the bigger the files, the longer a user has to wait 
for them to load – I often create separate HTML files for men and women in big road 
races, using RaceDay’s ability to list runners in order of finish separately by sex (page 
59).  Suppose you are working on the women’s results, putting them into a file called 
“mora5kwomen.html.” RaceDay assumes you will put the men’s results into a file 
called “mora5kmen.html,” pops that name up on the fifth line of the dialog and “men” 
into the next line.  Accepting these defaults will add to the “mora5kwomen.html” file 
the lines 

Results also available for <A HREF = mora5kmen.html>men.</A> 
Return to <A HREF = /mainrr.html>home page</A>. 

and your reader will see the lines 
Results also available for men. Return to home page. 

Clicking on the first underlined phrase will link the reader to the men’s results page.  
Clicking on the second other one will link to a page called “mainrr.html” which is the 
index page of the WWW account you are using.  Since sites differ as to the names of 
their home pages, you are given the opportunity to customize that, too, in the fourth 
box of the dialog above (what you choose is stored in the ARJaM.ini file in your 
program folder).  The links are inserted both at the top and bottom of the file. 

For events that have races at multiple distances, you can link the results of one to 
the other(s).  In the example shown, there was a 5K race and an 8K. The 8K results were 
being sent to freedom8k.html.  That name was used as the default choice for the 5K 
results. When, as in the case illustrated, the multiple races finish simultaneously, and 
you are separating the finishers by assigning them divisions (see page 12), RaceDay 
searches the KEYCODES file for the names of divisions other than the one currently 
being scored, and, if you entered the distances for each division, fills in the sixth line 
with the name of the first division not being scored.  You would still have to name the 
results file used for that division on line 5.  Changing the 5K link to freedom5k.html is 
pretty easy. 

All internet-capable ARJaM programs (Sorters, SetData, RaceDay, Handicap, and 
MultiRace) allow you to put your “corporate logo” at the top of html files you create. 
The logo file must already be on the site to which you're sending results. When you set 
up the html header, put the file name in the new box for "Logo file." If, as I do, you put 
the results in a folder on your site, and the logo file is in the next level up, put a "/" in 
front of its name. E.g., mine is arj.gif, so I enter "/arj.gif." Note that it's case sensitive.  

You can now put whatever type of results you want in the file.  For cross country 
meets the standard cross country options are a good place to start.  If you have splits in 
a cross country meet, you can show team scores at the splits and each runner’s places at 
the splits.  Simply say you want to list results of the splits in the splits dialog on page 64 
and click on “show scores at splits” and “show places at splits” in the standard cross 
country dialog on page 57.  The scores at splits will be listed after the final team scores.  
See. e.g.,  

http://raceberryjam.com/2018/nc3mencc.html 

If you want to show award winners followed by a complete order of finish, first 
click on the Standard Road button, specify the file name and make your selections in 
the dialog on page 56.  When that’s done, you’ll be asked if you want to “Add more 
results to the file.”  Say “Yes” and click on the Order of Finish button.  If you made an 
HTMLFILESTUFF, you can use the “Output results using stored formats” option under 
the file menu to do this in one step.  If there was team competition you can put the 
team results in the same file or post them separately (perhaps linking them to the order 
of finish).   

If you include pace per mile in the results format, the reader will be able to step 
through the order of finish results by clicking on links to places where the pace changes 
to an even minute (6:00, 7:00, etc.).   

If you have photos of the first man and woman in the race, you can include them in 
the order-of-finish results.  Convert the photo to a “jpeg” file.  Click on the “Include 
images of first man and woman” box in the dialog on page 59.  You then are asked to 
name the jpeg.  Lots of example on raceberryjam.com (I get my photos from my 
FinishLynx backup system that I bring to chip races).  You need to upload the files to 
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the same location as your results file (in the 2019 folder, e.g.), but RaceDay makes that 
easy for you; see below. 

The next step is getting your pages up on the Web, and making it easy for readers to 
find them.    You could use a commercially available FTP program.  For general 

purposes I have used a freeware program called FileZilla.   
However, it is easy to use the ARJaM programs to do it for 

you.  Immediately after you have finished writing results to the 
html file as described above, you are asked if you want to send 
them up to your web site.  If you say yes, the dialog at left 
allows you to enter the same data as are required with an FTP 
program (ARJaM remembers your input in the ARJaM.ini file).  
Note the option to put the file in a particular directory on your 
web site.  I post results from dozens of events each year, and by 
putting them in separate directories I can archive them.  Put “/” 
after the directory name if you do likewise. 

The Index File.  For users easily to access your meet results, 
there should also be an index file, usually with a name like 
“index.html” (mine are called “mainrr.html” for road races and 
“maincc.html” for cross country) inside your “www” folder on 
the provider’s server.  This is basically a text file containing, 

most critically, links to your results (and any other) pages.  Here is a bare-bones version 
of the index file for my www page that contains links to the results files discussed in 
the preceding paragraph: 

<HTML> 
<HEAD> 
<TITLE>Apple Raceberry JaM</TITLE> 
</HEAD> 
<BODY> 
<H1>Computer Services and Software for Road Races and Track 

and Cross Country Meets</H1> 
<BODY><BR> 
<H2>Race Results</H2> 
<UL><BR> 
<LI> Tiger Trot 5K and Fountain Lake 5 Mile, Austin, April 16 
<UL><BR> 
<LI><A HREF="tigertrot.html"> Tiger Trot 5K </A><BR> 
<LI><A HREF=" fountainlake.html"> Fountain Lake 5 Mile </A><BR> 
</UL><BR> 
</UL><BR> 
To comment or for further info send e-mail to 

jack@raceberryjam.com. 
</BODY> 
</HTML> 

Putting Your Files Up 
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If you can learn a little bit of html, 
you can edit the index file and send it up 
when you post the results.  Click on the 
“Update index file” box in the dialog 
above.  After the results are uploaded, 
you are asked to locate the index file, 
which then appears in a memo box as 
shown at left.  Scroll down to the 
location of your race information.  You 
can copy and paste, delete and insert.  
Use the <!--XXX--> delimiter to hide data 
as necessary. 

Otherwise you can use a commercial 
program to create and upload your 
index file. 

You can also upload PDFs and jpeg 
files from RaceDay to the same folder as 
that which you use for results.  Simply 
pull the Other options menu down to 
“Upload miscellaneous file.” 

 
 
 

If you have Internet access at the race site, you can easily update the order of finish 
and awards lists during the race.   Just create an HTMFILESTUFF file as described on 
page 66.  For this to be useful, you will need a link to the results file in a prominent 
place on your web site.  You might also post a line that says “Race starts at 9 a.m.” so 
that impatient viewers won’t complain about incorrect results. 

You may prefer to post your results as a PDF.  The HTML files are efficient but, 
aside from the possibilities of a logo at the top and pictures of the winners, not as pretty 
as you can get by using RaceDay’s printing capabilities. 

If so, note that you can concatenate results in order of finish, “standard road” award 
winners, and teams by accepting the option to “Add more results to the file.”  You will, 
however, need to install some software to create the PDF.  With Windows 10 comes 
Microsoft Print to PDF, which is great.  I used to like “Foxit Reader,” which is free.  You 
can upload the PDF by pulling RaceDay’s Other Options menu down to “Upload 
miscellaneous file.” 

If you have stored email addresses in the “superdata” field (see pages 9 and 20), you 
can use RaceDay to email individual results to all finishers for whom you have an 
address. 

Click on “Print results” 
and go through the usual 
formatting options (unless 
you’ve been printing results 
and will use the same options 
in your emails), including 
whether or not you wish to 
display any splits that are 
available.  After confirming 
the range of finishers to 
which you wish to send 
emails, you get the 
formatting dialog shown at 
right.  The emails that result 
will have the following form: 
Your official time was 50:48, a pace of 5:27 per mile. You finished 5th out 
of 216 overall and 3rd out of the 7 Men 20 - 24. Your age grade % was 
 81.03%. 
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Complete results are available at http://www.raceberryjam.com (click on Road 
Races then Results). 
 
Thanks for running the race. Next year's date is Aug. 12. Hope to see you 
back! 
The pace appears if, when you encountered the formatting dialog on page 55, you 
declared you wished to, and the split(s) (here an age-graded result) if you want to 
include them.  If so, you get a dialog like that on page 64 in which to name the splits 
(only 11 characters available) and identify which, if any, are WMA percents. 

You are asked if you want to send emails to all the finishers (or at least those in the 
ID number range or divisions you may have selected) or to a select few.  Sometimes 
you will hear from someone who received an email and wants to correct his/her age or 
have you send one to a friend/family member whose email address was not on file. 

You then get the opportunity to review your emails 
before you send them out, which is a good idea.  As shown 
on the left, simply enter the number of test emails you want 
to send; leave it at zero to actually send them out to your 
runners. 

 
 

You are then asked 
for the information in 
the dialog at right.  You 
can probably figure out 
what to put in the first 
four boxes by looking at 
the setup of your email.   

That’s about it.  You 
can print a list of email 
addresses you send to if 
you wish, but you’ll be 
able to tell they went 
out when you get some 
“Undelivered mail 
returned to sender” 
emails.  Unless you 
input all those addresses perfectly.  If you are collecting the results of your races in a 
data base so as to speed up data entry in future races (page 81), use Sorters and its 
scrolling display (page 30) to eliminate the incorrect email addresses before you run 
Database on your data. 

The “newspaper style” listed in the dialog above produces results suitable for the 
agate section of your newspaper; perhaps you can send them in by email, thus saving 
them work and improving your prospects for getting more finishers listed.    

Here’s a sample of what the “standard road results” option yields in this format: 
RUNNING RESULTS 
Nana's Run 5K, Minnetonka 
Men  
Open - 1. Roland Pauwels, Minneapolis, 15:24; 2. Pete Kessler, New Hope, 16:05; 3. 

Michael E Seaman, Edina, 16:37. 12 & Under - 1. Adam Wendle, Greenwood, 26:14. 
an13-19 - 1. Jeremy Beuch, Shakopee, 18:09. 20-29 - 1. Scott Wendt, Minnetonka, 19:02. 
30-39 - 1. Mike Setter, Minneapolis, 17:32. 40-49 - 1. Tom Heimdal, Apple Valley, 18:23. 
50-59 - 1. Carl A Koecher, Minnetonka, 21:40. 60-69 - 1. Bill Fraser, Edina, 21:01. 70 & Up 
- 1. Alex Ratelle, Grand Marais, 23:42.  

Women  
Open - 1. Janis Klecker, Minnetonka, 18:11; 2. Jessica Young, St. Louis Park, 18:26; 3. 

Judy Meyer, New Brighton, 18:44. 12 & Under - 1. Lisa Ekholm, Edina, 45:17. 13-19 - 1. 
Sarah Obert, St. Louis Park, 31:10. 20-29 - 1. Anne Fraser, Independence, 19:15. 30-39 - 1. 
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Tracy Kurschner, Minneapolis, 22:51. 40-49 - 1. Kathryn M Benhardus, Minnetonka, 
23:21. 50-59 - 1. Pat Clabo, Minnetonka, 25:21. 60-69 - 1. Mae Horns, Bloomington, 26:05.  

For this race, open runners (the top three men and women) were excluded from age 
group awards.  When they are not, only the open award winners’ names last names 
(and not their home towns) are listed in the age-group awards. 

If the newspaper wants to print complete results, they will probably print the class 
place as well as home town and print them in columns rather than the condensed style 
shown above.  If so, do not select the “newspaper” style for the output.  Instead find 
out their preference as to the character(s) they prefer to use for delimiting the various 
fields.  As shown above, your options are tabs, any one character of their choosing, or 
characters like @#$%.   

Be sure to send the newspaper a sample file before the race so they can check the 
format out! 

Here is the lightly edited form of results for a cross country meet, after selecting the 
“Standard Cross Country” option and electing to “Mark up qualifiers:” 

RUNNING RESULTS 
MSHSL Section 6AA Championships  
Gale Woods Farm, Minnetrista 
Boys 
Team scores: 1. Edina (Will Burke 15:55.1, Jake Campbell 16:11.1, Matt Lumbar 16:13.7, Luke Lumbar 

16:21.1, Matthew Berntson 16:47.0, Peter Knoll 17:00.0, Paul Nordquist 17:08.4), 53; 2. Eden Prairie (Cal 
Lawton 16:08.8, Henry Zurn 16:17.3, Andrew Hansen 16:19.7, Ricardo Reyes 16:21.3, Jacob Young 16:36.4, 
Ryan Stewart 16:43.4, Jack Odzer 17:06.9), 56; 3. Wayzata, 60; 4. Hopkins, 84; 5. Minnetonka, 95; 6. 
Minneapolis Southwest, 165; 7. Minneapolis South, 247; 8. St Louis Park, 258; 9. Robbinsdale Armstrong, 
278; 10. Robbinsdale Cooper, 279; 11. Benilde St Margaret's, 303; 12. Minneapolis Washburn, 341; 13. 
Minneapolis Henry, 414; 14. DeLaSalle, 419.  

Individuals: 1. Josh Thorson, Wayzata, 15:35.4; 2. Connor Olson, Wayzata, 15:37.7; 3. John Klecker, 
Hopkins, 15:51.4; 4. Will Burke, Edina, 15:55.1; 5. Kyle Anderson, Minnetonka, 16:07.5; 6. Cal Lawton, 
Eden Prairie, 16:08.8; 7. Jake Campbell, Edina, 16:11.1; 8. Joe Klecker, Hopkins, 16:11.4; 9. Matt Lumbar, 
Edina, 16:13.7; 10. Henry Zurn, Eden Prairie, 16:17.3.  

Girls 
Team scores: 1. Wayzata (Anna French 14:33.7, Annika HalvErson 14:51.2, Mackenzie Keller-Miller 

15:16.9, Alayna Sonnesyn 15:17.8, McKenna Evans 15:23.0, Mary Franke 15:44.0, Emily Holscher 15:59.7), 
60; 2. Edina (Piper Bain 15:02.2, Tate Sweeney 15:05.4, Stephanie Kohn 15:09.4, Molly Kuhs 15:11.3, 
Bridgit Loeffelholz 15:30.4, Laura Schmiel 16:01.3, McKenzie Lee 16:10.6), 69; 3. Eden Prairie, 97; 4. 
Hopkins, 118; 5*. Robbinsdale Armstrong, 136; 6*. Minneapolis Southwest, 136; 7. Minnetonka, 168; 8. 
Minneapolis South, 231; 9. Robbinsdale Cooper, 240; 10. Minneapolis Washburn, 254; 11. Benilde St 
Margaret's, 336; 12. St Louis Park, 343; 13. DeLaSalle, 367.  

Individuals: 1. Anna French, Wayzata, 14:33.7; 2. Hannah Jeter, Eden Prairie, 14:47.8; 3. Sally 
Donovan, Minneapolis South, 14:50.8; 4. Annika HalvErson, Wayzata, 14:51.2; 5. Robin Fassett-Carman, 
Minneapolis Southwest, 14:54.7; 6. Lucy Hoelscher, Minnetonka, 14:58.6; 7. Piper Bain, Edina, 15:02.2; 8. 
melissa cabak, Robbinsdale Armstrong, 15:04.5; 9. Anna Nachbor, Robbinsdale Armstrong, 15:04.7; 10. 
Tate Sweeney, Edina, 15:05.4. 

For this meet the first two teams and first 10 individuals qualified for the State Meet, 
and the scorer elected to output the first 10 individuals.  Note that the names and times 
of the scoring members on the qualifying teams are listed.  To get boys’ and girls’ 
results in the same file, I declared I would add more results to the file after doing the 
boys, switched to the girls’ folder, and repeated the Standard Cross Country operation. 

It is now required that results of NCAA cross country meets be submitted to TFRRS  
(Track & Field Results Reporting System).  You will have to register with tfrrs.org to get 
a user name and password, and enter information on the meet (name, date, location).  
Then you upload a file, whose preparation is described below.   

In RaceDay, go to Print Results/Standard Cross Country.  Say you want to send the 
results to a file.  Include “TFRRS” or “tfrrs” in the file name. It will be a text file. You’ll 
be asked for names of the referee and meet director and the zip code of the venue, 
among other things (don’t blame me). What you enter is stored in the Notes file for the 
meet, so you won’t have to reenter it if you have to redo the results. You’re also asked 
for the race distance and gender of the runners. If you have “Men”/“Women” and the 
race distance in the folder name, you’ll just be verifying that info. 

For the usual coed meet, when the results are done for one gender you’re asked if 
you want to add more results to the file. Yes, you do. You are then prompted to search 
for the other gender’s ORDER file and for the race distance and gender. Assuming 
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NCAA continues to score runners in just two genders, accept the default not to add any 
more results to the file. 

Some meets want to score the runners in divisions; e.g., Division I and Division II or 
III.  If so, create a KEYCODES file (page 12) in SetData or Download.  Division codes 
must be assigned as numerals, in order of their line in KEYCODES; the code of the first 
division named in KEYCODES should be “1,” e.g.  If some runners are not in any 
division (non-NCAA or unattached), they will be scored in a division named “No code 
assigned,” unless you edit the last line of KEYCODES to something more informative. 

In RaceDay, do not select a division in the formatting dialog (page 55).  Just confirm 
that the race is being scored in divisions when asked.  On the TFRRS.org site, team 
scores will be computed separately for the divisions but all runners will be listed in a 
single order of finish. 

Now you must get the data in the file to TFRRS.  Quit RaceDay, and select from 
ARJMenu the Results/Upload XC Results item, which calls up the TFRRSXC program. 
This asks you for your TFRRS user name and password (which will be stored in the .ini 
file when you’re done), shows you a list of meets you have filed info for, and, after you 
select the meet of current interest, asks you to locate the file you made in RaceDay. 
Much later you get a report on the number of entrants and finishers and will be able to 
see the results at the tfrrs.org site. 

No matter how fast you are, there will always be some award winners who do not 
show up for the award ceremony.  The race director may have to mail them their 
awards.  Programs RaceDay and Sorters make preparing labels for the award winners 
easy; see page 58. 

There are times when you need to mail something to a runner whose number you 
don’t have handy, or send him an email.  Sorters is probably your quickest way to do 
so.  See page 30 for how to scroll thru an alphabetical list to get the job done. 

Mailing Awards 

Listing, Printing 
Labels for, and 
Emailing Specific 
Runners:  
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Database Package 
Program DataBase helps you collect and maintain a database of runners who have 

entered or finished races scored with the Apple Raceberry JaM system.  This database 
can be a source of income for you, provide you with a mailing list for races that you 
direct or service, and also, as described on page 22, speed data entry for other races you 
score.  If you are timing a series of races (see page 85 for scoring options), you can use 
DataBase to keep track of which runners have run in which races.  It also allows you to 
access individual records of the database and so to turn Apple Raceberry JaM into an 
efficient data-base manager suitable for maintaining an organization’s membership.  
Before worrying about how you work with these programs, let’s take a look at the 
finished product. 

As new runners are added to the database, they are not added to the bottom of the 
file.  The line they occupy in the files is instead keyed to their last name.  This speeds 
the search to determine if a runner is already on file without making great demands on 
the computer’s memory.  The technique used is called “hashing;” an integer equivalent 
to the letters in the runner’s name is computed and then divided by the total number of 
lines available in the file.  The remainder is the line to which that runner is assigned.  If 
that line is occupied, the program searches for the next blank line.   This file structure 
has implications for how you correct the duplicates that will inevitably occur because 
of misspelling and erroneous ages.  See below. 

Although hashing improves the speed of adding to the database, it requires a lot of 
empty lines in the file or it slows down unacceptably.  Allow at least 30% and 
preferably 50% more lines in the files than you expect to fill. 

Two runners are judged to be identical, and so not given different lines in the file, if 
the following conditions are met: 

1.  They have the same last names, through the first six letters (or consonants, if the 
name is longer than six characters); and 
2.  Their “birth dates” (estimated by subtracting the runner’s age on race day from 
the date of the race in which they ran) are within one year of one another; and 
3.  They have the same sex; and 
4.  The first two characters of their first names agree, or else the numbers in their 
street addresses agree, or else one’s name is a standard nickname for the other 
(“Dick” for “Richard,” etc.). 
Note that the ability of the system to detect whether or not two runners from 

different races are the same person depends on the accuracy with which the data for 
those races were entered (and on the runner’s accuracy in specifying his/her age).  
When it works, however, the system allows you to update a runner’s address as he/she 
moves about. 

Besides the usual ARJ files (ROSTERN, ADDRESSESN, CITIES, and CLASSES), 
DataBase uses and fills a file called DATES, which holds, for each runner, an estimated 
birth date and the date of the last race in which he/she ran.  DATES is opened 
automatically by DataBase the first time you run it, as is a KEYCODES file.  If you are 
using DataBase for a series of races (an option you declare when you create the 
KEYCODES), the KEYCODES file will have items like “Race 1,” “Race 2,” and “Races 2 
& 3.”  Otherwise it helps you keep track of what types of races the runners have run: 
“8K or less,” “10K,” etc. 

DataBase takes a set of ROSTERN/ADDRESSESN/CITIES files from a race and 
adds the entrants (or, if you prefer, just the finishers) to your data base files, hopefully 
without duplicating previous entries.  It keeps track of what types of races (see the sec-
ond dialog below) and how often the runners have run, and allows you to “mark up” 
the data base file for producing a set of labels or list of runners who have run at least a 
specified number of races and/or who have run at least one race in a certain distance 
range or of a certain type (bike or triathlon, to be specific).  By “mark up” is meant that 
the fourth “division code” is turned on, allowing the alphabetical and zip-code parts of 
Sorters to concentrate on the “marked-up” runners.  It can also “analyze” the runners 
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in your data base, listing how many in each age-sex group have run what distances and 
how often they have run. 

DataBase also allows you to transfer the data in one data base to another, allowing 
you to break up (or compact) your data base files, to purify the files if you find some 
duplications (due to names being misspelled, for example), and to delete runners who 
have not entered or finished a race for some time.  It may also be used to access and 
edit or delete the records of individuals, and also to add new names to the list. 

1. Use NewEvent to open the usual “runner data files.”  As noted above, allow 30 
to 50% more room in ROSTERN than you expect to fill.  The maximum number of 
runners you can store in an ARJ ROSTERN/ ADDRESSESN/CITIES file set is 32000, 
the maximum allowable integer in Pascal.  You may as well allow for the maximum 
number of cities, which is 2047.  Opening OTHERDATA and SUPERDATA files allows 
you to be able to track such information as phone numbers and email addresses, too.  
Choose the classes so that you can do demographic analyses (count the numbers in 
each age/sex group) fine enough to be useful.   

2. If you want to keep track only of finishers (it may make your data base more 
salable and easier for you to handle, too), first pull down RaceDay’s Other Options 

menu to “Set division code for all finishers." 
3. Run DataBase to add the race data to your data base.  When 

asked to locate the ROSTERN, it wants you to find the data base, not 
the race data that you will add (that will come later).   

4. Now pull 
down the Options 
menu to “Add” 
(Ctrl+A) or click on 
the “Add Data from 
race” button.  If the 
race was chip-timed 
with either the IPICO 
or MyLaps shoe chip 
systems, the extra 
data field will contain 
chip numbers and 
you will be asked if 
you want to remove 
them.  The dialog at 
right asks for the type 
of race and whether 
you wish to restrict 
the additions by race 
division, zip codes, 
and runner’s age.  
You will probably want to restrict your data base to runners in your 
“local” area; what you choose is assumed to be your “standard” range 
of zip-codes and stored on your hard drive for future reference.  Since 

younger runners seldom do more than one race a year (and since their parents may 
resent getting stuff mailed to them by your data base customers), I also exclude runners 
under the age of 16.  For race series, the “8K or less” and similar labels are replaced by 
“Race 1,” “Race 2,” etc. 

Note also that you can elect to “update” addresses in the data base, without adding 
new names.   

Once a year you should use DataBase to eliminate runners who have not run of 
your races in a year or more, and so may have moved out of town, taken up smoking, 
or died.  Runners with blank zip codes are not transferred, which constitutes a way of 
eliminating duplicates.   

You can transfer only those whose last race was after a certain date, and/or those 
whose fourth division code has been turned on by DataBase’s “marking-up” 
mechanism.  If you mark those who have run at least two races and elect this last 
option, you thus eliminate those who have run only one.   

Procedure 
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Also, you can reduce the “race counter” by a specified factor.  At the end of each 
season, I eliminate everyone who (so far as I know) has run no races in the last year and 
reduce the race counter by a factor of two.  The counter is then a rough indicator of 

how many races a person runs per year. 
Use NewEvent to open up a new set of files in a new folder.  

Now run DataBase, locating the new ROSTERN and 
ADDRESSES files.  Use the dialog shown at left to define who is 
going into the new data base and modify the race counter, if you 
so choose.  Pull down the Add menu to “Add data from data 
base” and locate the old data base ROSTERN and ADDRESSES.  
And wait till it’s done. 

 
 
 
 
 
 
 
 
 
 

To use your data base, run Sorters.  Pick a range of zip codes (or initials, if you’re 
doing an alphabetical sort) for which you expect fewer than 20,000 runners (the 
maximum Sorters can sort in one batch).  If there are more than 20,000 in the range you 
pick, no problem; you will be told so, and asked to pick a narrower range.  You can also 
select what age/sex groups you want to receive the mailing by clicking on those of 
interest, and, at the cost of some extra time (a lot of time!), have the program eliminate 
duplicate labels for the same address.   

This last facility isn’t perfect, as was discussed above.  However, if it finds two 
addresses in a certain zip-code area that are similar (have the same leading number), it 
will print them out in a file called “DUPEFILE” that will be saved in the folder 
containing the addresses.  Each line of this file contains the zip code and the number 
and address of the two runners whose addresses were found either identical or similar.  
By going into the data base with SetData, you can judge for yourself whether the 
addresses are in fact the same.  If so, change one of them to be identical in form with 
the other, so that, the next time you do a zip-code sort with the “Eliminate duplicates” 

option turned on, the two runners will be recognized as having the 
same address. 

As noted above, before running Sorters you can “mark up” the 
data base, restricting the output to those who have run races of the 
type and distance in which you’re interested and/or who have run 
two or more races.  If you are using the data base to mail entries for 
another race, you will save a lot of postage if you mail only to those 
who you know have run at least two races in the last year or so.  
Remember that what DataBase does is to turn on the fourth division 
code for all who meet the specifications you set in the dialog at left.  
Thus when you run Sorters you must specify that you want out put 
only for runners whose last division code is on. 

Here’s how to prepare a mailing list tailor-made for a race that you 
scored last year.  First mark up the data base to select “frequent” 
runners who have participated in races at least as long as the distance 
of the race of interest and who are in a nearby zip-code region, too.  
Then use NewEvent to open up a new set of name and address files in 
a new folder and use DataBase as described above to transfer the 
marked-up runners to those files.  Then, without leaving DataBase, 
add the data from last year’s race to the new data base, possibly 

allowing all zipcodes so as not to eliminate last year’s far-flung entrants.  You might 
also add the names from the year before, but I wouldn’t go back any further than that; 
people are very mobile these days. 
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The new data base will now contain frequent runners, some of whom may have run 
the race last year, plus everybody else who ran last year (and optionally the year 
before).  If the runners you marked up were from a smaller range of zip codes than 
other runners in your data base, some of the runners who ran the race in the last two 
years may have moved.  You can update their addresses by choosing the “Add data 
from data base” option one more time, this time turning on the “update only” box but 
not the “marked-up” box.   

You can use Sorters to select everybody in those files, or eliminate zip codes for 
areas not likely to come to the race. When you’re done, trash the new data base. 

Program DataBase can be used to access the records of individual runners in your 
data base, to look up their address, for example.  On locating the ROSTERN and 
ADDRESSES in the usual way, pull down either its Add or Edit menu to “Individuals” 
or click on the “Add/Edit Individuals” button and enter the runner’s name.  If you 
enter just the last name, it will search for the first runner on file with that name.  If it 
finds someone, your are asked to confirm “This is it” just as on page 19.  If it is not the 
one you want, click on “No” or type <esc>.  If you did not enter a first name, a blank is 
put in front of the last name you entered and you are expected to enter the initial of the 
person’s first name (this is case sensitive).  The search will be continued until you either 
find the person you’re looking for or DataBase can find no one with that last name and 
first-name initial.  In a large data base this method is generally a lot faster than using 
SetData’s “Search For ID by name” option, in which you first find the ID number and 
then have to use the Edit or List option to pull up the address. 

Program DataBase can also be used to create a data base that is well suited for 
keeping track of an organization’s membership.  Open up a ROSTERN, ADDRESSES, 
and CITIES files as usual; whether you keep track of the members’ age and sex is 
optional.  If you want to store their phone numbers, open up an OTHERDATA file at 
the same time, and SUPERDATA if you email addresses.  When you run DataBase and 
locate a new set of ROSTERN and ADDRESSES files, a DATES file will be created.  As 
noted above, this file consists of two dates, which DataBase uses for an approximate 
birth date and for the last time the runner ran.  In DataBase, the first could be the 
member’s actual birth date, if you are keeping track of ages, whereas the other one 
becomes an expiration date. 

To enter data on a member, input his/her name.  You may as well input the full 
name in the usual ARJ form (JACK.P MORAN, for example) since the member may be 
new and, if not, the initial of the first name helps narrow the search.  Use the “Keep 
looking” box or “K” key to continue the search until you either locate the member or a 
set of blank boxes show up.  All of SetData’s short cuts are available for data entry; a “-
” recalls the surname last entered in the “Name” box and the address last entered in the 
“Street” box, cities are looked up as you type in their names, and zip codes are looked 
up for cities previously entered.  

Once your data are entered, Sorters can be used for lists and labels in alphabetical or 
zip-code order.  To print out labels one at a time as you access (or enter) a person’s 
record in program DataBase, select either the second or third item under its File menu.  
Only the members you have entered in the present session of DataBase will be listed. 

Once you start setting up a multiplicity of data bases – besides the one you accumu-
late from each race you score, you might have one or more to keep track of the 
memberships of organizations you serve, and set them up for each year’s entrants in 
specific races – you will find that an individual may be entered in more than one.  
DataBase allows you to update the data in each set of files from the others.  The 
simplest way is to use the “Add data from data base” option under the Add menu as 
described above, turning on the “update only” button in the dialog shown above.   

Alternatively, pull down the Add menu to “Add data from race” (Ctrl+A), but do 
not identify any race date or type; just click on the “Update only” button.  You will be 
asked in the dialogs to the right, first, if you want to “add” data from another data base 
(accept the default), and, if so, whether you want to add addresses “regardless of 
expiration date.”  You probably don’t.  When DataBase finds a person whose name is in 
both data bases, it then compares the “expiration dates” of the two entries, and replaces 
the data in the file you are working on with those in the source file only if the latter 
data are newer.  However, you can override this in special situations if you want (as 
when there are no addresses at all in the file you are working on). 

Membership 
Management 

Other Options 
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Handicap Scoring and Wave 
Starts 

 The optional program Handicap, packaged with MultiRace (to be discussed below),  
helps you to score races in which the runners start at different times according to either 
age/sex group or some handicapping scheme, or start at the same time but are scored 
on a handicapped basis.  In either case, the start times or handicaps are subtracted from 
their finish times (or the times are multiplied by a handicapping factor) and the finish 
order sorted in order of the handicapped times.  You can then print out the results in 
order of (handicapped) finish or by classes. 

Specifically, as indicated by the dialog at the left, which 
appears shortly after you start up Handicap, you may use one of 
nine handicapping schemes: individual handicaps, handicaps 
based on age/sex group, the age/sex grading factors devised by 
WMA (World Masters Athletes; formerly WAVA), handicaps 
(actually starting times) based on race number or by an entry in 
the extra data field, a system peculiar to a biathlon (run and 
shoot series), and handicaps based on ranges of ID numbers (see 
page 96 for an example). 

WMA handicaps can also be output in RaceDay; see page 63 
for details of their usage.  In Handicap the results are shown in 
order of WMA percent.  To get the results in order of age grades 
in RaceDay, click on the “Sort IDs and times by split #” box in the 
dialog on page 64, entering the number of the age graded split. 

To handicap the runners individually, store their handicaps as “PR’s” through 
program SetData.  That is, if 10 minutes is to be subtracted from a runner's actual clock 
time, you enter a PR for him/her as 10:00. Thus, to handicap runners individually you 
must have opened an ADDRESSES file in NewEvent, since PR’s are stored in that file.  
You may also be able to use DownLoad to import pre-determined start 
times/handicaps from a file. 

If you are handicapping on the basis of age/sex class, program Handicap can be 
used to input the handicaps for each age group, as will be discussed below.  In 
triathlons, the runners often start in waves based mainly on class, except for an “elite” 
wave that cuts across age lines.  For such a case, you can use Handicap to create a file of 
handicap times based on age and sex, store those handicaps as the runners’ individual 
PR’s by selecting an option within program Handicap, use SetData to edit the PR’s of 
the “elites” to their correct starting times, and then choose the “individual” 

handicapping option in program Handicap. 
When handicapping the runners by age-sex class, a dialog 

like that at left asks for the handicaps for each age group 
(separately for men and women and for “regular” and “extra” 
classes, if any) and stores them in a file called HANDICAPS.  
Use the X:XX:XX format; if you input “3”, the handicap is 
understood to be 3 seconds.  If you want it to be 3 minutes, type 
“3:00” or at least “3:”.  As when entering a PR in SetData, you 
can “mistakenly” use a “;” in place of the “:”.  If you are not 
handicapping some classes, enter “0” for their handicap.   

The fourth through sixth options, handicapping by ID 
number, allow you to start the runners at fixed intervals.  Using 
the fourth option, number 1 goes first, then number 2, etc.; all 
you have to specify is the time interval between successive 
runners.  With the sixth option you specify a range of ID 
numbers for each wave and their starting times.  Each of these 
options simply stores each runner’s start time in the PR field, 
after which you are using the “individual” handicapping 
option. 

In the last option, the runners’ predicted times are stored as PRs.  The sort then puts 
the runners whose finish times are closest to their predicted time at the top.  If you 
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want to show how close people run to their predictions in fractions of a second, use 
RaceDay to allow fractions of second in the finish times.   

In chip-timed races where the start time was recorded and the handicaps are to be 
applied to the runners' net times, simply click on ORDERX in the Finish folder when 

you open Handicap.  
Four buttons appear on the desktop, as shown at left.  The 

“Print Results” option is not enabled until you have “Sorted” 
the raw data at least once.  Except in the WMA option 
discussed above, the handicaps are subtracted from the clock 
times and a new finish order calculated on the basis of the 
handicapped times.  The sorted ORDER and TIMES files are 
stored as ORDERH and TIMESH.  This operation does not 
disturb the ORDER and TIMES files, so that you can go back 
and forth between RaceDay and Handicap repeatedly as the 
race progresses.  The “Recover” option allows you to 
reconstruct ORDER and TIMES files from the ORDERH and 
TIMESH files (I put this in after accidentally wiping out the raw 
data).   

When you exercise the “Print Results” option you first get a 
formatting dialog similar to that on page 55, except that team 
scoring and tracking PR’s are not supported (see below).  Note 
that the “pace” options will not be useful in a handicapped 
race, since they are computed on the basis of handicapped time.  
Use them only in the case of a wave start.  The desktop buttons 
change to “Order of Finish” and “Standard Road”.  Results by 
age-sex class are also available from an item under the Print 
results menu.  The formatting options available for the results 
are similar to those of RaceDay, including the possibility of 
eliminating open runners from age-group awards.  A sample of 
the output is shown at the end of the manual.  Note that it 
includes the clock time. 

While you are scoring a race in progress, you may not have 
the same number of times on file as you have ID numbers.  The 
programs only sort handicapped times for as many runners as 
you have both ID’s and times on file. 
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MultiRace 
The optional program MultiRace, packaged with Handicap, extends the capabilities 

of the road race package to series of races, scoring according to either the total time, a 
weighted average time, average pace, total places, or place in a particular race.  The 
series can consist of up to fifteen distinct races (or parts of a race).  Results can be 
printed either only for those who finished all the races or for those who finished a 
specified number of the races.  It can also be applied to triathlons and relays for which 
you want to record splits; results are then usually printed only for those who finished 
the last event.  Finally, it can be used to report times between splits in a road race that 
captures splits.   

To use the program, you must first score each race or event in the usual way. 
Program MultiRace opens up and fills a file called TRIPLEDATA (the first version of 
the program was developed for a three-race series), which contains, for each entrant, in 
order of ID number, his/her age/sex class and, for each race in the series, the runner's 
finishing time and place overall in that race.   

 On starting 
MultiRace and 
locating the 
ROSTERN of 
interest, you 
first select the 
type of event 
from the dialog 
at left and then 
the data storage 
options from 

the one at the right.  The 
split/event time is always stored, 
along with one of the three items 
shown for each event.  You have 
the option of printing these items along with the runners’ split/event times.  If you 
select “pace,” you will be asked for the event distance.  In triathlons, you sometimes 
want the speed of the triathletes during the bike leg.  If you enter the distance of that 
leg as a negative number (“-20” for 20 miles, e.g.), the miles per hour will be shown 
rather than pace. 

A set of buttons now appears on the 
desktop.  

First consider scoring a series of 
distinct races.  Naturally, you must first 
score each race or event in the usual 
way.  Two cases will be considered: first, 
when the runners have the same ID 
numbers in all the races, and second, 
when they do not.  The first case 
includes chip races run the same day (a 
10K followed by a 5K, for example); the 
runners simply keep the same chip 
during the second race that they wore in 
the first one.  See page 65 for using 
RaceDay for such events; MultiRace has 
more formatting options for the output, 
in particular showing each runner’s 
place in each race. 

Your first step will be to “Add the 
results of [each] event” to TRIPLEDATA.  All you need do is to locate the ORDER  file 
(or ORDERX file, if start times were recorded and you choose to score by net times), 
name the event, and specify which event of the series (name and number, 1 to 15) it is.  
If you later discover errors in the results, simply correct them with RaceDay and then 
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come back to MultiRace to put the corrected results for that event back into 
TRIPLEDATA. 

As you add data from the various events, MultiRace asks if you want to 
1.  Update the runners’ PR’s with the results of this race.  This makes sense when 
the races all have the same length (the program was developed for a series of 10Ks). 
2. Weight the race times with an “equalization factor”, as MultiRace calls it.  This, of 
course, is most attractive when the races are not of the same length.  The factor can 
be an integer or a real number (with or without a decimal).  

The number of times added for the race in question is shown on the desktop. 
When the data for all the events have been added to TRIPLEDATA, click on the 

“Print results” button or pull down the File menu to ““Print results.”  You will then 
select the format of the results and the output device.  Program MultiRace outputs the 
results for all or the first few races in the series.  It works with only four files: 

ROSTERN, TRIPLEDATA, CLASSES, and (optionally) 
CITIES.   

As shown at left, the formatting options include the 
number of events/races for which you want data 
output.  The “Show places etc in splits.” option allows 
you to print the runners’ place overall, place in class or 
pace (whatever you selected when you added the data 
from the events to your files) along with their times in 
each event, according to the selection you made on the 
dialog above.  If you click it off, only the event times 
(and final score) will be printed.  The results resemble 
the samples shown at the end of the manual for a 
triathlon.  

MultiRace then asks you to name each of the events 
(recalling any names you’ve input the races you added 

to the series in the current session), for use in the header of the printed output, and to 
select the method of scoring: by either total or average time (if you have weighted 
the times from one or more races, it works with the weighted times), by average 
pace, by total places, or by the place in a specific event.   

When scoring a series of races, it also asks how many of the races the runner 
must have run in order to be considered in the final scoring.  Optionally, you can 
“tag” those who did run enough races by turning on their fourth “division code,” 
which makes possible a special mailing just to those runners; just use Sorters, 
sorting them any way you wish but restricting the sort to people with the last code.  
After sorting the data accordingly to your instructions, MultiRace gives you the 
usual options of printing out results in order of finish, by class, or “standard road.” 

The foregoing procedure works fine when the runners have the same ID number 
in each event.  When dealing with completely separate races, you could sort the 

ROSTERN in alphabetical order after each race and use the sorted ROSTERN as the 
basis for the next race; TRIPLEDATA will be sorted, too, so that it could be used for 
subsequent races.  Here’s a simpler method. 

Open up some road race files big enough to hold all the runners who take part in 
the series.  After each race, write out its results in order of finish to a csv file, selecting 
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the option to “separate first and last names.”  Don’t include pace in the formatting 
options.  

Use DownLoad to upload the files from each race into the ARJaM files for the series.  
Zero out the field number for ID/bib number.  Accept the options to add the names to 
the end of the file and, crucially, also to “Check for repeated names.” 

Each runner who participated in more than one race will now have each of his times 
in the series file, all associated with the a same ID number (his/her place overall in the 
first race if the runner ran it).   Run RaceDay on the series data.  Go to the Finish Order 
part and read in the IDENTIME file; you will see many runners with “ID # ALREADY 
SEEN AT PLACE …” but that’s normal. 

Run MultiRace on the series files, selecting the “Multi-race 
series” option.  Then click on “Decode loop race/relay 
results.”  On locating the ORDER file for the series, you are 
first asked whether MultiRace will store each of a runner’s 
times on his/her line of the TRIPLEDATA file, the first time 
for the first race he ran, the second for the second race, and so 
on.  The numbers of runners who ran each race are shown on 
the desktop (actually it’s the number who ran one race, then 
the number who ran two, etc.).  You’re then ready to print out 
results as described above 

 
 

Simply to determine the winners of a triathlon or relay, you can use programs 
RaceDay or Handicap, depending on whether or not the athletes start all together or in 
waves, since all that matters is who took the shortest time.  RaceDay can also display 
their accumulated times in the individual events or legs, but if you want to record their 
split times – times between the splits – and places in those splits, you need MultiRace, 
selecting either the second or third option in the Event Types dialog on page 84.  It can 
handle up to 15 splits. 

In some events, all the splits are collected at the same point and runners or teams 
lap one another.  Then it makes sense to input them into a single set of results files and 
use MultiRace to sort everything out, using the “Decode” option discussed above.   

On selecting this option for a triathlon or relay race, you are first asked if the 
runners’ start times are available.  If so they will be subtracted from their split times 
and total times.  The split disposition dialog shown above then appears.  

The numbers of 
runners recorded at 
each split are then 
displayed, and the 
dialog at left 
appears.  
“Check[ing] for 
missing splits” is 
useful when the 
numbers shown for 
the numbers 

recorded at the splits indicate some 
runners were missed.  Since some 
runners may have been recorded too 

often, you can correct the number of splits expected.  For 
each runner with fewer than the expected number of splits, 
the display at right above allows you to “insert” a split 
before one of the legs.   

For relays, you get the scoring options shown at left. 
Note that you can decode the results taken at the split 

repeatedly during the event.  That is, you can input results in 
RaceDay until almost all the runners or teams have passed 
the split once, switch to MultiRace and post the results to 
that point, go back to RaceDay and collect results from the 
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second lap, back again to MultiRace for the results of the first two legs, etc. 

If the splits in an event are collected at different places, you will have to put each 
split's results in its own folder.  You need a race folder to hold data on the runners in 
ROSTERN and related files, and folders within the race folder to hold results files 
ORDER, TIMES, and IDENTIME for each event/leg. The elapsed times and finish order 
at the end of each event are collected as usual by program RaceDay in files TIMES and 
ORDER.  Program MultiRace takes these data and produces split times and ID’s for 
each event, sorted in order of the split times rather than the elapsed times at the event’s 
end.   

If entrants are started in the traditional opening swim in waves, their start times 
must be input as their PR’s before the start of the triathlon.  When the starting times are 
determined at least in part by age/sex class or ID number, program Handicap can help 
with this process.  Say you want to handicap the runners by age/sex class.  Input the 
starting time for each age group as discussed on page 82, and then click the “Store 
handicaps as PR’s” box on.  If necessary, use SetData to correct the starting times of any 
runners who do not start with their age group (in an “elite” wave, for example).  So 
important is it to getting the start times right (and so often do people jump into the 
“elite” wave without telling me) that I usually go right down to the water and check off 
anyone going in the elite wave. 

When you start program MultiRace, you answer the “Event Type” dialog shown on 
page 84 by clicking on either the second or third button.  Adding the results of an event 
to TRIPLEDATA is mechanically the same for you as if it were simply one of a series of 
independent races.  When you “Add” the results of an event to TRIPLEDATA in a 
triathlon or relay, MultiRace subtracts the elapsed time at the end of the preceding 
event (or at the start of the triathlon) and stores the time taken to complete the event, or 
“split time,” in file TRIPLEDATA.  A finish order for the event is computed by sorting 
the event data in order of split time, and the place also stored in TRIPLEDATA.  The 
elapsed time at the end of the event is simply the sum of all the splits up through that 
event plus the starting time or PR. 

When you’re done, results for each event are stored in file TRIPLEDATA.  Pull 
down the Options menu to “Score race or series”or click on the “Print Results” button  
to get your final results.   

Because splits are taken on the fly, you may not have splits for all the athletes.  
TRIPLEDATA will then contain zero times for some events and, for two or three 
events, times that combine the actual split times. MultiRace only prints out data for a 
split in a triathlon if there is a non-zero time for the previous split, indicating that the 
elapsed time was known both before and after the event.  This leads to some holes in 
the final results, but what is printed should be accurate.  Samples of the output are 
shown in the back of the manual. 

Manually collecting the splits is one of the hardest parts of scoring a triathlon (thank 
God for chips!).  I used to station four people at each split: one calls out numbers, one 
writes them down (along with the time when there is a break), one punches a timer for 
each person past the split line, and the fourth punches their numbers into an automatic 
timer.  I dump the timer into the computer, create a preliminary ORDER file by reading 
the select times file, and then correct it with the handwritten list of IDs.  Duplicate ID 
numbers are frequent.  I try to eliminate them by comparing the places of the runners 
whose IDs were collected more than once at the different stages.  To identify those for 
whom no time was collected, I use MultiRace to read the data for each event into a 
TRIPLEDATA file as if it were a multi-race series, and print out the results with ID 
number showing.  This may help to fill in ID numbers of unidentified runners.  It’s a 
good place for chip timing. 

Sometimes athletes are penalized a certain number of minutes for rule infractions, 
such as drafting.  The easiest way to assess such penalties is to use SetData to subtract 
the penalty from the athlete’s PR at the start of the event.  That will add the penalty to 
the elapsed time for the event.  Since MultiRace will add the elapsed times for all the 
events, the penalty is also added to the final time.  

For relays with splits at various points and for triathlons with relay competition, 
you will again need a folder for each leg if you wish to record the splits.  If each team is 
given just a single number, the “name” belonging to that number is just the team name, 
and each member of the relay team has the same number.  The procedure used to enter 
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the data is then exactly the same as for a triathlon without a relay; in particular, when 
starting up MultiRace, click on the middle button of the “Event Type” dialog on page 
84. 

The bottom button of the dialog — the one that refers to relays — should be used 
only if you assign different numbers to the members of the relay.  You will then be able 
to output the names of the individuals who do each leg (if you follow the procedure in 
the preceding paragraph, the splits will be assigned to the team as a whole).  These 
individuals should all be assigned a team, and the team’s starting time (in a wave start) 
input into the PR part of their ADDRESSES record.   

In a triathlon with relay, relay team numbers should be higher than those used for 
the individual triathletes, so they don’t mess up their overall and class results. 

Inputting the data from the individual legs is the same as for a triathlon.  For a 
triathlon with relay, it is done at the same time you add the data for the triathletes; the 
only thing you do differently is to click the third button of the “Event Type” dialog on 
page 84 rather than the second.  When printing out the results, however, you must 
choose to deal with the relay portion or not (i.e., with the individuals).  In the latter 
case, indicate the range of ID numbers assigned individuals (or division, if you're using 
division codes to flag relay competitors) in the formatting dialog on page 55, to keep 
relays out.   

Since MultiRace has the capability of dealing with series of up to fifteen events, the 
same procedure can be used to score a “quadrathlon” or “pentathlon,” and to produce 
split times for the transitions in a triathlon along with the events themselves.  You can 
get pretty fancy with this by pulling the Edit menu down to “Change type of event” 
and shifting to the Multi-Race Series option after inputting the splits as a triathlon.  For 
example, you can add the accumulated times at the end of each leg and then the final 
time, and score by the place in the “last leg” (final time).  When the event is a road race 
and MultiRace is being used to record the splits, you can also add the WMA percents as 
an “event.” 

Road races that capture splits may choose to report the splits as is - for example, the 
runners’ 5K times in a 10K -  or want to list the times between splits: the runners’ first 
and second 5K times.  The “Triathlon” option on page 84 could be used, putting the 5K 
splits into split 1 and the 10K times into split 2.   

However, almost always such races are chip timed (so are triathlons, for that 
matter).  Further, they often employ starting line mats to record runners’ start times.  
The problem is that the net times are then stored as split number one, which precludes 
using the triathlon routines.  RaceDay is quite capable of handling these races; see page 
64. 
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Appendix A: Networking 
Computers 

For computers to share data, as when TheTimerAP records times on a remote 
computer (page 40), two things are required: the data that are to be shared must be in a 
folder that allows sharing, and the computers must have compatible IP addresses. 

To turn on sharing, in Windows Explorer right-click on the folder.  Select “Share 
with ..” and then “Homegroup (Read/Write).”  You’ll be asked to confirm the sharing.  
That’s it.  (This is for Windows 7; it’s slightly different for other versions of Windows.) 

To set the IP address of a computer, proceed as follows: 
2. In Windows 7: 

a. Click on “My Network Places.”  In  
b. Click on “View network connections.” 

   In Windows 10: 
a. Click on “Settings.” 
b. Click on “Ethernet.” 
c. Click on “Network and Sharing Center.” 

3. Click on “local area connection” and select 
“Properties.” 

4. Click on “Internet protocol Version 4 
(TCP/IPv4)” and then on properties. 

 
 
 
 
 
 
 
 

5. Turn on “Use the following IP 
address” and enter the desired address. 

6. Tab; the subnet mask should turn 
to 255.255.255.0. 

7.  Click OK and then Close. 
The addresses you choose must be 

compatible.  Their form is A.B.C.D, 
where A, B, C, and D are numbers in 
the range 0 to 255.  “Compatible” IP 
addresses have the same values of A, B, 
and C but different values of D.  For 
example, two of my computers have IP 
addresses 192.168.0.70 and 
192.168.0.100. 

Connect the two computers with a 
LAN cable in their network ports, or to 
an Internet switch, or connect one of 
them to an access point from its 
network port.  Now both computers 
should show up in the NetWork 
display (if not, try typing "\\[computer name" in the Network box).  If you double-
click on the “other” computer’s icon, the shared folder will show up.  
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Appendix B: Timing with the 
IPICO and Trident Chip Systems 

Note: IPICO prefers that the transponder worn by runners be called a “tag,” but it is 
commonly called a “chip” and that’s what we’ll use here.  The Trident system is 
physically and internally different from IPICO, but it uses the same chips as does 
IPICO and is operationally identical to IPICO.  For brevity, when you see “IPICO” 
below, think “IPICO and/or Trident.” 

For RaceDay to use the IPICO chip system, it must know which runner is wearing 
which chip.  This information is stored in the OTHERDATA file.  Thus, when opening 
the files for the race, you must first elect to store the runners’ home towns (even in 
cross country meets), and addresses, and then “extra data.” 

The IPICO chip numbers are 12 characters long (although only the last seven differ 
from one chip to another).  Typing them would be not only tedious but likely to be 
often erroneous.  An application called ChipData circumvents those problems, and also 
creates an index file (CHIPINDEX) that is used to translate chip numbers into ID 
numbers efficiently.   

ChipData reads a text file into the race’s OTHERDATA file.  It also prepares the text 
file.  First arrange the chips in the order they will be assigned.  Some people label the 
chips with the runners’ ID numbers for which they will be used.  Because chips get lost 
and/or fail from time to time, I put the chips in plastic bags and put the bags on a 
stringer. 

Because the success of chip timing depends on the index file, you are warned in 
SetData and Download to return to ChipData to (re)create the CHIPINDEX file if it 
does not correctly translate the chip numbers in OTHERDATA or is missing entirely. 

To create a file that can be read into the race’s OTHERDATA file, connect the IPICO 
registration reader to the computer, start up ChipData, select IPICO (ChipData also 
works with ChampionChip) and pull its Options menu down to “Read IPICO tags into 
file.”  You’ll be asked to verify the COM port through which the registration reader is 
connected and name the file into which the chip numbers will be put.  I have labeled 
my chips with their chip numbers (“058001545e3a,” e.g.) and include the first chip 
number on the string in the file name (or at least the last seven characters).  If you’ve 
labeled the chips with ID numbers, a name like “101-200” would be useful. 

This assumes you have a serial registration reader.  If you have a USB registration 
reader, you can use the TagData application supplied by IPICO to create the files of 
chip numbers.  But ChipData 
works with the USB 
registration reader, too, with 
the help of IPICO's USB Port 
Driver. 

Once you have enough 
chips read into files to cover 
the race, and after you have 
assigned numbers to pre-
registered runners 
(ChipData will assign the 
chips to specific ID 
numbers), go to ChipData.  
After locating the ROSTERN 
as usual, click on the “Read chip file into OTHERDATA” and read the files in the order 
that they will be assigned to runners.   

You may have pre-existing data in the OTHERDATA field; phone numbers, birth 
dates, etc.  The dialog at the right asks how the existing data are to be treated.  In most 
cases, the default suffices; the chip number is appended to the existing data, separated 
by a backslash.  In the first case listed in the dialog, your chip number is also appended 
to the existing data, but the separation character is a plus sign (“+”).  The programs 
than know that either of the two chip numbers in the OTHERDATA field belong to that 
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runner.  A similar device is used when runners are assigned two chips, as is often the 
case in cross country championships. 

Note that you can start adding a file of tags at any ID number you wish.  Since you 
always want to have plenty of tags for race day entrants, I often have many left over 
after a race, in bags and labeled with ID numbers.  To save work I'll try to add those 
files starting at the ID number with which the first tag is labeled. 

Also, note that you must have some ID numbers at the end of your file to which no 
chip is assigned.  Sometimes unknown chips will cross the finish line (who knows 
where they come from).  Those chips are tacked on to the end of the file, after the last 
ID number to which you assigned a chip.  RaceDay will not function unless it has room 
for at least 20 unknown chips at the end of your file.  Use the Expand option in SetData 
if necessary. 

You can eliminate chips from particular ranges of ID numbers by clicking on 
ChipData's "Clear OTHERDATA file." 

When you’re done, click on “Create index file.”  The files are now ready for 
RaceDay. 

I then use SetData or Sorters to print out ID labels (without bar codes), accepting the 
invitation to print the “extra data” field.  These labels are then stuck on the plastic bags 
containing the chips.  If the chips are labeled with chip numbers, I get a check as to 
whether I’m assigning the right chip to each runner.  If they’re labeled with bib 
numbers, they can be put in packets or envelopes labeled with the runner’s name or at 
least number. 

The IPICO reader must be networked to the computer, and the computer’s IP 
address must be in the same family as the reader.  See Appendix A. 

After you connect to the reader using the procedure in the IPICO manual, you can 
change the IP address of the reader to fit your own network.  Click on the “Basic setup” 
icon and change the first three pieces of the reader’s IP address so that they match those 
of your network.  Then change the IP address of your computer back to what it was, 
using the procedure outlined above. 

At a race or meet, the first things I do are as follows: 
1.  Hook up the mats to the reader.  For races using a single shoe chip, three rows of 

mats will assure that the runner’s chipped shoe cannot skip over all the mats; the 
system works best if the shoe lands on a mat or in an 18 to 24 inch gap between mats.  If 
the runners wear two shoe chips or a bib chip, two rows of mats are fine. 

2.  Turn on the reader.  With Trident, make sure the Data Mode Switch is in the 
“up” position.  When the delta unit lights stabilize, test the mats with a chip.  If they 
don't seem to be working, try pressing the reset button. On a Lite reader, the TXA/TXB 
lights should be green. 

3.  Connect the computer to the LAN port of the reader.  Or connect the reader to an 
Internet switch to which the computer is connected.  

With the Lite reader, be sure to clean out the TagData file on the memory stick 
supplied by IPICO before you insert it.  Specifically, connect the stick to your computer, 
open up TagData, select all, delete the contents, and save it.  If you are not using the 
stick supplied by IPICO, be sure its size is big enough (4GB is good, 125MB is bad) and 
that you have the IPICO software on it (MOXA Firmware and SDK).  When you insert 
it in the Lite reader, you should get two beeps. 

Whatever the type of reader, start up RaceDay and pull its Network menu down to 
“Synchronize IPICO reader.”  You'll be asked to identify the IP address of the reader 
and port with a LAN Connection dialog like that below (as noted on this version of the 
dialog, use 10000 for the port on a Lite Reader and 9999 for an Elite or Trident).  If an 
Elite reader's time and computer time differ by more than a few minutes, the batteries 
in the delta unit need replacing.  You should have a charged set with you.  After 
changing them, restart the reader and reconnect.  Synchronize the reader to the current 
computer time.  With an Elite reader, you are invited to clear the existing log files. You 
probably want to do so. 

4.  You can now turn off the reader to save its battery.  Be sure to turn it back on 10 
minutes before the first finishers arrives; even though you can hear beeps as runners 
cross the mats, they are not recorded until the reader warms up. 
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If you were not able to hear the chips when you ran them across the mats, or if you 
were not able to connect to the reader via your LAN, you are in trouble.  Hopefully you 
have a backup system put in place. 

At least 10 minutes before the reader will be used, turn it back on.  Connect to it via 
LAN.  Run RaceDay, and pull its Other Options menu down to "Synchronize IPICO 
readers."  This will insure that all your readers are synchronized.  Even if you're only 
using one reader, it's good to have the reader time close to the time of day; see the 
"Start Time" dialog below.  Don't bother synchronizing until you're ready to leave the 
reader on; turning it off and on alters the reader's clock.   

In most cases when you’re 
doing finish-line results, and 
sometimes for splits, you can 
download the data as they are 
recorded in the reader through 
your LAN connection.  Pull the 
Network menu down to “Open 
LAN connection” and select either 
IPICO Elite Reader, IPICO Lite 
Reader, or Trident.   You are then 
asked for the IP address and port of 
the reader, as shown at right.  For a 
Lite Reader, the port should be 
“10000.”  You can also use that for 
an Elite Reader, but “10200” reads 
just the first and last times each 
chip is recorded, which is quicker.   

The option to read data from backup antennas is not available for IPICO and 
Trident, but note the option to use the data for announcing finishers.  Selecting this will 
allow announcing finishers shortly after they finish (or cross a mat before the finish 
line, if you’ve got that much equipment).  The format would be the same as described 
on page 54.  Of course that would require a computer separate from the one being used 
for results. 

The dialog on page 51 gives you several options for the disposition of the data.  If 
you are just collecting times at the finish of a race, you probably don't need to accept 
any of them (the “multiple entries” option allows you to use the system for loop or lap 
races).  If you have start mats, see page 52 for instructions on how to upload them. 

Now all you do is to pull the Network menu down to “Read data over LAN” 
whenever you want to record some finishers.  Their IDs, names and times can be 
printed and posted or at least viewed on the monitor in the “preliminary results” 
format described in the manual, just as if you had entered their IDs from tags on a 
spindle. 

The first time you read data into the results files, the dialog on page 52 appears.  See 
the discussion there for how to respond to that dialog. 

In any case the reader's start time is subtracted from the other times it collects to get 
the runners’ times. 

Just as when entering IDs manually, each time you read results from the reader you 
are asked for the numbers of the “spindle” and the place at which IDs are to be added.  
In this case “spindle” number indicates simply the batch of finishers in the current 
download.  You then select an output device for a listing similar to the preliminary 
results you get when entering IDs manually.  If you have set up HTMLFILESTUFF and 
LIVEFILE, they are updated after each batch. 

For start times (see page 52) and splits that you cannot access until the end of the 
race, you will instead have to upload files that are produced in the reader.  It could also 
happen that you lose the LAN connection to the reader, or that RaceDay crashes.  
Streaming only captures data as the runners finish. 

The Lite Reader creates a file “TagData” on a memory stick (don’t forget to press the 
button until you hear four beeps before you remove it).  The Elite Reader stores data in 
three files on its hard drive, the most useful of which is “FS_LS,” which contains the 
first and last times each chip is recorded.  To move an FS_LS file to your computer, pull 
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the Network menu down to “Read IPICO log file.”  The file will be copied into the 
current results folder. 

To upload a file, click on RaceDay’s Finish Order button.  Pull the Finish Order 
menu down to “Read” (Ctrl+R).  Select IPICO chip file.  The Chip Options dialog 
shown above then appears. You are then asked to locate the file you downloaded from 
the reader.   

As when you are accessing the data over a LAN, the dialog on page 52 appears the 
first time you read data into the results files.  The default entry in the last box now may 
or may not be the reader time at the arrival of the first finisher; you may not have 
cleaned out the reader after checking the mats or after some runners crossed the mats 
on their way to the start, or you may be timing a multi-race cross country meet.   

In such cases replace the time in the last box with a reader time (which is close to 
clock time if you synchronized the reader to your computer) just before the arrival of 
the winner, and enter the winner’s elapsed time in the second box.  RaceDay will search 
through the reader file until it finds a time past what you enter, subtract what you enter 
in the winner’s time box, and use that for the reader’s start time, to be subtracted from 
the times in the reader to get the runners’ times. 

To guard against mistakes, if you change the default start time RaceDay reports the 
owner of the first chip to arrive after that time.  If it’s not the runner you expect, click 
“No” until it reports the right one. 

RaceDay stores what it is using as the reader’s start time in a text file called 
CHIPTIMESTARTED in the race folder.  If it finds such a file in the folder, the dialog 
above is bypassed, even if you quit RaceDay (to go to Handicap, e.g.) or otherwise had 
to restart it.  If your readers are synchronized, you can use the CHIPTIMESTARTED 
from the start or finish or one of the splits to set the start time for other sets of results. 

If you lose your LAN connection to the reader during the race, you will have to 
download FS_LS.log files to get your results.  As noted above under the heading 
Reading Data From Files, simply pull the Serial Port menu down to  “Read IPICO log 
file.”  The file will be copied into the current results folder.  Continue to download the 
current FS_LS.log file as the race proceeds; the various copies will be labeled 
FS_LSA.log, FS_LSB.log, etc. and you will be informed as to the name of the latest 
version.  On uploading the most recent file, runners previously recorded will be 
skipped over. 

Given enough equipment, you can record up to 15 splits with RaceDay.  You have 
the usual problem of establishing the start time.  Synchronizing the readers simplifies 
that task, obviously.  Otherwise you will need the split times of the first runner to reach 
each split. 

When the results for a split are done, use the "Store Results as Split" item under the 
File menu to store them in the TRIPLEDATA file.  If you want to report the splits as net 
times, when you go to print results and get to the “Splits” dialog on page 64, say that 
you want to report the splits as net times.  

If you have splits in a cross country meet, you can show the team scores at the splits 
in an html file.  After doing the standard cross country results, say that you do want to 
add more results to the file.  Then go to the split folder(s) whose results you want to 
show.  You can do standard cross country for each split, turning off the options to list 
finishers by team and in order of finish if you wish. 

Another coup for chip timing is the ease with which it can allow you to record lap 
times in a multiple-lap race.  Simply click on the “Allow multiple entries of ID 
numbers” in the dialog above that appears when you read the reader or an IPICO .log 
file, and specify a minimum time between laps.  When you go to list results, click on the 
option to print “Extra Data” and name the extra field “LAPS.”  Select the item “Count 
multiple finishes (splits)” under the Print Results menu.  The output will be like that of 
http://www.raceberryjam.com/drakelaps.html.  When it’s done, you are asked if you 
want to “File last IDS and times.”  On accepting the suggestion, the runners’ final 
results are stored in a folder of your choice (you create it on the fly). 

In some races, a split is of no interest the first time a runner reaches it.  If you allow 
multiple laps, you’re asked if you want to “Skip splits until split #.”  If you change the 
default “1,” all the splits will be recorded but the IDs will be negated (turkeyed) until 
the split of interest.  If a runner was missed on the first split, you’ll see his ID in the 
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preliminary results mixed in with the runners in the split of interest and can 
“unturkey” him. 

Another coup for chip timing is the ease with which it can allow you to record lap 
times in a multiple-lap race.  Simply click on the “Allow multiple entries of ID 
numbers” in the dialog above that appears when you read the reader or an IPICO .log 
file, and specify a minimum time between laps.  When you go to list results, click on the 
option to print “Extra Data” and name the extra field “LAPS.”  Select the item “Count 
multiple finishes (splits)” under the Print Results menu.  The output will be like that of 
http://www.raceberryjam.com/drakelaps.html.  When it’s done, you are asked if you 
want to “File last IDS and times.”  On accepting the suggestion, the runners’ final 
results are stored in a folder of your choice (you create it on the fly). 

In some races, a split is of no interest the first time a runner reaches it.  If you allow 
multiple laps, you’re asked if you want to “Skip splits until split #.”  If you change the 
default “1,” all the splits will be recorded but the IDs will be negated (turkeyed) until 
the split of interest.  If a runner was missed on the first split, you’ll see his ID in the 
preliminary results mixed in with the runners in the split of interest and can 
“unturkey” him. 

After the race you must (1) see if you got all your chips back, (2) see if they’re 
still working, and (3) get them ready for your next event. 

ChipData can give you a quick check for missing chips, as follows.  Collect the chips 
that were assigned but not picked up (no shows) and read their numbers into a file 
with the registration reader.  Then click on “Check for Missing Chips.”  Find the file, 
say you do not want to read another file, but that you do want to “Tag only non-
finishers.”  Then locate the ORDER file(s) for your finishers; if you had multiple races, 
you’ll be able to check the finishers in each file.  You are then shown the name, age, sex, 
and assigned chip number of each entrant who was not recorded as a finisher but 
whose chip was picked up.  The last “division code” in their data is turned on, and you 
can list their data to a file, and also email them concerning their (possibly) missing chip.  
Since it could be that they did not finish the race but returned the chip at the finish, or 
that they did finish the race but were not recorded (whether because of their chip went 
bad chip or they did not finish with it on their shoe), the default message gives them an 
out: 
 
“Subject: Chip missing from Mora Half Marathon & 5K? 
 
I may be missing the chip (numbered 1549c3e).  
I've made a preliminary check as to what chips may be missing, comparing 
those that were not picked up with the people who did not finish. You may be 
getting this email because you didn't finish but did turn in the chip, or 
because your chip failed to register your finish (if that's the case, please 
let me know your approximate time and I'll check the video backup).If in fact 
you still have your chip, please return it to Jack Moran, 5429 Wooddale Ave., 
Edina, MN 55424 
Thanks.” 

I am able to get out these preliminary emails the day of the race.  So long as the race 
collected chips from everyone who was recorded as finishing, that gives me time to do 
a more thorough check.  

If your chips are labeled with the ID numbers of the runners who will wear them, 
you need to sort them by number after the race.  This will reveal which chips are 
missing.  You also need to check that they are still working.  Simply running them over 
an IPICO registration reader will suffice; it doesn’t have to be connected to a computer.  
If and when you replace lost or defective chips with new ones, you will have to use 
ChipData to read the chip numbers into a file as described above.  Otherwise you must 
keep track of which ID numbers are no longer associated with your remaining chips 
and avoid assigning those IDs. 

I prefer not to have to think while I’m doing menial work, and so have labeled my 
chips with the chip numbers.  I put them in plastic bags (90236 RESEALABLE PLASTIC 
BAGS - ALL-CLEAR from Store Supply Warehouse, http://www.storesupply.com/; 
under $10 per 1000) in which I have punched  a hole and string the bags on Rainbow 
Racing System’s nylon “fish stringers.”  The bags come in batches of 100, so it’s easy to 
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put about 200 on each stringer.  I then read the tag numbers into a file with ChipData, 
as described above. 

To check for missing chips, I use ChipData.  After clicking on the appropriate box, I 
locate the files for all the chips that were returned.  When I’m done, the last division 
code of all the runners whose chips are missing has been turned on so that SetData or 
Sorters can be used to print out lists (Sorters can do labels, too) for those runners, so 
that you or the race can contact them.  If you have their email address, you can email 
them right from ChipData, as in the “quick check” described above: 
“Chip missing from River City Ramble! 
 
I'm missing the chip (numbered 153383d).  
Please return it to Jack Moran, 5429 Wooddale Ave., Edina, MN 55424 
If you tape it to a card, it and the envelope will be fine. Thanks.” 

My source for chip labels (with either the ID number or chip number) is Mark 
Courtney, a long-time ARJaM customer.  You can email him at smc@runhigh.com.  
Some examples of the kinds of labels he produces are shown below. 
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Appendix C: Nordic Ski Meets 
In the typical Nordic ski meet, each skier competes twice: once in “classic style” and 

the other “freestyle” (skating).  In the first race, skiers usually start out at intervals, two 
every 30 seconds for example, their starting positions being drawn by lot.  Program 
Sorters has an option to assign numbers randomly, which may be of assistance in the 
draw.  Program Handicap is in any case certainly useful in assigning the start times. 

The second race is usually a “pursuit” race: skiers start at intervals according to 
their times in the first race.  That is, the winner of the first race goes off first.  The other 
skiers start behind the winner by the same time as they finished behind the first race 
winner.  The order of finish in the second race is then the order of finish for the 
combined races.  A major complication is that ID numbers are usually reassigned in 
start order for the second race. 

For the typical two-gender meet, you will need four divisions (folders) for the meet, 
each with its own ROSTERN, ADDRESSES (and hence CITIES), TEAMS, and results 
files like ORDER.  For each gender, one folder contains the files for the first race and the 
other handles the pursuit race.   

Use NewEvent’s cross country meet option, saying you want four rosters.  Name 
the divisions “Boys/Girls Freestyle” and “Boys/Girls Pursuit” (assuming the Freestyle 
is the first race; otherwise do “Boys Classic” and “Girls Classic”).  Click on the option to 
store Cities and Addresses (to store start times as PRs).  Each ROSTERN will have the 
same first number.  Use SetData to correct the correct number for each ROSTERN as 
necessary. 

For the first race, you will want one “finish line.”  For the Pursuit races, you want 
three: Classic, Freestyle, and one whose name you leave blank.  This will put one set of 
result file outside the Classic and Freestyle folders. 

If, as is usual, ID numbers 
are pre-assigned (by lot), 
Download can be used to 
input the entrants with those 
numbers.  Handicap can then 
be used to assign PRs (start 
times).  Select the sort "By ID 
number (with waves and 
“ghosts)” option.  Set the 
“Waves between ghosts” to 
zero.  If the skiers form two 
lines for the start of the first 
race (odd numbers in one 
line, even in the other), you 
will want to fill in any 
unassigned numbers with 
dummy names (the “Ghost” 
option in the dialog at right) 
so that the start times are 
assigned at equal intervals.   

Use Sorters to output start lists in printed form and post them on the internet.  Sort 
the skiers by PR.  If they are starting in lanes, accept the option to list them by lane. 

Often a Nordic ski meet is an environment too harsh for my computers.  I have had 
good luck with TimeMachines, however.  A three-person team can produce excellent 
results: one person records an individual time for every finisher; a second person enters 
bib numbers in order of finish, hitting the <enter> button when the skier finishes when 
possible; and the third records bib numbers in order of finish with pencil and paper.  If 
you have another timer available, use it.  Getting the times right is of the utmost 
importance. 

Bring the TimeMachine in from the cold, connect it to the scoring computer, and run 
RaceDay.  Pull the Serial Port menu down to “Open timer” and dump the data from the 
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appropriate event (see page 38).  This brings in the recorded times and select times. 
Then go to the Finish Order section, click on “Read data from file” (Ctrl-R) and select 
IDENTIME.  This enters the ID numbers in the order that the select timer entered them.  
Check them against the handwritten list, and then check the times by selecting “Edit” 
from the Times menu (Ctrl-E). If you have a second timer, compare your results with its 
times, too. 

You could also use TheTimerAp on a netbook at the finish line.  To pull in the times 
and select times, connect it to the scoring computer with an Ethernet cable.  In 
RaceDay, pull the Network menu down to “Get times from remote computer,” then say 
you want to add IDs.  When the entry form (page 41) appears, hit <esc> without 
entering any IDs.  This will activate the search for the remote computer and bring in the 
times.  Then read the IDENTIME file as described above. 

Once the IDs and times are available for the first race, you can produce the results 
by following a procedure similar to that described on page 53 for chip times.  Pull the 
Other Options menu down to “Subtract start times to get net times.”  Then go to Print 
Results (Ctrl-P).  In the formatting dialog (page 55), click on “No splits or clock times; 
show net times in order.”  You can then print the results of the first race in order of 
finish. 

Now you must reassign ID numbers for the second race in order of the skiers’ net 
times in the first race, and assign them start times according to how close they finished 
behind the race winner.  While still in the first race folder and in the Print Results/“No 
splits or clock times; show net times in order” option print results in order of finish to a 
csv file and save it in the Pursuit folder. 

Now open the Pursuit ROSTERN in DownLoad.  Pull its Edit menu 
down to “Edit first race number” and verify that it is correct.  Meets will 
often use a series of bibs not starting with 1.  Then click on the “Read” 
button and locate the csv results file from the first race (you will have to 
pull down the menu at the lower right to see csv files).  In the Times 
Options dialog shown at left, click on the last check box, and then locate 
the IDENTIMES file in the subfolder for the first race. 

As usual DownLoad will help you select the order of the fields and 
show you whether you’ve set the field numbers correctly (see page 27).  
Just set the ID number field to 0; you will want Download to assign ID 
numbers in order of net time in the first race. 

Next open RaceDay and select the ROSTERN in the Pursuit folder.  Switch to the 
results files for the first race.  You will see that all the times have been entered but no 
finishers.  Click on the Finish Order button, and then select the “Read file” option (!R).  
As before, select the IDENTIME file. 

These results are now identical to those you printed out from the first race folder, 
but the ID numbers have been reassigned in order of the skiers’ net times in that race.  
Now pull the File menu down to “Store results as PRs.”  So that they become start 
times, subtract the winner’s time in the process (some meets want the first skier to start 
at 1:00 on the clock; if so, subtract one minute less than the winner’s time). 

Now you need to print out start lists for the second race.  Sorters is best equipped to 
do this.  Open the ROSTERN in the Pursuit folder and sort the skiers by PR.  Usually 
the skiers will start in lanes; when two are used, odd numbers start in one lane and 
even in the other.  If the meet does start in multiple lanes, accept the option to list the 
skiers by lane.  You may also want to select a large font size, so the start lists can be 
posted near the start.  If you accept the option to “Show start time and IDs only,” the 
font size will be boosted to 80 for very visible results.   Sorters also has the capability of 
printing special identification labels with the skier’s lane and start time on them; say 
you want ID labels and accept the option to print them by lane.  Start lists for the 
individual coaches should also be printed; suppress the lanes in those.  

To fix ideas, suppose that the Freestyle race was run first. 
In RaceDay, open up the ROSTERN in the Pursuit folder.  Switch to the Classic 

(second) race.  Score the Classic race just as you did the Freestyle: dump the times and 
select times collected at the finish line into the ARJaM files, go to the Finish Order 
section and read in the IDENTIME file, check your results against the hand written list 
of finishers, and edit any errors in timing.  Go to the Finish Order section and click on 
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“Check Finish Order” and accept the option to print out results. This is just to help you 
check the final results, which should be in the same order (unless some of the more 
heavily handicapped skiers were started early; if so, edit their PRs in RaceDay or 
SetData).   

Pull the Other Options menu down to “Use PR to report net times.”  This creates 
files ORDERX and TIMESX which contain the results in order of net times.   

Now Ctrl-G to the Freestyle (first race) folder and save those results as split number 
one.  Then Ctrl-G back to the Classic  (second race) folder, but click on ORDERX, which 
has the results of the Pursuit race in net-time order; i.e., it has the results of the Classic 
race.  Save them as split number two.  Finally, Ctrl-G back to the ORDER file in the 
Pursuit folder (outside the Classic and Freestyle folders).  Select Print results.  When the 
Splits dialog shows up, say you want two and that you want to replace the final times 
(which you may recall are the first-race results) with the sum of the splits.  You’ll be 
asked for the “Required number of splits,” the default being two.  If you say “1,” skiers 
who finished the first race but not the second will be listed at the bottom of the results 
as DNFs.  Print one copy of the order of finish and check it against your printout of the 
raw finish order from the second race.  When two skiers finish almost together, you 
may have to reverse the finish order to make it match what was observed at the finish 
of the pursuit race. 

In the Standard Cross Country option, click on “Ski race.”  You ‘ll be asked for the 
points awarded the winning skier, but otherwise the options are the same as in 
running.. 
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Appendix D: Timing with the 
race|result System 

After ten years of using IPICO, I have moved to race|result.  Rather than using low 
frequency communication to charge the chip and high frequency to get information 
back from the chip, as do IPICO and Trident, race|result uses ultra-high frequency 
communication with the chips in both directions.  As is typical of such systems, 
spectators wearing chips can produce spurious results.  However, runners must cross 
the mats to be recorded. 

As is also typical of UHF systems, the chips are designed to be attached to bibs and 
their ID number is simply the bib number.  SetData does allow specifying a fixed gap 
between bib numbers and chip IDs (pull the Other Options menu down to “Make files 
for bib chips”) but I’ve never used that option. 

RaceDay can communicate with the race|result decoder over a network cable.  The 
decoder must be networked to the computer, and the computer’s IP address must be in 
the same family as the decoder.  See Appendix A. 

After you connect to the decoder, you can change the IP address of the decoder to fit 
your network.  Press “Menu,” use the down arrow on the decoder to move the cursor 
to “Network,” and press “OK.”  You do not want DHCP on.  If the display has “Yes” 
by DHCP, press “OK.”  Press the down arrow to move the selection to “no” and press 
“OK.”  Press “Menu” and return to “Network.”  Now press the down arrow to select 
“Manual configuration” and edit the IP address to what you want. 

At a race or meet, the first things I do are as follows: 
1.  Hook up the mats to the decoder.  For races of moderate size, splitting the 

antennas in two allows two rows of 2.4m wide mats, which is usually adequate.  Space 
the rows as far apart as the connecting cables will allow.  If they are too close, the 
decoder will assign a finish time past that at which they cross the first row. 

2.  Turn on the decoder.  After a few minutes, it will start looking for GPS to 
establish the time of day.  You will also see whether all eight of the sections of the 
antenna are connected. 

3.  Connect the computer to the LAN port of the decoder.  Or connect 
the decoder to an Internet switch to which the computer is connected.  
Start up RaceDay and pull its Network menu down to “Open LAN 
connection.”  Select “RaceResult” from the Network Options dialog.  
You'll be asked to identify the IP address of the reader and port with a 
LAN Connection dialog like that at left.   

4.  You can now turn off the reader to save its battery.  
At least 10 minutes before the decoder will be used, turn it back on.  

Press the “Start” button when it settles down.  This is extremely 
important: no data are captured unless the “Start button” was pressed. 

Pressing the “Start” button a second time will put a marker in the 
data (usually an ID of 99999) .  If you are recording a race start, press it 
at the gun.  If it’s the finish, press it at some time you can remember 
after the start.  When you read the first batch of data, you’ll be asked at 
what time the race started. 

In most cases when you’re doing finish-line results, and sometimes for splits, you 
can download the data as they are recorded in the reader through your LAN 
connection.  Establish a network connection as described above.   

Note the option to read data from backup antennas.  Especially for cross country, 
where accurate places are as important as accurate times, it is best to have separate 
decoders for the primary and backup antennas.  If you have split the antennas in two, a 
single decoder may assign a finish time between the times at which a runner crosses the 
two rows.  If you have a backup decoder, you’ll enter its IP address after getting that of 
the primary decoder.  RaceDay will read the backup decoder immediately after reading 
the other. 
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Note also the option to use the data for announcing finishers.  Selecting this will 
allow announcing finishers shortly after they finish (or cross a mat before the finish 
line, if you’ve got that much equipment).  The format would be the same as described 
on page 54.  Of course that would require a computer separate from the one being used 
for results. 

The dialog on page 52 gives you several options for the disposition of the data.  If 
you are just collecting times at the finish of a race, you probably don't need to accept 
any of them (the “multiple entries” option allows you to use the system for loop or lap 
races).  If you have start mats, see page 52 for instructions on how to upload them. 

Now all you do is to pull the Network menu down to “Read data over LAN” 
whenever you want to record some finishers.  Their IDs, names and times can be 
printed and posted or at least viewed on the monitor in the “preliminary results” 
format described in the manual, just as if you had entered their IDs from tags on a 
spindle. 

The first time you read data into the results files, the dialog on page 52 appears.  See 
the discussion there for how to respond to that dialog.  If you pressed “Start” twice, so 
as to put a marker in the file, you’re asked at what race time you recorded the marker.  
In any case the reader's start time is subtracted from the other times it collects to get the 
runners’ times. 

Just as when entering IDs manually, each time you read results from the reader you 
are asked for the numbers of the “spindle” and the place at which IDs are to be added.  
In this case “spindle” number indicates simply the batch of finishers in the current 
download.  You then select an output device for a listing similar to the preliminary 
results you get when entering IDs manually.  If you have set up HTMLFILESTUFF and 
LIVEFILE, they are updated after each batch. 

RaceDay stores what it is using as the reader’s start time in a text file called 
CHIPTIMESTARTED in the race folder.  If it finds such a file in the folder, the dialog 
above is bypassed, even if you quit RaceDay (to go to Handicap, e.g.) or otherwise had 
to restart it.  If your readers are synchronized, you can use the CHIPTIMESTARTED 
from the start or finish or one of the splits to set the start time for other sets of results. 

I’ve put “Streaming” in quotes in titling this section.  Unlike with IPICO and the 
like, RaceDay does not have to be connected to the decoder as the runners finish in 
order to record their results over a network.  It reads data from a file in the decoder, 
remembering the place in that file where it left off.  Thus if the connection is 
interrupted one simply reconnects and picks up where you left off. 

For start times (see page 52) and splits that you cannot access until the end of the 
race, you will instead have to upload files that are produced in the reader.  If you insert 
a memory stick into the USB port on the decoder, you’ll be asked to hit “OK” when it’s 
ready to transfer data.  Remove the stick when it stops flashing.  Insert the stick into 
your computer and click on RaceDay’s “Read data” button.  You’ll find the data in a 
folder “raceresult” on the stick.  It will actually have data from all of your previous 
races; choose the appropriate one from the date of the file.  Processing the data is 
described on page 51ff. 

Race|result supplies an app “Connector,” that enables remote operation of a 
decoder (or decoders) over an Internet connection and so facilitates scoring splits.  And 
mailing a system to a race that interferes with your busy schedule. 

You will need a wireless router and plug it into one of the LAN ports on the 
decoder.  Mine is a TP-Link TL-MR3040.  To keep it going for hours, I hook it up to a 
portable battery charger, namely the meiyi 20000mAh Quick Charger.  You will also 
need a MiFi to connect the router to the Internet. 

You must change the Network setting on the decoder.  Click on “Menu,” navigate 
to “Network,” and hit “OK” on the DHCP line, selecting “Yes” on the next display and 
hitting “OK.”  Then hit “Menu” again, navigate to “Upload,” click “OK,” navigate to 
:”Enabled,” and click “OK” if it’s not “yes.”  Hit “Menu” to return to the basic setup.  
You should get a message indicating a connection to the race!result Connector. 
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Now run Connector.  You’re taken to the basic Connector screen.  Click 
on “Add new source.”  Your decoder should show up in a dialog like that 
at left as   “Currently Online.”  Select “Use current online file.” 

Next, click on “Add 
new location.”  Name the 
location (in the “Rule” 
box); a tab next to the 
“All” tab with that name 
will appear, as show 
below. 

 
 
 
 
 
 
 

 
Next, click on “Add New Exporter.”  This is the destination of the 

file you will read from this source.  Select “File” for the type of 
Exporter, and navigate to the location in your race folder from which 
you will upload data.  Choose “Save passings manually” for the File 
Mode and be sure to replace “All” with the location (if you have more 
than one location).   

If you have decoders at the start and/or at splits, repeat this 
process for each decoder. 

 
 
 
 

The source lines of Connector 
now resemble what’s shown at 
left.  Initially the numbers to the 
right of the File numbers read 
“TEST.”  Once you press the 
Start button on a decoder “TEST” 

changes to “0” and then to the number of records (“passings”) in the decloder. 
Data flow from decoder frequently stalls.  To wake it up, click blue PAUSE button 

to the right of the source, then click it again to RESUME.  Number should now jump to 
current count and flow all the way to the exporter. 

To download results, right-click on the file icon in 
the Exporter list (to the left of the name of the 
Exporter destination, as show at left) and click on 
“Save file.”  A file of the passings recorded since the 
last time you downloaded results is sent to the 
destination folder.  The files are named serially; 
“finish,” “finish (1),” “finish (2),” etc., for example.   

In RaceDay, after you have downloaded a file click 
on “Read Data from File.”  When you upload the file 
with the first batch of data, you establish the start time 
just as described above under “Streaming.”  After that 
the default name of the file is indexed as indicated above; after you read “finish (2)” 
you are invited to upload “finish (3).” 
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Given enough equipment, you can record up to 15 splits with RaceDay.  You have 
the usual problem of establishing the start time.  Race|result synchronizes all the 
decoders with a GPS signal, so that the start times are the same for all the splits and the 
finish. 

When the results for a split are done, use the "Store Results as Split" item under the 
File menu to store them in the TRIPLEDATA file.  If you want to report the splits as net 
times, when you go to print results and get to the “Splits” dialog on page 64, say that 
you want to report the splits as net times.  

If you have splits in a cross country meet, you can show the team scores at the splits 
in an html file.  After doing the standard cross country results, say that you do want to 
add more results to the file.  Then go to the split folder(s) whose results you want to 
show.  You can do standard cross country for each split, turning off the options to list 
finishers by team and in order of finish if you wish. 

Another coup for chip timing is the ease with which it can allow you to record lap 
times in a multiple-lap race.  Simply click on the “Allow multiple entries of ID 
numbers” in the dialog above that appears when you read the reader or an IPICO .log 
file, and specify a minimum time between laps.  When you go to list results, click on the 
option to print “Extra Data” and name the extra field “LAPS.”  Select the item “Count 
multiple finishes (splits)” under the Print Results menu.  The output will be like that of 
http://www.raceberryjam.com/drakelaps.html.  When it’s done, you are asked if you 
want to “File last IDS and times.”  On accepting the suggestion, the runners’ final 
results are stored in a folder of your choice (you create it on the fly). 

In some races, a split is of no interest the first time a runner reaches it.  If you allow 
multiple laps, you’re asked if you want to “Skip splits until split #.”  If you change the 
default “1,” all the splits will be recorded but the IDs will be negated (turkeyed) until 
the split of interest.  If a runner was missed on the first split, you’ll see his ID in the 
preliminary results mixed in with the runners in the split of interest and can 
“unturkey” him. 

Bib chips are supposedly disposable, but they are in fact reusable.  And they cost 
at least 50¢ apiece, not even including the cost of the bibs. 

Here’s how to reuse bib chips for races/meets that require bibs to be pre-assigned. 
1. Put a couple of boxes out at events that used bib chips with a “Please recycle your 

bib here” sign. Sometimes I get half of them back (helps oif the race announcer says 
something about recycling). 

2. Sort the bibs by number. 
3. Use a chip checker to read the chips into a file.  
4. For a subsequent race, merge the bib numbers with a file of the entrants. Use 

Download or Setdata to create a roster with the entrants in the order you want.  If, as is 
usual, you don’t have enough used bib chips to cover the race, use SetData to insert a 
gap in numbers past the highest number of your old bibs.  Then export the entrants to a 
tabbed file and delete them all from your race file.  Open the file in Word, select it all, 
and convert it to a “Table.”  Do the same with the file of bib numbers.  Select the 
column of bib numbers and paste it over the ID number ion the file of entrants.  
Convert the file back to tabbed text and uploads the file into your race files with 
Download.  You may prefer to use Excel rather than Word, but I’m better with Word 
than Excel. 
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New, 4 
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Runner data 
Deletions, 23 
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Save, 4 
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Propagated error, 45 
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TIMESH, 83 
TimeTech, 38, 39 
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Outputting results, 87 
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Wave start, 87 

TRIPLEDATA, 30 
Turkey tags, 33 
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Turkeys, 37, 42 
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Word processor, 6 
World Wide Web, 71 
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Zip codes 
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